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Before You Begin

Welcome to MicroSim
Welcome to the MicroSim family of products. Whichever 
programs you have purchased, we are confident that you will 
find that they meet your circuit design needs. They provide an 
easy-to-use, integrated environment for creating, simulating and 
analyzing your circuit designs from start to finish.
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MicroSim PSpice 
Overview
MicroSim PSpice can simulate analog circuits. A schematic is 
prepared for simulation from which MicroSim Schematics 
generates a circuit file set. The circuit file set, containing the 
circuit netlist and analysis commands, is read by MicroSim 
PSpice for simulation. The results are formulated into 
meaningful graphical traces in Probe which can be marked for 
display directly from your schematic.
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How to Use this Guide
This guide is designed so you can quickly find the information 
you need to use PSpice.

This guide assumes that you are familiar with MicroSoft 
Windows (3.1, NT or 95), including how to use icons, menus 
and dialog boxes. It also assumes you have a basic 
understanding about how Windows manages applications and 
files to perform routine tasks, such as starting applications and 
opening and saving your work. If you are new to Windows, 
please review your MicroSoft Windows User’s Guide.

Typographical Conventions
Before using PSpice, it is important to understand the terms and 
typographical conventions used in this documentation.

This guide generally follows the conventions used in the 
MicroSoft Windows User’s Guide. Procedures for performing an 
operation are generally numbered with the following 
typographical conventions.

Notation Examples Description

ALL CAPS ANALOG.SLB or 
CLIPPER.SCH

Library files and file names.

C+r Press C+r A specific key or key stroke 
on the keyboard.

monospace 
font

Type VAC... Commands/text entered from 
the keyboard.
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Mouse Conventions
• If you have a multiple-button mouse, the left mouse button 

is the primary mouse button, unless you have configured it 
differently. 

• “Point” means to position the mouse pointer until the tip of 
the pointer rests on whatever you want to point to on the 
screen.

• “Click” means to press and then immediately release the 
mouse button without moving the mouse.

• “Right-click means to press the right mouse button and then 
immediately release the mouse button without moving the 
mouse.

• “Drag” means to point and then hold down the mouse button 
as you move the mouse.
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Related Documentation
The documentation for all MicroSim products is available in 
both hard-copy and on-line.

*.  On-line documentation is available only to those users who install MicroSim products by CD-ROM. 

**. This manual is provided in on-line format only.

Manual Name * Description

MicroSim Schematics 

User’s Guide

Provides information about how to use MicroSim Schematics, which is a 
schematic capture front-end program with a direct interface to other MicroSim 
programs and options.

MicroSim PCBoards 
User’s Guide

Provides information about MicroSim PCBoards, which is a PCB layout editor 
that allows you to specify printed circuit board structure, as well as the 
components, metal and graphics required for fabrication.

MicroSim PCBoards 
Autorouter User’s Guide

Provides information on the integrated interface to Cooper & Chyan 
Technology’s (CCT) SPECCTRA autorouter in MicroSim PCBoards.

MicroSim PSpice A/D & Basics+ 
User’s Guide

Describes the capabilities of PSpice A/D, Probe, Stimulus Editor, and Parts 
utility. It provides examples for demonstrating the process of specifying 
simulation parameters, analyzing simulation data results, editing device 
stimuli, and creating models.

MicroSim PSpice A/D 
Reference Manual

Provides reference material for PSpice A/D. Also included: detailed 
descriptions of the simulation controls and analysis specifications, start-up 
option definitions, and a list of device types in the analog and digital model 
libraries. User interface commands are provided to instruct you on each of the 
screen commands.

MicroSim 
Application Notes**

Provides a variety of articles that show you how a particular task can be 
accomplished using MicroSim‘s products, and examples that demonstrate a 
new or different approach to solving an engineering problem.

MicroSim PSpice Optimizer User’s 
Guide

Provides information for using the PSpice Optimizer for analog performance 
optimization. 

MicroSim PLSyn Programmable 
Logic Synthesis

Provides information for using programmable logic synthesis.

MicroSim/AMD PLD Design 
System User’s Guide

Provides information about the implementation of a PLD design targeted for 
using one or more of AMD’s devices. 

MicroSim Filter Designer User’s 
Guide

Provides information about designing electronic frequency selective filters.

Library Reference Manual** Provides a complete list of the analog and digital parts in the model and symbol 
libraries.
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On-Line Help
Pressing 1 or selecting Contents from the Help menu brings 
up an extensive on-line help system. 

The on-line help includes:

• Step-by-step instructions on how to use PSpice features.

• Reference information about PSpice.

• Technical Support information.

If you are not familiar with Windows (3.1, NT or 95) Help 
System, select How to Use Help from the Help menu.



If You Don’t Have the Standard PSpice Package ix

If You Don’t Have the 
Standard PSpice 
Package

If You Have PSpice Basics
PSpice Basics provides the basic functionality needed for 
analog and mixed-signal design without the advanced features 
in the full PSpice package that some users do not need. Since 
this user guide is for both PSpice and PSpice Basics users, 
however, there are some features described in this user guide 
that are not available for PSpice Basics users.

The Basics icon next to this paragraph is used throughout the 
user guide to mark each section or paragraph which describes a 
feature not available for PSpice Basics users. If an entire section 
describes a “non-Basics” feature, the icon is placed next to the 
section title. If an individual paragraph describes a “non-Basics” 
feature, the icon is placed next to the paragraph.

The following table identifies which features are included with 
PSpice and PSpice Basics.

Feature PSpice
PSpice
Basics

Benefits of integration with MicroSim Schematics 

graphical design entry (schematic capture) yes yes

simulation setup using dialog boxes yes yes

cross-probing yes yes

multi-window analysis of Probe data sets yes yes

marching waveforms in Probe yes yes

board layout package interfaces yes yes

not
included

in:
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Notable PSpice analysis and simulation features 

DC sweep, AC sweep, transient analysis yes yes

noise, Fourier, temperature analysis yes yes

parametric analysis yes no

Monte Carlo, sensitivity/worst-case analysis yes no

analog behavioral modeling (ABM) yes yes

Stimulus Editor yes no

Parts utility yes no

performance analysis (goal functions) yes no

save/load bias point yes no

Notable PSpice devices and library models

GaAsFETs: Curtice, Statz, TriQuint, 
Parker-Skellern

all Statz

MOSFETs: SPICE3 (1-3) with charge 
conservation, BSIM1, BSIM3 (version 2)

yes yes

IGBTs yes no

JFETs, BJTs yes yes

resistor, capacitor, and inductor .MODEL support yes yes

ideal, non-ideal lossy transmission lines all ideal

coupled transmission lines yes no

nonlinear magnetics yes no

voltage- and current-controlled switches yes yes

analog model library 8500+ 8500+ *

Purchase options

MicroSim PCBoards yes yes

MicroSim PSpice Optimizer yes no

Device Equations yes no

network licensing yes no

Feature PSpice
PSpice
Basics
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If You Have the Evaluation 
CD-ROM
MicroSim’s evaluation CD-ROM has the following limitations:

• Schematic capture limited to one schematic page (A-size)

• Maximum of 25 symbols can be placed on a schematic

• Maximum of nine symbol libraries can be configured

• Maximum of 20 symbols in a user-created symbol library

• Circuit simulation limited to circuits with up to 64 nodes, 10 
transistors, two operational amplifiers, or a combination 
thereof, and 10 ideal transmission lines with not more than 
four non-ideal lines (lossy lines using RLGC parameters) 
and four coupled lines

• Device characterization limited to diodes

• Sample library includes 22 analog parts

*. PSpice Basics package includes all libraries except SCRs, thyristors, 
PWMs, magnetic cores, and transmission lines.

**. Unlimited circuit size means you can have as many components in your 
design as can be accommodated by your computer’s memory—rule-of-thumb 
is one Mb of RAM for every 400 transistors or 4,000 gates in the circuit. The 
PSpice Basics package is limited by the total device count: 100 large devices 
(all transistors and ABM devices) or 500 small devices

Miscellaneous specifications

unlimited circuit size yes no **

Feature PSpice
PSpice
Basics
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Part One provides basic information about circuit simulation
and includes examples of common analyses.

Chapter 1,Simulation Overview, provides an overview of the 
circuit simulation process and describes standard simulation
analysis types.

Chapter 2,Simulation Examples, includes examples of 
common analyses which provide an introduction to the metho
and tools for entering circuit designs, running simulations wi
PSpice, and analyzing simulation results using Probe. 
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Chapter Overview
This chapter provides an overview of the circuit simulation 
process and describes standard simulation analysis types.

Creating and Analyzing Circuits on page 1-2 describes the 
process of circuit simulation. The simulation process consists
creating and preparing a circuit for simulation, simulating a 
circuit with PSpice, and displaying simulation results.

Analysis Types on page 1-6 describes the analysis types for 
PSpice.
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The term “simulator” refers to 
PSpice, which simulates analog 
circuits.
Creating and Analyzing 
Circuits
Figure 1-1 illustrates the process of creating a circuit, simulat
the circuit, and displaying the simulation results. This proces
consists of the following:

1 The circuit schematic is created and prepared for simulat
using MicroSim Schematics.

2 Circuit simulation and analysis are performed by PSpice

3 Probe is used to display simulation results.

Each of these procedures is described in the following page

Figure 1-1 Circuit Analysis File Interactions

custom
include fil

local
models

model
definitions

input
waveforms

stimulus f

simulation
primitives

MicroSim
PSpice

simulation
directives

netlist

MicroSim
Schematics

output fil

circuit file set

simulation
audit

simulation
results

Probe
data file

MicroSim
Probe

Probe
markers

global
models
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The filename of the primary 
circuit file is schematic.cir , 
where schematic is the name of 
the schematic.

The filename of the netlist file is 
schematic.net , where schematic 
is the name of the schematic.

The filename of the alias file is 
schematic.als , where schematic 
is the name of the schematic.

The most commonly used 
models are available in the 
MicroSim model library. If 
needed, however, you can 
create models. See Chapter 
5 Creating Modelsfor more

See The Stimulus Editor Utility 
on page 10-5 for a description of 
how to use the Stimulus Editor.

Note PSpice Basics
 does not include the 
Stimulus Editor.
Creating and Preparing a Circuit 
for Simulation
The following files are used for circuit simulation:

• Circuit file set

• Model files

• Stimulus files

• Custom include files

Circuit file set

The circuit file set includes the following files:

• Primary circuit file, which contains analysis commands, 
simulation control commands, and references to the netl
alias, model, and other files required by the circuit to be 
simulated.

• Netlist file, which describes the components and 
connections of the circuit.

• Alias file, which maps the Schematics part and pin names
the simulator device and node names.

Model files 

Model files contain the electrical definition of the component
of a schematic. Each model is comprised of an individual dev
or a subcircuit.

Device models describe a primitive part by a set of paramete
Subcircuits are functional groupings of components to which
elements in external circuits can be connected.

Stimulus files

Stimulus files are user-defined files containing analog stimul
waveform specifications. These can be automatically create
using the Stimulus Editor utility or created manually. The 
creation of these files is transparent when specifying VSTIM
ISTIM, or DIGSTIM stimulus part instances in your schemati
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See Part Three, Setting Up and 
Running Analyses, for a 
description of how to set up and 
perform simulation.

See Part Four, Viewing Results, 
for a description of how to use 
Probe to display simulation 
results.
Custom include files 

Custom include files are user-defined files containing simula
command and device instructions referenced in the circuit fi
set. These files can include user-defined functions that are u
in numeric expressions.

Simulating a Circuit with 
PSpice
Simulation and analysis are performed by PSpice. The simula
interprets the information in the Schematics files for the circu
runs the simulation, and produces the Probe data file and 
simulation output file.

To simulate a circuit, the wire connections to the pins of par
shown in a schematic are transformed into electrical node 
connections to device terminals that are understood by the 
simulator.

PSpice is a analog electrical circuit simulator that can calcul
the behavior of analog circuits with speed and accuracy. PSp
simulates analog circuits and calculates voltages and curren
the devices and nodes.

PSpice uses the files generated by Schematics to run the 
simulation, and produces a Probe data file and simulation out
file.

Displaying Simulation Results
Simulation results are written to the Probe data file and 
simulation output file.

Probe data file

The Probe data file contains simulation results to be viewed 
manipulated interactively with the graphical waveform analyz
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program, Probe. As the simulation proceeds, the simulator 
updates the Probe data file with simulation results.

Probe reads the data stored in the Probe data file and displa
waveforms reflecting circuit response at marked nets, pins, a
devices in your schematic or for output variables specified in
Probe. The results can be further manipulated through 
expressions and search functions, and families of curves ca
displayed on a single plot.

Analyzing data in Probe can help you to determine the valid
of your design. Both your schematic and simulation setup 
parameters can be refined based upon earlier results, thus 
creating an iterative process of running simulations and Pro
analyses.

Simulation output file

The simulation output file is an ASCII text file containing lists
and tables describing the input circuit, the analysis directive
and the results of the specified simulations—in essence, an a
trail of simulation events and results.

The content of the simulation output file is determined by the
types of analyses run, the options selected for running PSpi
and the pseudocomponents placed and connected to nets in
schematic. For example, each instance of a VPRINT1 
pseudocomponent placed in your schematic and connected
different net causes PSpice to save the voltage values at tho
nets to the simulation output file. Any warning or error 
messages encountered during read-in or simulation are also
written to the output file.
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See Chapter 2,Simulation 
Examples, for introductory 
examples of how to run each 
type of analysis.

See Part Three, Setting Up and 
Running Analyses, for a more 
detailed description of how to run 
each type of analysis.
Analysis Types
PSpice circuit analyses can be classified as follows:

• Standard

• Simple multi-run

• Statistical

These analyses types are described in the following pages.

Standard analyses
PSpice standard analyses include the following:

Table 1-1 PSpice Standard Analysis Types

DC sweep Voltages and currents of the circuit’s steady-
state response are calculated where a source
model parameter, or temperature is swept ove
a range of values.

Bias point detail Additional bias point data is calculated and 
reported (bias point is computed automatically
by PSpice). 

DC sensitivity Calculates the DC sensitivity of a node or 
component’s voltage as a function of bias 
point.

Small-signal DC 
transfer

Calculates small-signal DC gain, input 
resistance, and output resistance as a function
of bias point.

Frequency 
response 
(AC sweep) 

Calculates the small-signal response of the 
circuit, linearized around the bias point, to a 
combination of inputs. One or more sources 
are swept over a range of frequencies. The 
voltages and currents of the circuit are 
calculated, including magnitude and phase. 
This can be used to obtain Bode plots.
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Simple multi-run analyses
The following PSpice analyses allow the circuit-wide 
temperature, a global parameter, or a characteristic of a 
particular component to be changed, resulting in each speci
DC sweep, AC sweep, or transient analysis being rerun with 
new value. The simple multi-run analyses provided are:

Noise analysis A noise analysis can be performed in 
conjunction with the frequency response 
analysis. The contribution of each noise 
generator in the circuit is propagated to an 
output node for every frequency specified in 
the AC analysis. These propagated 
contributions, as well as their RMS sum, are 
calculated for each frequency.

Transient 
response

Circuit behavior is tracked over time in 
response to time-varying sources. The 
voltages and currents are computed. 

Fourier 
components

A Fourier analysis can also be performed in 
conjunction with a transient analysis. 
Calculates the DC and Fourier components of
the transient analysis results.

Table 1-2 PSpice Simple Multi-Run Analysis Types

Parametric Repeats the specified standard analyses as 
global parameter, model parameter, 
component value, or operational temperature 
is stepped through a series of values.

Temperature Repeats the specified standard analyses as 
operational temperature is stepped through a 
list of values.

Table 1-1 PSpice Standard Analysis Types (continued)



1-8 Simulation Overview

 
le 
sis. 

 

not
included

in:
Statistical analyses
Two PSpice analyses are provided that allow device and lot
tolerances to be applied to device models, resulting in multip
runs of the specified DC sweep, AC sweep, or transient analy
The statistical analyses provided are:

Table 1-3 PSpice Statistical Analysis Types

Monte Carlo Computes circuit response to changes in 
component values by randomly varying all 
device model parameters for which a tolerance
has been specified.

Sensitivity/
worst-case

Computes circuit response to changes in 
component values by varying one device 
model parameter (where a tolerance is 
specified) at a time on a device by device 
basis, culminating in a single run where all 
model parameters for all devices are set to 
their worst-case values.
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Chapter Overview
The examples in this chapter provide an introduction to the 
methods and tools for entering circuit designs, running 
simulations with PSpice, and analyzing simulation results us
Probe. All analyses are performed on the same example circ
This allows for a clearer illustration of analysis setup, 
simulation, and result analysis procedures for each analysis
type.

This chapter includes the following sections:

Example Circuit Design Entry on page 2-2

Bias Point Analysis on page 2-6

DC Sweep Analysis on page 2-9

Transient Analysis on page 2-14

AC Sweep Analysis on page 2-18

Parametric Analysis on page 2-22

Probe Performance Analysis on page 2-28
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New icon: 

Shortcut: Click on  or press 
C g

If you have enough room on your 
screen, click on Place to leave 
the Part Browser dialog box 
open.
Example Circuit Design 
Entry
This section describes how to use MicroSim Schematics to e
the simple diode clipper circuit shown in Figure 2-1.

Figure 2-1 Diode Clipper Circuit

To open a new schematic window

1 Start Schematics. If Schematics is already running, be s
you are in the schematic editor.

2 If you are in a blank schematic window (indicated by “new
in the title bar at the top of the window), you can begin 
entering the circuit.

If you need to open a new schematic window, click the Ne
icon or select New from the File menu.

To place the voltage sources

1 Select Get New Part from the Draw menu to display the P
Browser dialog box.

2 Type VDC in the Part Name text box.

3 Click on Place & Close. 

4 Move the cursor to position the source at the desired 
location on the schematic page.
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If needed, click on  to 
redisplay the Part Browser dialog 
box.

When placing components:

• Leave space to connect the 
components with wires.

• If device names and values 
don’t match the names 
shown in Figure 2-1, they can 
be changed later.

Select Redraw from the View 
menu or press C+l to redraw 
the circuit as necessary.
5 Click to place the first source.

6 Move the cursor and click again to place the second sou

7 Right-click to end placement mode.

To place the diodes

1 Go to the Part Browser dialog box.

2 Type D1N39* in the Part name text box.

3 Press J to display a list of diodes.

4 Click on D1N3940.

5 Click on Place (to leave the dialog box open) or Place &
Close (to close the dialog box).

6 Press C+r to rotate the diode outline to the desired 
orientation.

7 Click to place the first diode (D1), and click again to plac
the second diode (D2).

8 Right-click to end placement mode.

To move the text associated with the diodes (or 
any other object)

1 Click once on the text to select it.

2 Drag the text to the desired location.

To place the other components

Follow similar steps as described for the diodes to place the
components listed below. The symbol names you need to ty
in the Part name text box of the Part Browser dialog box are
shown in parentheses.

1 resistors (R)

2 capacitor (C)

3 ground symbols (EGND)

4 bubble symbols (BUBBLE)
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Shortcut: Click on  or press 
C+w.

You can right-click at any time to 
stop the wiring mode. The cursor 
changes to the default arrow.

If necessary, double-right click or 
press s to resume wiring 
mode. The cursor changes back 
to a pencil.

Clicking on any valid connection 
point terminates a wire. A valid 
connection point is shown as an 
“x” (see Figure 2-2).

If you make a mistake when 
placing or connecting 
components:

1 Click on the wire or 
component.

2 Press X.

Figure 2-2 Connection Points

Bubbles serve as “wireless” 
connections where connectivity 
is implied by identical labels.
To connect the components

1 Select Wire from the Draw menu to enter wiring mode. Th
cursor changes to a pencil.

2 Click on the connection point (the very end) of the pin on t
bubble at the input of the circuit. 

3 Click on the nearest connection point of the input resisto
R1.

4 Connect the other end of R1 to the output capacitor.

5 Connect the diodes to each other and to the wire betwee
them:

a Click on the connection point of the anode for the low
diode.

b Move the cursor straight up and click on the wire 
between the diodes. The wire terminates and the 
junction of the wire segments is made visible.

c Click again on the junction to continue wiring

d Click on the end of the upper diode’s cathode pin.

6 Continue connecting components until the circuit is wire
as shown in Figure 2-1 on page 2-2.

To assign names (labels) to the nets and bubbles

1 Double-click on any segment of the wire which connects
R1, R2, R3, the diodes, and the capacitor.

2 Type Mid  in the Label text box.

3 Click on OK.

4 Double-click on each bubble to label it as shown in 
Figure 2-1 on page 2-2.
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Example: assigning the name 
“Vin” for the second VDC.

1 Double-click on the reference 
designator of the VDC 
symbol, V2.

2 Type Vin  in the Edit 
Reference Designator dialog 
box.

3 Click on OK.

Shortcut: Click on  or press 
C+s.
To place the viewpoint symbol

1 Type VIEWPOINT in the Part Name text box of the Part 
Browser dialog box.

2 Place the viewpoint so that its connection point (pin end
touches the wire labeled Mid.

To assign a name to a device

A particular name can be assigned to a device in the schem
(like “Vin” for a VDC, or Cout for the capacitor) as follows:

1 Double-click on the reference designator for the device.

2 Type the new name in the Edit Reference Designator dia
box.

3 Click on OK.

To change the value of a device

1 Double-click on the value for the device.

2 Type the new value in the Edit Value dialog box.

3 Click on OK.

To save your schematic

1 Select Save from the File menu.

2 Type CLIPPER as the schematic file name.

3 Click on OK to save the file as clipper.sch .
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Shortcut: Click on  or press 
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Bias Point Analysis

Running PSpice
After creating the schematic clipper.sch , you can run PSpice 
by selecting Simulate from the Analysis menu. PSpice perfor
the simulation and generates the output file (clipper.out ).

While PSpice is running, the progress of the simulation is 
displayed in the PSpice simulation status window (see 
Figure 2-3).

Figure 2-3 PSpice Simulation Status Window
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 The voltage at net Mid is in 
agreement with manual 
calculation:

where:

Correct, expected bias point 
analysis results provide 
assurance of proper circuit 
connectivity.

V MI D( )
Req

R2 Req+
------------------------ VCC×=

Req
R1 R3×
R1 Req+
------------------------=
Simulation Output File 
The simulation output file acts as an audit trail of the simulatio
This file optionally echoes the contents of the circuit file as w
as the results of the bias point calculation. If there are any syn
errors in the netlist declarations or simulation directives or 
anomalies while performing the calculation, error and/or 
warning messages are written to the output file.

To view the simulation output file

1 Close the PSpice window.

2 In Schematics, select Examine Output from the Analysis
menu to display the output file in the MicroSim text edito
window. Figure 2-4 shows the results of the bias point 
calculation as written in the simulation output file 
(clipper.out ).

3 When finished, close the MicroSim text editor window.

Figure 2-4 Simulation Output File

Since the diodes are both reverse biased (off), and the inpu
source Vin is 0V (a short circuit to ground), the bias point is 
dependent only on the values of VCC, R1, R2, and R3.
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Note that the current through VIN is negative. By convention
PSpice measures the current through a two terminal device 
the first terminal and out of the second terminal. For voltage
sources, current is measured from the positive terminal to th
negative terminal; this is opposite to the positive current flow
convention and results in a negative value.

Voltage Viewpoint
The VIEWPOINT symbol was initially a blank line. When the
simulation is finished and bias point voltages are available, 
viewpoint reflects the voltage at the net to which it was 
connected (in this case, the voltage at the node Mid is 0.943
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Shortcut: Click on .

Figure 2-5 DC Sweep Dialog 
Box

Save icon: 

Shortcut: Click on  or press 
!.
DC Sweep Analysis
You can visually verify the DC response of the clipper by 
performing a DC sweep of the input voltage source and 
displaying the waveform results in Probe. This example sets
DC sweep analysis parameters to sweep Vin from -10 to 15 v
in 1 volt increments.

Setting Up and Running a DC 
Sweep Analysis

To set up and run a DC sweep analysis

1 Select Setup from the Analysis menu.

2 Click on the DC Sweep button in the Analysis Setup dialo
box.

3 Set up the DC Sweep dialog box as shown in Figure 2-5

Note The default settings for the DC Sweep dialog box 
are Voltage Source as the swept variable type and 
Linear as the sweep type. To select a different 
swept variable type or sweep type, click on the 
appropriate radio button.

4 Click on OK to exit the DC Sweep dialog box.

5 If needed, click on the DC Sweep check box in the Analys
Setup dialog box so that it is checked on (enabled).

6 Click on Close to exit the Analysis Setup dialog box.

7 Click on the Save icon.

You can also save the circuit under a different name. To
save the circuit as clipperd.sch , for example, select Save
As from the File menu in the schematic editor and enter
clipperd  as the file name.

8 To run the analysis as specified, select Simulate from th
Analysis menu.
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To set up Probe to automatically 
run after simulation, select Probe 
Setup from the Analysis menu 
and click on the Automatically 
Run Probe After Simulation box 
so that it is checked on.

Shortcut: Click on  or press 
I.
Displaying DC Analysis Results 
in Probe
If Probe is set up to automatically run upon successful 
completion of a simulation (the default setting), then the Pro
window is displayed when the simulation is finished. The Pro
window displays a plot screen like the one shown in Figure 2

To plot voltages at nets 1 and 2

1 Select Add from the Trace menu.

2 Click on V(In) and V(Mid) in the Add Traces dialog box.

3 Click on OK.

To display traces using markers

1 Delete the two traces you plotted above:

a Click on the text V(In) located under the X axis of the
plot to select trace V(In).

b Press and hold the V key and click on V(Mid) to also 
select trace V(Mid).

c Press X to remove both traces.

Figure 2-6 Probe Plot
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Shortcut: press C+M.

You can click on  in 
Schematics to save the 
schematic with markers.

Labels are included in Figure 2-7 
for informational purposes only. 
Refer to the Schematics User’s 
Guide for a description of how to 
add labels.

This example uses the cursors 
feature to view the numeric 
values for two traces and the 
difference between them by 
placing a cursor on each trace.

Table 2-1 Association of 
Probe Cursors with Mouse 
Buttons

Figure 2-8 Trace Legend with 
Cursors Activated

Cursor 1 left mouse button

Cursor 2 right mouse button
2 In Schematics, select Mark Voltage/Level from the Marke
menu.

3 Click to place the first marker on net In.

4 Click to place the second marker on net Mid.

5 Right-click to end marker mode. Waveform traces are 
displayed as shown in Figure 2-7.

To place a cursor on each trace

1 In Probe, select Cursor from the Tools menu, then selec
Display to activate cursors.

Two cursors are activated for the first trace defined in th
legend below the X axis—V(In) in this example. The Prob
Cursor window is also displayed.

2 To display the cursor cross-hairs:

a Position the mouse cursor anywhere inside the plot 
window.

b Click to display the cross-hairs for the first cursor.

c Right-click to display the cross-hairs for the second 
cursor.

Figure 2-7 Voltage at In and Mid

trace legend
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Your ability to get as close to 4.0 
as possible depends on screen 
resolution and window size.

Figure 2-9 Trace Legend with 
V(Mid) Symbol Outlined

There are other ways to display 
the difference between two 
voltages at a trace:

• By plotting “V(In)-V(Mid)” in 
Probe

• By selecting Mark Voltage 
Differential from the Markers 
menu in Schematics
In the trace legend, the symbol for V(In) is outlined in the
crosshair pattern for each cursor, resulting in a dashed l
as shown in Figure 2-8.

3 Place the first cursor on the V(In) waveform:

a Click on the portion of the V(In) trace in the proximity
of 4 volts on the X axis. The cursor cross-hair is 
displayed, and the current X and Y values for the firs
cursor are displayed in the Probe Cursor window.

b To fine-tune the cursor location to 4 volts on the X axi
drag the cross-hairs until the corresponding entry in t
Probe Cursor window is approximately 4.0 for the X 
axis value of the A1 cursor. You can also press r and 
l for tighter control.

4 Place the second cursor on the Mid waveform:

a Associate the second cursor with the Mid waveform b
right-clicking on the trace legend symbol for V(Mid) 
(on the diamond). The crosshair pattern for the seco
cursor outlines the V(Mid) trace symbol as shown in 
Figure 2-9.

b Right-click on the portion on the V(Mid) trace that is in
the proximity of 4 volts on the X axis. The X and Y 
values for cursor 2 are displayed in the Probe Curso
window along with the difference between the two 
cursors’ X and Y values.

c To fine-tune the location of the second cursor to 4 vo
on the X axis, drag the cross-hairs until the 
corresponding entry in the Probe Cursor window is 
approximately 4.0 for the X axis value of the C2 curso
You can also press V+r and V+l for tighter 
control.

Figure 2-10 shows the Probe window when both cursors 
placed.
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Figure 2-10 Voltage Difference at V(In) = 4 Volts

At this point, the schematic has been saved. If needed, you 
close Schematics and Probe and begin the remaining analy
exercises later using the saved schematic.
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Shortcut: press C+x.

If your version of Schematics 
does not include the Stimulus 
Editor (Basics users):

1 Place a VSIN symbol instead 
of VSTIM.

2 Double click on it.

3 Double-click on the 
appropriate attributes to set 
their values as VOFF, 
VAMPL, and FREQ. Click on 
Save Attr or press J after 
entering each attribute’s 
value to accept the changes.

4 Click on OK.
Transient Analysis
This example shows how to run a transient analysis on the 
clipper circuit. This requires adding a time-domain voltage 
stimulus as shown in Figure 2-11.

Figure 2-11 Diode Clipper Circuit with a Voltage Stimulus

To add a time-domain voltage stimulus

1 In Schematics, select Clear All from the Markers menu.

2 Select the ground symbol beneath the VIN source.

3 Select Cut from the Edit menu.

4 Scroll down or select Out from the View menu (or click o
the Zoom Out icon).

5 Place a VSTIM symbol as shown in Figure 2-11.

6 Select Paste from the Edit menu.

7 Place the ground symbols as shown in Figure 2-10.

8 Select Fit from the View menu.

9 Select Save As from the File menu, and save the file as 
clippert.sch .

10 Double-click on the VSTIM symbol to start the Stimulus 
Editor.
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Save icon:  
11 When prompted to name the stimulus, type SINE and click 
on OK.

12 In the New Stimulus dialog box of the Stimulus Editor, clic
on SIN, and click on OK.

13 In the Stimulus Attributes dialog box, set the first three 
parameters as follows:

Offset Voltage = 0

Amplitude = 10

Frequency = 1kHz

14 Click on Apply to view the waveform. The Stimulus Edito
window should look like Figure 2-12.

Figure 2-12 Stimulus Editor Window

15 Click on OK.

16 Click on the Save icon or press V+@ to save the 
stimulus information.

17 Select Exit from the File menu.
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Analysis Setup icon:  

Figure 2-13 Transient 
Analysis Dialog Box

Save icon: 

Simulate icon:  
To set up and run the transient analysis

1 In Schematics, click on the Analysis Setup icon or selec
Setup from the Analysis menu to display the Analysis Set
dialog box.

2 Click on Transient to display the Transient Analysis dialo
box.

3 Set up the Transient dialog box as shown in Figure 2-13

4 Click on OK.

5 If needed, click on Transient check box in the Analysis 
Setup dialog box so that it is checked on (enabled).

6 If needed, disable DC sweep from the previous example
clicking on the DC Sweep check box so that it is not 
checked.

DC Sweep is disabled here so that you can see the resul
a transient analysis run by itself. PSpice can run multiple
analyses during simulation, and you could run both DC 
sweep and transient analyses.

7 Click on Close to exit the Analysis Setup dialog box.

8 Click on the Save icon.

9 Click on the Simulate icon or press ! to start the 
simulation.

PSpice uses its own internal time steps for computation. Th
internal time step is adjusted according to the requirements 
the transient analysis as it proceeds. Data is saved to the P
data file for each internal time step.

Note The internal time step is different from the Print 
Step value. Print Step controls how often optional 
text format data is written to the simulation output 
file (.OUT).
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This portion of the example 
describes how to view the input 
sine wave and the clipped wave 
at Out. The output variable list is 
used as an alternative to 
markers to select the traces to be 
displayed.

Save icon: 

These waveforms illustrate the 
clipping of the input signal.
To display the output variable list with aliases 
and display desired traces in Probe

1 Select Add from the Trace menu. (You can also click on t
Add Trace icon or press I.)

2 Select V(Out) and V(In) by clicking on them in the trace lis

3 Click on OK. The traces are displayed.

4 Place the symbols shown in the trace legend on the trac
themselves as shown in Figure 2-14:

a Select Options from the Tools menu.

b Click on Always in the Use Symbols portion of the 
dialog box.

c Click on OK.

5 Click on the Save icon.

Figure 2-14 Sinusoidal Input and Clipped Output Waveform



2-18 Simulation Examples

l) 
e 

 in 

 

 

Time-domain and AC stimuli are 
independent of one another. For 
example, the SINE stimulus is 
ignored (0V) during AC analysis.

The new Vin still has a DC 
attribute which can be used to 
include a bias with the AC 
source. Double-click the AC 
source to see the DC attribute 
value.
AC Sweep Analysis
The AC sweep analysis in PSpice is a linear (or small signa
frequency domain analysis which can be used to observe th
frequency response of any circuit at its bias point.

Setting Up and Running an AC 
Sweep Analysis
This example sets up the clipper circuit for AC analysis by 
adding an AC voltage source for a stimulus signal as shown
Figure 2-15, and by setting up AC sweep parameters.

Figure 2-15 Clipper Circuit with AC Stimulus

To change Vin to include the AC stimulus signal

1 Click on the DC input source, Vin, to select it.

2 Select Replace from the Edit menu.

3 In the Replace Part dialog box, type VAC.

4 Click on the Keep Attribute Values check box so that it is
checked on.

5 Click on OK. The input voltage source changes to an AC
voltage source.
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Analysis Setup icon:  

Figure 2-16 AC Sweep and 
Noise Analysis Dialog Box

Simulate icon:  
6 Double-click on the displayed (AC) value of the new Vin
In the Set Attr Value dialog box, set the value to 1V.

To set up the AC sweep and start simulation

1 Click on the Analysis Setup icon or select Setup from the
Analysis menu to display the Analysis Setup dialog box.

2 Click on AC Sweep.

3 Set up the AC Sweep and Noise Analysis dialog box as 
shown in Figure 2-16.

Note PSpice is not case sensitive, so both M and m can 
be used as “milli,” and MEG, Meg, and meg can all 
be used for “mega.”

4 Click on OK to close the AC Sweep dialog box.

5 Click on Close to close the Analysis Setup dialog box.

6 Select Mark Advanced from the Markers menu.

7 Double-click on vdb.

8 Place one Vdb marker on the output node, and place ano
on the Mid node.

9 Select Save As from the File menu, and save the schem
as clippera.sch .

10 Click on the Simulate icon or press ! to start the 
simulation.

Since the transient analysis was not deactivated, PSpice
performs both the transient and AC analyses.
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AC Sweep Analysis Results
Probe displays the dB magnitude (20log10) of the voltage at
marked nodes, Out and Mid, as shown in Figure 2-17. 
VDB(Mid) has a lowpass response due to the diode capacitan
to ground. The output capacitance and load resistor act as a
highpass filter, so the overall response, illustrated by VDB(ou
is a bandpass response. Since AC is a linear analysis and t
input voltage was set to 1V, the output voltage is the same as
gain (or attenuation) of the circuit.

Figure 2-17 dB Magnitude Curves for “Gain” at Mid and Out

To display a Bode plot of the output voltage, 
including phase

1 Switch back to the Schematics window.

2 Select Mark Advanced from the Markers menu.

3 Place a vphase marker on the output next to the Vdb. 

4 Delete the Vdb marker on Mid.

5 Switch to Probe. The gain and phase plots are both 
displayed on the same graph with the same scale.

6 Click on the trace name, VP(Out), to select it. The text 
should turn red.

Note Depending upon where the vphase marker was 
placed, the trace name may be different, such as 
VP(Cout:2), VP(R4:1), or VP(R4:2).
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Shortcut: Click on  or press 
C+x.

Shortcut: Click on  or press 
C+v.
7 Select Cut from the Edit menu.

8 Select Add Y Axis from the Plot menu.

9 Select Paste from the Edit menu. The Bode plot is display
as shown in Figure 2-18.

Figure 2-18 Bode Plot of Clipper’s Frequency Response
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Parametric Analysis
This example shows the effect of varying input resistance on 
bandwidth and gain of the clipper circuit. This is done by:

• Changing the value of R1 to the expression {Rval}

• Adding a PARAM symbol to declare the parameter Rval

• Specifying a parametric analysis to step the value of R1 
Rval

Figure 2-19 Clipper Circuit with Global Parameter Rval

The example results in 21 analysis runs, each with a differe
value of R1. Once the analysis is complete, you can analyze
curve families for the analysis runs in Probe.
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PSpice interprets text in curly 
braces as an expression which 
evaluates to a numerical value. 
This example uses the simplest 
form of an expression—a 
constant. The value of R1 will 
take on the value of the Rval 
parameter, whatever it may be.

Part Browser icon:  
Setting Up and Running the 
Parametric Analysis

To change the value of R1 to the expression 
{Rval}

1 Double-click on the value of R1.

2 Type {Rval}  in the Set Attribute Value dialog box. 

3 Click on OK.

To add a PARAM symbol to declare the parameter 
Rval

1 Click on the Part Browser icon or press C+g.

2 Type PARAM in the Part text box, and click on OK.

3 Place one PARAM symbol on the schematic.

4 Double-click on the PARAM symbol to display the 
attributes list.

5 Double-click on NAME1 and type Rval  (no curly braces) in 
the Value text box.

6 Click on Save Attr to accept the changes.

7 Double-click on VALUE1, type 1k , and click on Save Attr.

8 Click on OK. Rval 1k is displayed in the PARAMETERS 
list on the schematic. 
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Analysis Setup icon:  

Figure 2-20 Parametric Dialog 
Box

This setup specifies that the 
parameter Rval is to be stepped 
from 100 to 10k logarithmically 
with a resolution of 10 points per 
decade. 

The analysis is run for each 
value of Rval. Since the value of 
R1 is defined as {Rval}, the 
analysis is run for each value of 
R1 as it logarithmically increases 
from 100Ω to 10 kΩ in 20 steps, 
resulting in a total of 21 runs.
To set up and run a parametric analysis to step 
the value of R1 via Rval

1 Click on the Analysis Setup icon or select Setup from the
Analysis menu to display the Analysis Setup dialog box.

2 Click on Parametric.

3 Set up the Parametric dialog box as shown in Figure 2-2

4 Click on OK.

5 If needed, click on the Parametric check box in the Analy
Setup dialog box so that it is checked on (enabled).

6 Click on the Transient check box so that it is not checked.

7 Click on Close to close the Analysis Setup dialog box.

8 Select Save As from the File menu, and save the schem
as clipperp.sch .

9 Delete the VP marker. (For this example, we are only 
interested in the magnitude of the response.)

10 To run the analysis as specified, click on the Simulate ic
or press !.
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To select individual runs, click on 
each one separately.

To see more information about 
the section which produced a 
specific trace, double-click on 
the corresponding symbol in the 
legend below the X axis.

You can also remove the traces 
by deleting the VDB marker in 
Schematics.

Shortcut: Click on  or press 
I.
You can avoid some of the typing 
for the Trace Command text box 
by clicking on the V(OUT) 
selection in the trace list and 
editing the resulting Trace 
Command to insert text where 
appropriate.
Analyzing Waveform Families in 
Probe

To display all 21 traces in Probe

1 There are 21 analysis runs, each with a different value of R
When Probe starts, it displays the Available Sections dia
box which lists all 21 runs and the Rval parameter value 
each. You have the option to select one or more runs.

Click on OK to accept the default of all runs. All 21 trace
(the entire family of curves) for VDB(Out) are displayed i
Probe as shown in Figure 2-21.

Figure 2-21 Small Signal Response as R1 is Varied from 100Ω 
to 10 kΩ

2 To remove the traces shown, click on the trace name to 
select it and then press X.

To compare the last run to the first run

1 Select Add from the Trace menu.

2 Type the following text in the Trace Command text box:

Vdb(Out)@1 Vdb(Out)@21
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Shortcut: Click on  or press 
I.

Shortcut: Click on .

Shortcut: Click on .

Shortcut: Click on .

This command instructs Probe to 
search for the point on the trace 
where the X axis value is 100.
Note The difference in gain is apparent, you can also 
plot the difference of the waveforms for runs 21 
and 1 and then use the search commands feature 
to find certain characteristics of the difference.

3 Delete the two traces.

4 Plot the new trace by specifying a waveform expression

a Select Add from the Trace menu.

b Type the following waveform expression in the Trace
Command text box:

Vdb(Out)@1-Vdb(OUT)@21

c Click on OK.

5 Use the search commands feature to find the value of th
difference trace at its maximum and at a specific frequen

a Select Cursor from the Tools menu, and then select 
Display.

b Select Cursor from the Tools menu, and then select 
Max.

c Select Cursor from the Tools menu, and then select 
Search Commands.

d Enter the following search command:

search forward x value (100)

e Select cursor 2 as the cursor to move.

f Click on OK.

Figure 2-22 shows the Probe window when the cursors 
placed.

Note that the Y value for cursor 2 shown in the cursor bo
at the lower right is about 17.87. This indicates that when 
is set to 10 kΩ, the small signal attenuation of the circuit a
100Hz is 17.87dB greater than when R1 is 100Ω.

6 Deactivate the cursors and delete the trace to prepare for
next exercise.
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Figure 2-22 Comparison of Small Signal Frequency Respon
at 100 and 10 kΩ Input Resistance
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At each step, the wizard provides 
information and guidelines to 
follow.

Shortcut: Click on , then 
double-click on V(Out).
Probe Performance 
Analysis
Probe's performance analysis is an advanced feature that ca
used to compare the characteristics of a family of waveform
Performance analysis uses the principle of search command
introduced earlier in this chapter to define functions which 
detect points on each curve in the family.

Once these functions have been defined, they can be applie
a family of waveforms using Add on the Trace menu and 
produce traces that are a function of the variable that chang
within the family.

This example shows how to use the performance analysis 
feature of Probe to view the dependence of circuit 
characteristics on a swept parameter. In this case, the smal
signal bandwidth and gain of the clipper circuit are plotted 
against the swept input resistance value.

To plot bandwidth vs. Rval using the performance 
analysis wizard

1 In Probe, select Performance Analysis from the Trace me
The Performance Analysis dialog box is displayed with 
information on the currently loaded data and performanc
analysis in general.

2 Click on Wizard.

3 Click on Next>.

4 Click on Bandwidth in the Choose a Goal Function list, an
then click on Next>.

5 Click in the Name of Trace text box, and type V(Out) .

6 Click in the db Level Down text box and type 3.

7 Click on Next>. The wizard displays the gain trace for th
first run (R=100) and shows how the bandwidth is 
measured. This is done to test the goal function.

8 Click on Next> or Finish. Probe displays a plot of the 3d
bandwidth vs. Rval.
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Shortcut: Double-click on the X 
axis.

Shortcut: Click on  or press 
I.

The Trace list includes goal 
functions only in performance 
analysis mode when the X-axis 
variable is the swept parameter.
9 Change the X-axis to log scale.

a Select X Axis Settings from the Plot menu.

b Select Log in the Scale list box.

c Click on OK.

To plot gain vs. Rval manually

1 Select Add Y Axis from the Plot menu.

2 Select Add from the Trace menu.

3 Click on the Max(1) goal function. Use the scroll bar to 
move to the right in the Trace list.

4 Scroll to the left again and click on V(out). 

5 Edit the Trace Command text box to be Max(Vdb(out)) , 
and click on OK. Probe displays gain on the second Y ax
vs. Rval.

Figure 2-23 shows the final performance analysis plot of 3dB
bandwidth and gain in dB vs. the swept input resistance val

Figure 2-23 Performance Analysis Plots of Bandwidth and 
Gain vs. Rval

For more information about performance analysis, see Example: 
RLC Filter on page 11-3.
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Part Two provides information about entering circuit designs
MicroSim Schematics.

Chapter 3,Preparing a Schematic for Simulation, provides 
information to help you enter circuit designs that simulate 
properly.

Chapter 4,Creating Symbols, provides information about 
creating symbols. Symbols are the graphical representation
circuit components.

Chapter 5,Creating Models, provides information about 
creating models. Models define the electrical behavior of 
schematic components for purposes of simulation.

Chapter 6,Analog Behavioral Modeling, describes how to use
Analog Behavioral Modeling (ABM) feature provided in 
PSpice.



Preparing a Schematic for 
Simulation
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supplements the
the Schematics U
The Schematics 
describes how to
Schematics to cr
schematics, and
includes addition
help you set up c
ensure proper si
schematic.
3
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 information in 
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mulation of the 
Chapter Overview
This chapter provides information to help you enter circuit 
designs that simulate properly.

Passive Parts on page 3-2 describes setup information for a 
variety of analog parts. For a listing of standard library 
components, refer to the on-line Library Reference Manual.

Parameters and Expressions on page 3-9 describes how to use 
parameters and expressions in place of literal values.

Analog Power Supplies on page 3-13 describes setup 
information for DC sources.
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*. The Symbol Library file ANALOG_P.S
the symbols in this file instead of those
ANALOG_P.SLB to the list of configure
Schematics User’s Guide for a d

Table 3-1 Resistor, Capacitor,

Part Type
Symbol 
Name

capacitor
(PSpice ‘C’ device)

C

C_VAR

inductor
(PSpice ‘L’ device)

L

resistor
(PSpice ‘R’ device)

R

R_VAR
Passive Parts
This section describes setup information for a variety of ana
parts. For a listing of standard library components, refer to t
on-line Library Reference Manual.

Resistors, Capacitors, and 
Inductors
Also see Resistors, capacitors, and inductors on page 5-26.

LB contains R, L, C, R_VAR, and C_VAR symbols with visible pin numbers. To use 
 in ANALOG.SLB, use Editor Configuration on the Options menu to add 
d Symbol Library files before the ANALOG.SLB file entry. Refer to the 

escription of how to use Editor Configuration.

 and Inductor Attributes

Symbol Library 
File

Attribu
te

Description

analog.slb
analog_p.slb*

VALUE capacitance

IC initial voltage across the 
capacitor during bias point 
calculation

VALUE base capacitance

SET multiplier

analog.slb
analog_p.slb

VALUE inductance

IC initial current through the 
inductor during bias point 
calculation

analog.slb
analog_p.slb

VALUE resistance

TC linear and quadratic 
temperature coefficients

VALUE base resistance

SET multiplier
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For the standard R, C, and L parts, the effective value of the p
is set directly by the VALUE attribute. For the variable resisto
and capacitors, R_VAR and C_VAR, the effective value is th
product of the base value (VALUE) and multiplier (SET).

In general, resistors, capacitors, and inductors should have 
positive component values (VALUE attribute). In all cases, 
components must not be given a value of zero.

However, there are cases when negative component values
desired. This occurs most often in filter designs that analyze
RLC circuit equivalent to a real circuit. When transforming fro
the real to the RLC equivalent, it is possible to end up with 
negative component values.

PSpice allows negative component values for bias point, DC
sweep, AC, and noise analyses. In the case of resistors, the n
contribution from negative component values come from the
absolute value of the component (components are not allowe
generate negative noise). A transient analysis may fail for a
circuit with negative components. The negative components
especially negative-valued capacitors and inductors, may cre
instabilities in time which the analysis cannot handle. 
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Table 3-2 Transformers

Part Type Symbol Nam

transformer
(PSpice ‘K’ and ‘L’ 
devices)

XFRM_LINE

K_LINEAR
Transformers
Table 3-2 lists attributes that can be set per instance of a line
transformer part.

For additional information:

• See Transformers on page 5-29.

• See Using the Inductor Coupling Symbols in the Application 
Notes Manual for a description of techniques for creating 
additional transformer configurations.

• See Using the KBREAK symbol in a schematic on 
page 5-27 for information about using nonlinear magnetic
cores with transformers.

e
Symbol Library 
File

Attribute Description

AR analog.slb L1_VALUE
L2_VALUE

winding inductances 
in Henries

COUPLING coefficient of mutual 
coupling (must lie 
between 0 and 1)

analog.slb Ln inductor reference 
designator



Passive Parts 3-5

n 

 of a 
ce, 
ned 

se 
 
h, 
 
ugh 
istic 
nd 

Description

characteristic impedance

transmission delay

frequency for NL

number of wavelengths or wave 
number

electrical length

per unit length resistance

per unit length inductance

per unit length conductance

per unit length capacitance
Transmission Lines

Ideal and lossy transmission lines

Table 3-3 lists the attributes that can be set per instance of a
ideal (T) or lossy (TLOSSY) transmission line. The parts 
contained in the tline.slb  symbol file contain a variety of 
transmission line types. Their part attributes vary.

PSpice uses a distributed model to represent the properties
lossy transmission line. That is, the line resistance, inductan
conductance, and capacitance are all continuously apportio
along the line’s length.

A common approach to simulating lossy lines is to model the
characteristics using discreet passive elements to represent
small sections of the line. This is the lumped model approac
and it involves connecting a set of many small subcircuits in
series as shown in Figure 3-1. This method requires that eno
lumps exist to adequately represent the distributed character
of the line. This often results in the need for a large netlist a
correspondingly long simulation time. The method also 

*. Not available for Basics users.

Table 3-3 Transmission Lines

Part Type
Symbol 
Name

Symbol 
Library File

Attribu
te

transmission line
(PSpice ‘T’ device)

T analog.slb Z0

TD

F

NL

TLOSSY* analog.slb LEN

R

L

G

C
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produces spurious oscillations near the natural frequencies 
the lumped elements.

Figure 3-1 Lossy Line Comprised of Lumped Line Segmen

The distributed model used in PSpice frees you from having
determine how many lumps are sufficient, and eliminates th
spurious oscillations. It also allows lossy lines to be simulate
with the same accuracy in a fraction of the time required by 
lumped approach.

In addition, you can make R and G general Laplace expressio
This allows frequency dependent effects to be modeled, suc
skin effect and dielectric loss.

Coupled transmission lines 

Table 3-4 lists the attributes that can be set per instance of a
coupled transmission line symbol. The symbol library provid
symbols that can accommodate up to five coupled transmiss
lines. You can also create new symbols that have up to ten 
coupled lines.

lumped line segment
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UPLEDX implementation uses the expansion 

Description

electrical length

per unit length resistance

per unit length inductance

per unit length conductance

per unit length capacitance

per unit length mutual inductance

per unit length mutual capacitance

electrical length

per unit length resistance

per unit length inductance

per unit length conductance

per unit length capacitance

per unit length mutual inductance

per unit length mutual capacitance

name of first coupled line

name of second coupled line

per unit length mutual inductance

per unit length mutual capacitance

name of first coupled line

name of second coupled line

name of third coupled line

per unit length mutual inductance 
between line Ti and line Tj

per unit length mutual capacitance 
between line Ti and line Tj
*. T2COUPLEDX is functionally identical to T2COUPLED. However, the T2CO
of the subcircuit referenced by T2COUPLED.

Table 3-4 Coupled Transmission Lines

Part Type Symbol Name
Symbol 
Library File

Attribu
te

coupled
transmission line—
symmetric 
(PSpice ‘K’ and ‘T’ 
devices)

T2COUPLED

T3COUPLED

T4COUPLED

T5COUPLED

tline.slb LEN

R

L

G

C

LM

CM

coupled transmission 
line—asymmetric
(PSpice ‘K’ and ‘T’ 
devices)

T2COUPLEDX*

T3COUPLEDX

T4COUPLEDX

T5COUPLEDX

tline.slb LEN

R

L

G

C

LM

CM

transmission line 
coupling matrix 
(PSpice ‘K’ device)

KCOUPLE2 tline.slb T1

T2

LM

CM

KCOUPLE3

KCOUPLE4

KCOUPLE5

T1

T2

T3

LMij

CMij
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Simulating coupled lines

Coupling between transmission lines can be simulated using
PSpice K device. Each of the coupled transmission line part
provided in the standard symbol library translate to K device a
T device declarations in the netlist. PSpice compiles a system
coupled lines by assembling capacitive and inductive coupli
matrices from all of the K devices involving transmission line
Though the maximum order for any one system is ten lines,
there is no explicit limitation on the number of separate syste
that may appear in one simulation. 

The simulation model is accurate for:

• ideal lines

• low-loss lossy lines

• systems of homogeneous, equally spaced high-loss line

For more information about the K device, refer to the PSpice 
Reference Manual.

Simulation considerations

When simulating, transmission lines with short delays can 
create performance bottlenecks by setting the time step ceil
to a very small value.

If one transmission line is setting the time step ceiling 
frequently, PSpice reports the three lines with the shortest ti
step. The percentage attenuation, step ceiling, and step ceilin
percentage of transmission line delay are displayed in the 
PSpice status window.

If your simulation is running reasonably fast, you can ignore th
information and let the simulation proceed. If the simulation 
slowed significantly, you may want to abort the simulation an
modify your design. If the line is lossy and showing negligibl
attenuation, model the line as ideal instead.
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The OPTPARAM 
pseudocomponent can also be 
used to define global 
parameters, though its primary 
use is to define design 
parameters for use with the 
PSpice Optimizer. If you choose 
to use OPTPARAM, up to eight 
parameters can be defined by 
specifying values for Name and 
Initial Value.

Note The system variables in 
Table 3-7 on page 3-13 have 
reserved parameter names. 
User-defined parameters 
should not use these 
parameter names.
Parameters and 
Expressions

Parameters
In many applications, it is convenient to use a parameter inst
of a numeric value. A parameter is like a programming variab
used to indirectly represent a value. Parameters are useful f
assigning like values to multiple part instances as well as set
up analyses involving swept variables (parametric, for 
example).

A parameter is defined using the PARAM pseudocomponen
Up to three parameters can be defined per PARAM instance
assigning each parameter’s name and value to the correspon
NAMEn and VALUEn attributes. These are global to the entir
schematic regardless of hierarchical level.

For instance, an independent voltage source, VCC, can hav
VALUE attribute set to the value of a parameter called 
VSUPPLY using the notation {VSUPPLY}. The curly braces
instruct the simulator to evaluate VSUPPLY rather than use 
text representation itself.

VSUPPLY must also be defined by placing a PARAM 
pseudocomponent in your schematic, and defining one of th
NAMEn/VALUEn attribute pairs. To set VSUPPLY to 12 volts
the first pair of PARAM attributes can be defined as:

NAME1 = VSUPPLY
VALUE1 = 12V

By using parameters, multiple devices can respond to a cha
in that parameter. For instance, if a second independent sou
VEE, also has its value set to {VSUPPLY} as well, then both
sources can be changed to 14 volts by simply reassigning th
VALUE1 attribute of the PARAM pseudocomponent to 14V.
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Additional flexibility can be 
provided by using parameters in 
expressions. See Parameters on 
page 3-9 for more information 
about parameters.
Expressions
In many applications, it is helpful to have more flexibility in 
setting up values by using expressions in place of literal valu

For example, an independent source, VEE, could have its 
VALUE attribute defined as:

VALUE = {-10*FACTOR}

where FACTOR is assigned the value of 1.2 using a PARAM
pseudocomponent. The value for VEE resolves to (-10 * 1.2)
-12.0 volts.

Expressions can contain the standard operators listed in 
Table 3-5, the functions in Table 3-6, and the system variables
listed in Table 3-7.

The simulator accepts expressions of any length, but MicroS
Schematics imposes some length limits. Part attribute 
definitions, for example, are limited to 1,024 characters in 
Schematics. In such cases, it is appropriate to define custom
functions for expressions, thus decreasing length and improv
readability.

The simulator evaluates expressions upon reading in the en
circuit file set. Parameter values that change as an analysis
proceeds (a DC sweep or parametric analysis, for example)
cause the simulator to reevaluate the expression at that time

Table 3-5 Operators in Expressions

Type
Operato
rs

Meaning

arithmetic + addition (or string 
concatenation)

- subtraction

* multiplication

/ division

** exponentiation
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relational: within 
IF() functions

== equality test

!= non-equality test

> greater than test

>= greater than or equal to test

< less than test

<= less than or equal to test

Table 3-6 Functions in Arithmetic Expressions

Function Meaning Comment

ABS(x) |x|

SQRT(x) x1/2

EXP(x) ex

LOG(x) ln (x) log base e

LOG10(x) log(x) log base 10

PWR(x,y) |x|y

PWRS(x,y) +|x|y (if x > 0)
-|x|y (if x < 0)

SIN(x) sin(x) x in radians

ASIN(x) sin-1(x) result in radians

SINH(x) sinh(x) x in radians

COS(x) cos(x) x in radians

ACOS(x) cos-1(x) result in radians

COSH(x) cosh(x) x in radians

TAN(x) tan(x) x in radians

ATAN(x) tan-1(x) result in radians

ARCTAN(x)

ATAN2(y,x) tan-1(y/x) result in radians

TANH(x) tanh(x) x in radians

Table 3-5 Operators in Expressions (continued)

Type
Operato
rs

Meaning
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M(x) magnitude of x same result as ABS(x)

P(x) phase of x in degrees; returns 0.0 for 
real numbers

R(x) real part of x

IMG(x) imaginary part of x applicable to AC analysis 
only

DDT(x) time derivative of x applicable to transient 
analysis only

SDT(x) time integral of x applicable to transient 
analysis only

TABLE(x,x1,y1,...) y value as a 
function of x

xn,yn point pairs are plotted 
and connected by straight 
lines

MIN(x,y) minimum of x and 
y

MAX(x,y) maximum of x and 
y

LIMIT(x,min,max) min if x < min
max if x > max
else x

SGN(x) +1 if x > 0
0 if x = 0
-1 if x < 0

STP(x) 1 if x > 0
0 otherwise

used to suppress a value until 
a given amount of time has 
passed; for example, 
{v(1)*STP(TIME-10ns) 
gives a value of 0.0 until 10 
nsec has elapsed, then gives 
v(1)

IF(t,x,y) x if t is true
y otherwise

t is a relational expression 
using the relational 
operators shown in 
Table 3-5

Table 3-6 Functions in Arithmetic Expressions (continued)

Function Meaning Comment
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Analog Power Supplies
This section describes setup information for DC sources.

The symbols in Table 3-8 have a DC attribute which can be se
to the supply level. See To place the voltage sources on page 2-2 
for an example of how to place a power supply.

Table 3-7 System Variables

Variab
le

Applicability

TIME Time values resulting from a transient analysis. If no 
transient analysis is run, this variable is undefined.

TIME can only be used in analog behavioral modeling 
expressions.

Table 3-8 Analog Power Supplies

Symbol Symbol Library Description

VDC source.slb voltage source

VSRC source.slb voltage source

IDC source.slb current source

ISRC source.slb current source
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Chapter Overview
This chapter provides information about creating symbols. 
Symbols are the graphical representation of circuit compone

When you create a new symbol in the symbol editor, you ne
to define the graphics and pins of the symbol and the symbo
attributes. You also must define a device model or subcircui
the symbol will be simulated and a package definition if it wi
be used with a board layout package.

Creating a New Symbol on page 4-2 describes how to create a
symbol and define graphics and attributes for the symbol.

Linking a Symbol to a Model or Subcircuit Definition on 
page 4-12 describes how to link a symbol to the model or 
subcircuit which defines the simulation behavior of the part.

Adding New Symbols from a Vendor on page 4-14 describes 
how to set up symbols created by a vendor.
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The symbol library contains 
graphical descriptions of all 
devices found in the model 
library.

It is recommended that changes 
to symbols be saved in a user 
library rather than the supplied 
MicroSim library.
Creating a New Symbol
The process of creating a new symbol includes the following

• Creating the symbol

• Defining symbol graphics

• Defining attributes for the symbol

Each of these are described in the following pages.

Creating a Symbol
There are two ways to create a new symbol:

• Copy an existing symbol from the symbol library and 
modify it as needed

• Create a new symbol from scratch

If there is an existing symbol similar to the one you want to 
create, it is normally quicker and easier to create the new sym
by copying and modifying the existing symbol.

It is recommended that you create a separate symbol library
for new symbols rather than modify any of the original symb
library files.

To copy and modify an existing symbol

1 Select Edit Library from the File menu to access the symb
editor.

2 The currently selected symbol library is indicated in the tit
bar of the symbol editor window. If you want the new 
symbol to be in an existing user library:

a Select Open from the File menu.

b Select the library file to open and click on OK.

3 In the symbol editor, select Copy from the Part Menu an
click on the Select Lib button.
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An AKO part cannot exist in a 
symbol library file without the 
base part that it references. If 
you want to copy an AKO part, 
first copy the base, then the 
AKO.

Be sure to configure the model 
library using Library and Include 
Files on the Analysis menu in 
Schematics.
4 In the Open dialog box, click on the symbol library file 
which contains the symbol you wish to copy, then click o
OK. 

5 At the Copy Part dialog box, scroll through the part list in
the lower right corner and click on the symbol you want 
copy. Make sure that you copy a “base” part rather than
“AKO” part. 

6 When you click on the desired part, the part name appea
in both the Existing Part Name and New Part Name field
Modify the New Part Name field as desired, then click on
OK. The symbol is displayed.

7 Select Attributes from the Part menu. Click on the PART
attribute so that it is selected. In the VALUE text box, typ
the name to display on the symbol. If the symbol has a 
MODEL attribute, click on it and set the value to the exa
name of the model (.MODEL or .SUBCKT name). Make
sure attributes have been changed.

8 Select Save As from the File menu (for a new file) or Sa
(if you opened an existing file in step 2).

To create a new symbol from scratch

1 Select Symbol from the Edit menu to access the symbol
editor.

2 The currently selected symbol library is indicated in the tit
bar of the symbol editor window. If you want the new pa
to be in a different library:

a Select Open from the File menu.

b Select the library file to open and click on OK.

3 Select New from the Part menu to define the part name,
description, and other information for the symbol. Click o
OK when finished.
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Graphics checklist:

1 Is the origin at the hot-spot of 
the upper leftmost pin of the 
symbol?

2 Are all visible pins and 
graphics contained within the 
bounding box?

3 Is the bounding box no larger 
than necessary?

4 Are all pins on grid?
Understanding Symbol Graphics
The following graphic information is defined for a symbol:

• Origin

• Bounding box

• Grid spacing

Origin

The origin is used when placing a part and is the center poin
used when rotating a part. The symbol origin is defined usin
Origin on the Graphics menu in the symbol editor.

By convention, the origin of each symbol in the symbol libra
is placed at the hot-spot of the upper leftmost pin on the dev
The hot-spot is the point of connection to a wire or to anothe
pin.

The origin is maintained as a point of reference on the 
schematic. If you change the origin of a symbol, thus chang
the location of the symbol graphics and pins, relative to that
point, then the symbol graphics and pins are relocated 
accordingly when a schematic is edited.

Bounding box

The bounding box determines the selection area for a part. W
you click on a part in MicroSim Schematics, the area in whic
you can click and have that part be selected is defined by th
bounding box of the symbol. The symbol bounding box is 
defined using Bbox on the Graphics menu in the symbol edi

By convention, the bounding box contains the complete sym
(graphics and pins). You will get a warning if you try to save
symbol which has any pins outside the bounding box. All visib
pins must be contained within the bounding box in order to 
make proper connections.

The bounding box should be no larger than necessary. If a pa
bounding box is larger than necessary, then part selection in
schematic editor can be difficult for parts placed close togeth
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The bounding box should only contain the symbol graphics a
visible pins.

Grid spacing

The grid spacing in the symbol editor can be changed when
higher resolution is desired for creating graphics in a tighter
grid. Grid spacing is defined using Display Options on the 
Options menu in the symbol editor.

The default grid spacing is set at 0.1", and the minimum grid
spacing is 0.01". If you change the grid spacing, be sure to s
the grid spacing back to the default before placing pins.

Pins must be placed on the grid at 0.1" intervals from the orig
of the symbol and at least 0.1" from any adjacent pins. Pins t
are not at 0.1" intervals from the origin are considered “off-
grid,” and a warning is displayed if you try to save a symbol wi
one or more pins off-grid.
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When you use New on the Part 
menu in the symbol editor to 
create a new symbol, the PART, 
MODEL, REFDES, and 
TEMPLATE attributes are 
provided as a default set. You 
can provide any other attributes 
as needed.

Attributes checklist

1 Does the value of the MODEL 
attribute match the PSpice 
.MODEL/.SUBCKT name?

2 Does the TEMPLATE specify 
the correct number of pins/
nodes?

3 Are the pins/nodes in the 
TEMPLATE specified in the 
proper order?

4 Do the pin/node names in the 
TEMPLATE match the pin 
names on the symbol?
Defining Part Symbol Attributes
This section describes the following attributes:

MODEL, below

SIMULATION ONLY, below

TEMPLATE on page 4-7

MODEL

This attribute indicates the name of the model referenced fo
simulation. The MODEL name should match the name of th
.MODEL or .SUBCKT definition of the simulation model as i
appears in the PSpice model library file (.lib ).

For example, your design could include a 2N2222 bipolar 
transistor with a .MODEL name of Q2N2222. The MODEL 
attribute on the symbol for that part should be Q2N2222. Th
MODEL attribute can then be referenced in the TEMPLATE
attribute.

In the schematic editor Edit Attributes dialog box, the MODE
attribute is marked with an asterisk and cannot be changed. 
can change the MODEL attribute the following ways:

• Use Model on the Edit menu item in the schematic editor
either change the model reference or to create an instan
model. 

• To edit the underlying model definition of a part, use Mod
on the Edit menu in the symbol editor.

SIMULATION ONLY

If present, this attribute indicates that the part only has mean
for simulation. The SIMULATION ONLY attribute identifies 
parts such as voltage and current sources, breakout devices
(found in breakout.slb ), and special symbols (found in 
special.slb ).
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Connectors

For board layout purposes, 
connectors are treated as parts 
(and may be packaged, in the 
case of a multi-pin connector). 
For simulation purposes, 
connectors do not play any part 
other than to provide one or 
more pins where Probe markers 
might be placed.

Connectors are indicated by 
having a PKGREF attribute but 
no TEMPLATE attribute. If you 
create a connector symbol, be 
sure to delete the automatically 
provided TEMPLATE attribute 
from the attribute list in the 
symbol editor.
TEMPLATE

This attribute defines how to create a netlist entry for PSpice
The pin names specified in the TEMPLATE attribute must 
match the pin names on the symbol. The number and order o
pins listed in the TEMPLATE attribute must match those 
appropriate for the associated .MODEL/.SUBCKT definition
referenced for simulation. 

In the schematic editor Edit Attributes dialog box, the 
TEMPLATE attribute is marked with an asterisk and cannot 
changed. To change the TEMPLATE attribute, use Model o
the Edit menu in the symbol editor.

The TEMPLATE contains regular characters that are copied
the netlist, and special items such as attributes, that are 
translated before being copied to the netlist. The translation
process is repeated until there are no more attributes left in 
template.

Regular characters include alphanumerics, $ and _, white sp
and some punctuation marks. An “identifier” is taken to mean
alphabetic character followed by zero or more alphanumeric
characters, $ or _.

Attribute names are denoted by an identifier preceded by on
the following special characters:

@ ? ~ # &

Attribute processing is determined by the character precedin
the attribute name:

@<id > replaced by the value of <id>. Error if no 
<id> attribute or if no value assigned.

&<id > replaced by the value of <id> if <id> 
defined.

?<id >s...s replaced by text between s...s if <id> 
defined.

~<id >s...s replaced by text between s...s if <id> 
undefined.

#<id >s...s like ? but delete rest of template if <id> 
undefined.
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The ? and ~ forms can also take an “else” clause:

?<id> s...ss...s

~<id> s...ss...s

In the above, “s” can be any “non-regular” character. These
conditional attribute constructs can be nested by using differ
separator characters.

The ^ character is also special. It is replaced by the complet
hierarchical path to the device being netlisted. 

The sequence \n  is replaced by a new line. This allows a mult
line netlist entry to be generated from a one-line template.

Pin names are indicated by a % character followed by one o
more regular characters. A pin name in the template is repla
by the name of the node connected to that pin. The pin nam
everything after the % to a separator (white space or comma
Some characters in pin names are translated to avoid proble
with Probe:

< is replaced by l (L)

> is replaced by g

= is replaced by e

\XXX\ is replaced by XXXbar

To enter a % character into the netlist output, enter %% in the 
template.

Any devices generated from a netlist template must start wit
letter acceptable to PSpice for that particular kind of device 
(such as Q for a bipolar transistor). To ensure this, templates f
devices in the Symbol Library start with a prefix letter, followe
by the hierarchical path, and then the reference designator 
(REFDES) attribute. 

For example:

R^@REFDES ....   for a resistor

We strongly recommend that users adopt this scheme when
generating their own netlist templates.
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TEMPLATE example: simple resistor (R)

The symbol for a simple resistor has attributes for REFDES a
VALUE, both of which are required. It has two pins (1 and 2
A suitable template would be:

R^@REFDES %1 %2 @VALUE

A device with REFDES = R23 and VALUE = 1k connected t
nodes abc and def would generate:

R_R23 abc def 1k

TEMPLATE example: voltage source with 
optional AC and DC specifications (VSRC)

The VSRC symbol has two attributes (AC and DC) and has t
pins (+ and -). A suitable TEMPLATE would be:

V^@REFDES %+ %- ?DC|DC=@DC| ?AC|AC=@AC|

A device with REFDES = V6 connected to nodes vp and vm, 
with DC set to 5v and AC undefined would generate:

V_V6 vp vm DC=5v

or with AC set to 1v would generate:

V_V6 vp vm DC=5v AC=1v

TEMPLATE example: parameterized subcircuit 
call (X)

Suppose you have a subcircuit Z that has two pins (a and b),
a subcircuit parameter G. If G is undefined, the value 1000 is
be supplied. You use an attribute, G, to allow the parameter
be changed on the schematic.

A suitable TEMPLATE would be:
X^@REFDES %a %b Z PARAMS: ?G|G=@G| ~G|G=1000|

A device U33 connected to nodes 101 and 102, and with G 
to 1024 would generate:

X_U33 101 102 Z PARAMS: G=1024

or with G undefined would generate:
X_U33 101 102 Z PARAMS: G=1000

The TEMPLATE could also be written using the ‘if...else’ form
X^@REFDES %a %b Z PARAMS: ?G|G=@G||G=1000|
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Subcircuit definitions (which start 
with the .SUBCKT statement) are 
stored in model library files (with 
the .LIB  extension).

Note that the node numbers 
need not be in ascending order. 
(In fact, they need not be 
numbers; other alphanumeric 
designations are allowed.)

The remaining lines in the 
definition include descriptions of 
all the subcircuit’s nodes. The 
first line merely lists those that 
are brought out as pins.

The initial X indicates that the 
template refers to a subcircuit 
definition.

The ^@REFDES appends the 
hierarchical path (if any) and the 
reference designator to the “X” in 
the netlist.

The final @MODEL will be 
automatically replaced with the 
value of the MODEL attribute.
Pin callout in subcircuit templates

The number and sequence of pins named in a subcircuit’s 
template must agree with the definition of the subcircuit itsel
To see how this works, consider the following first line of a 
(hypothetical) subcircuit definition:

.SUBCKT GIMMICK 10 3 27 2

The four numbers following the name GIMMICK are node 
numbers. These nodes—and only these—are to be brought
as pins. Thus, this subcircuit has four pins, corresponding to
four nodes shown.

Now suppose that the symbol definition shows four pins:

IN+ OUT+ IN-
OUT-

The number of pins on the symbol equals the number of node
in the subcircuit definition (namely, four).

Now suppose that the correspondence between pin names 
nodes is to be as follows:

Then the template might look like this:

X^@REFDES %IN+ %IN- %OUT+ %OUT- @MODEL

Every term beginning with a % sign refers to a pin. In fact, each
pin entry consists of the pin’s name preceded by the % sign.

Note that the template contains the correct number of pins 
(four), as well as the correct sequence of pin names.

Node 
Number

Pin Name

10 IN+

3 IN-

27 OUT+

2 OUT-
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The “rules of agreement” are outlined in Figure 4-1.

*  Unmodeled pins may appear on a symbol (like the two voltag
offset pins on a 741 opamp symbol). Such pins are not netlis
and do not appear on the template.

Figure 4-1 Rules for Pin Callout in Subcircuit Templates

Number of nodes in first 
line 

of subcircuit definition

must 
equal

Number of pins called 
out in template

must 
equal

Nu

Sequence of nodes in 
first line of subcircuit 

definition

must 
match

Sequence of pins called 
out in template

Names of pins called out 
in template

must 
match

Na
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For a description of the MODEL 
attribute, see MODEL on 
page 4-6.

For a description of the MODEL 
attribute, see MODEL on 
page 4-6.
Linking a Symbol to a 
Model or Subcircuit 
Definition
Each part that you place on your schematic is linked to a mo
or subcircuit definition which describes the electrical behavio
of the part for simulation purposes. This section provides 
information about how parts are linked to models and 
subcircuits.

Linking a Symbol to a Model
When the electrical behavior of a part is described by a mod
the associated model is identified by the MODEL attribute fo
the part symbol.

To tell PSpice where to find the model library file containing th
definition of the simulation model referenced, use Library an
Include Files on the Analysis menu in the schematic editor.

In the Library and Include Files dialog box, the files listed mu
be in a directory on the library search path or be specified w
a complete path. You can display or modify the library searc
path using Editor Configuration on the Options menu in the 
schematic editor.

Relating Subcircuits to Part 
Symbols
When the electrical behavior of a part is described by a 
subcircuit, the associated subcircuit is identified by the MODE
attribute for the part symbol.

In the standard symbol and model libraries, the symbol nam
and corresponding subcircuit name are identical. This 
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For a description of the 
TEMPLATE attribute, see 
TEMPLATE on page 4-7.
convention should be followed when creating user-defined pa
with subcircuit definitions.

If the subcircuit has variable input parameters using the 
PARAMS: construct, the part symbol must have correspond
attributes which can be optionally set on a part instance bas

For example, the LM7805C subcircuit definition in the mode
library has two variable parameters: Av_feedback  and Value  as 
defined in the following .SUBCKT statement:

.SUBCKT LM7805C Input Output Ground

   x1 Input Output Ground x_LM78XX PARAMS:

+     Av_feedback=1665, R1_Value=1020

The equivalent part symbol attributes for this subcircuit are:

MODEL = LM7805C

Av_feedback=1665

R1_Value=1020

These part symbols also have a TEMPLATE attribute, which
defines how Schematics should translate the attributes of a g
part instance into an X (subcircuit) device declaration written
the netlist. A LM7805C TEMPLATE is defined in a single line
of text as:

TEMPLATE=X^@REFDES %IN %OUT %COMMON @MODE

X^@REFDES instructs Schematics to substitute the 
hierarchical (if applicable) reference designator for this part 
instance prefixed with the letter X, thus producing a simulato
compatible subcircuit device.

Template items preceded by a % character produce simulat
compatible node names. The required connecting terminals
must be listed in the order specified in the subcircuit definitio
In this example, %IN, %OUT, and %COMMON reflect the 
exact order of the terminals in the LM7805C .SUBCKT 
definition.

@MODEL is substituted with the subcircuit name LM7805C

When creating a subcircuit definition for a new part (rather th
modifying an existing part symbol or part instance), you need
create a new part symbol (and possibly a package definition
being sure to define all of the appropriate attributes.
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Adding New Symbols 
from a Vendor
This section describes how to add new symbols from a vend
or other source when the user has an existing model library

For every new device that you want to add to the software, y
need to add two and sometimes three distinct items: 

• a model or subcircuit definition

• a symbol

• a package definition

The model and symbol are required in all cases, but the pack
is required only if you are packaging your design to go to a P
layout program.

Model Library
All .MODEL and .SUBCKT statements are kept in the mode
library. By convention, this file has a .lib  extension.

If you receive new models from a vendor, they may be in a 
single file or in many files that each contain one model or 
subcircuit. If they are in a single file, simply rename it so that
has a .lib  extension.

If each model is in its own file, then you can copy them all in
a single file using the DOS copy command. For example, if t
model files all have a .mod  extension, enter the following DOS
command:

copy *.mod mylib.lib

This command copies all of the models into the file called 
mylib.lib .

Note Make sure none of the new model or file names 
duplicate those already in the MicroSim package.
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Now you need to tell the simulator that this file exists:

1 In Schematics select Library & Include Files from the 
Analysis menu.

2 Type in the name of your file including the extension in th
File Name text box.

3 If you want the models to be global (available for any 
schematic), select Add Library*. If you want them to be 
local (only for the current design), select Add Library. 

Symbol Library
Now you need to add a symbol for each of the models or 
subcircuits that you intend to use.

Switch to the symbol editor by selecting Edit Library from th
File menu. The title bar at the top of the window should say 
<new>:<new>. This means that you are editing a new symb
library file and are editing a new symbol.

A quick overview of the structure of a typical symbol library 
may be helpful. Most symbol libraries are composed of base
parts and AKO (a kind of) parts. The base part usually conta
the graphical information for the symbol as well as the minimu
attributes required to make that symbol functional. The AKO
symbol inherits all of the graphics and attributes of the base p
but can alter them or add to them. One other important point:
AKO symbol can only reference base parts contained in its o
library.

The quickest way to add a new symbol is to copy an existing 
and customize its attributes. Let’s assume you have a new s
opamps from a vendor. For this example, we assume that e
device has five interface pins. Since all of the symbols will loo
the same, we want a symbol library that has one base part an
AKO part for each device to be used.
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There are two types of parts in a 
symbol library: a base part and 
an AKO part. Only base parts 
(those without the AKO 
reference after the part name) 
can be copied.

The TEMPLATE attribute must 
be defined in accordance with 
the model or subcircuit definition. 
See TEMPLATE on page 4-7
Copying and Modifying a Symbol 
for a Single Vendor Model
1 Select Edit Library from the File menu to start the symbo

editor.

2 If the new symbol is to be placed in an existing library, 
select Open from the File menu to open the destination 
library. (Skip this step if the symbol is to be placed in a ne
symbol library.)

3 Select Copy from the Part menu.

4 Click on the Select Lib button.

5 Scroll through the list of .slb  files, select opamp.slb , and 
click on OK. A list of symbols is displayed in the parts 
window. Notice that most of the symbols have an AKO 
reference after them. 

6 To copy a base part:

a Scroll through the list nearly to the bottom (base par
are always at the bottom of the library).

b Select a base part (op5, for example). The base part
name appears in both the New Part Name and Exist
Part Name text boxes.

c Enter the name of the new model or subcircuit in the
New Part Name text box.

d Click on OK. The symbol for the part is displayed.

7 Select Attributes from the Part menu and do the followin

a Type PART in the Name text box.

b Type the name of the model or subcircuit in the Valu
text box.

c Click on Save Attr.

d Type MODEL in the Name text box. (The name of the 
model or subcircuit should still be displayed in the 
Value text box.)

e Click on Save Attr.
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There are two types of parts in a 
symbol library: a base part and 
an AKO part. Only base parts 
(those without the AKO 
reference after the part name) 
can be copied.
8 Select Save As from the File menu (or select Save if an 
existing library was opened in step 2).

9 Type the name of the new file without the .slb  extension. 
Make sure that the new symbol and file names do not 
duplicate existing file names.

10 When you are asked whether to add this file to the list o
Schematics’ configured libraries, select Yes. This makes 
symbol library available to Schematics.

Copying and Modifying a Symbol 
for Multiple Vendor Models 
Using AKO Symbols

Adding a base part

1 Select Edit Library from the File menu to start the symbo
editor.

2 If the new symbol is to be placed in an existing library, 
select Open from the File menu to open the destination 
library. (Skip this step if the symbol is to be placed in a ne
symbol library.)

3 Select Copy from the Part menu.

4 Click on the Select Lib button.

5 Scroll through the list of .slb  files, select opamp.slb , and 
click on OK. A list of symbols is displayed in the parts 
window. Notice that most of the symbols have an AKO 
reference after them. 

6 To copy a base part:

a Scroll through the list nearly to the bottom (base par
are always at the bottom of the library).

b Select a base part (op5, for example). The base part
name appears in both the New Part Name and Exist
Part Name text boxes.
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AKO symbols are useful if a 
library contains multiple models 
that can use the same symbol 
graphics. If only one symbol is 
needed, you can skip this 
section.
c Enter the name of the new model or subcircuit in the
New Part Name text box.

d Click on OK. The symbol for the part is displayed.

7 Select Save As from the File menu (or select Save if an 
existing library was opened in step TBD2).

8 Type the name of the new file without the .slb  extension. 
Make sure that the new symbol and file names do not 
duplicate existing file names.

9 When you are asked whether to add this file to the list o
Schematics' configured libraries, select Yes. This makes 
symbol library available to Schematics.

Adding AKO symbols

Your new library now has one base part. Next we will add th
first AKO part (the first symbol that can be used for simulation
Assume that the first opamp that you want to add is called 
LM557.

1 Select New from the Part menu.

2 Enter a description for the part. This can be anything 
meaningful to you (inverting OPAMP , for example).

3 Enter the name of the part. This usually matches the na
of the model (LM557, for example).

4 Enter OP5 for the AKO name.

5 Click on OK. The status bar at the top of the screen lists 
symbol being edited as LM557.

6 Select Attributes from the Part menu. In the Attributes 
dialog box, there are four attributes listed for the symbol
REFDES, TEMPLATE, PART, and MODEL. REFDES 
equals U? by default, which denotes that it is referencing
IC definition. For most cases you do not need to edit 
TEMPLATE. Both PART and MODEL are blank.

7 Click on PART. The word PART appears in the NAME tex
box.

8 Enter the name of the symbol (LM557) in the VALUE text 
box.
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9 Click on Save Attribute.

10 Repeat the previous two steps for the MODEL attribute.

MODEL must match exactly the name of the part as defin
in the .SUBCKT definition found in your .lib  file. (Case is 
not important.)

11 Click on OK.

12 Select Save from the File menu.

You now have one base part and one AKO symbol in your 
library. At this point, you could return to Schematics and call 
the LM557 symbol, place it in your drawing, and simulate wi
it.

Repeat the procedure for each AKO part that you want to add
other new devices have different graphics than the op5, add
new base part and proceed as above.

If you need to add symbols over the course of several editin
sessions, you need to add one step: after switching to the sym
editor, select Open from the File menu and open the file to wh
you will be adding new symbols. The status bar at the top of 
screen shows which library you are working in at any given 
time.
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Chapter Overview
This chapter provides information about creating models. 
Models define the electrical behavior of schematic compone
for purposes of simulation.

This chapter includes the following sections:

Model Overview on page 5-2

Using the Parts Utility on page 5-4

Subcircuits on page 5-20

Using the Model Editor (Text Editor) on page 5-21

Configuring the Library on page 5-36
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See MODEL on page 4-6 for a 
description of the MODEL 
attribute.
Model Overview
Models define the electrical behavior of parts or subcircuits f
simulation. A model is linked to a specific part or subcircuit b
the MODEL attribute defined for the symbol used by the par
subcircuit.

The model library shipped with your MicroSim software 
installation contains descriptions of the electrical behavior fo
many stock parts using the device model (.MODEL) and 
subcircuit (.SUBCKT/.ENDS) constructs. 

Model definitions describe circuit behavior by a set of variab
model parameters which fine-tune the output of the model. T
model construct is used for analog devices that are supporte
intrinsic simulator device models.

Subcircuit definitions describe the electrical behavior of a pa
using circuitry. The subcircuit construct supports variable inp
parameters to fine-tune output. Subcircuits are used to desc
analog devices.

Global Models vs. Local Models
Models can be global (available to any schematic) or local 
(customized for one schematic).

When designing a reusable custom part, it is usually necess
to add a model or subcircuit definition to the model library in
conjunction with a symbol and package definition in the symb
and package libraries, respectively. This kind of global 
definition becomes available to any circuit created in the 
MicroSim Schematics environment.

It is sometimes necessary to modify the model or subcircuit 
definition for a part instance in your schematic, thus creating
local version of the definition. An example of this is setting 
device and lot tolerances on the model parameters for a 
particular part instance in order to run a Monte Carlo or 
sensitivity/worst-case analysis.
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See Supported Device Types on 
page 5-8 for a description of 
models supported by the Parts 
utility.

Note The Parts 
utility is not 
included in 
Creating and customizing device definitions requires 
knowledge of the model and subcircuit syntax recognized by 
simulator, as well as various techniques to facilitate their 
creation and modification.

Parts Utility vs. Text (Model) 
Editor
Models can be defined using the Parts utility or the text edito
(sometimes called the model editor).

The Parts utility is useful for characterizing specific models 
from data sheet curves. The text editor is useful if model 
parameters are already defined (such as for models from a 
vendor) or if the model is not supported by the Parts utility.



5-4 Creating Models

 
e-

 
our 

be 

 
rcuit 

 

 by 

’t 
ler 
lue 

ical 

he 
et 

r 
nd 
or 
 

not
included

in:
Using the Parts Utility
MicroSim software is shipped with a model library containing
device model and subcircuit definitions for thousands of off-th
shelf parts. For most users, the devices in this library are 
sufficient. However, it is sometimes necessary to define new
device models when creating additional parts to be used in y
schematic or to test changes to a part’s operational 
characteristics.

By simply entering data sheet values for the desired 
semiconductor components, the Parts utility can be used to 
create new .MODEL and .SUBCKT definitions. These 
definitions are saved to external model files which can then 
used when simulating a schematic.

A difficult areas in using analog circuit simulators is finding 
accurate models for off-the-shelf parts. The Parts utility is a 
semiautomatic aid for determining the model parameters for
standard devices, such as bipolar transistors, and the subci
definitions for more complex models, such as operational 
amplifiers. The Parts utility helps to convert information from
the component manufacturer’s data sheet (without taking 
measurements of a real device) into parameter values used
PSpice.

You may ask, “Why do I need to model these devices? Won
the data sheet values work?” Well, yes and no. Yes, for simp
devices such as resistors, which only need the resistance va
to have a complete model. No, for more complex devices, 
especially semiconductor devices. This is because the phys
model for predicting how a transistor operates views the 
transistor from the inside, while the manufacturer provides 
measurements that show how the transistor operates from t
outside. Therefore, a conversion is necessary from data she
values to physical model parameters.

Data sheet information shows what the manufacturer will 
guarantee when you buy a part. The device’s operating 
characteristics will fall within the range specified: a particula
part could be near the minimum value of one specification a
near the maximum value of another. A typical value is given f
some specifications to indicate how most of the devices will
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Each curve in the Parts utility is 
defined only by the parameters 
being adjusted. For the diode, 
the forward current curve 
displayed in the Parts utility only 
shows the part of the current 
equation which is associated 
with the forward characteristic 
parameters (such as IS, N, Rs).

However, PSpice uses the full 
equation for the diode model, 
which includes a term involving 
the reverse characteristic 
parameters (such as ISR, NR), 
which could have a significant 
effect at low current.

This means that the curve 
displayed in the Parts utility is not 
exactly as what is displayed in 
Probe after a simulation. Models 
should always be tested and 
verified using PSpice and fine-
tuned if necessary.
operate. Though the Parts utility works with measurements 
taken from a specific device, it is sufficient to use typical valu
from the data sheet for most of your simulation work. You m
also want to create best/worst case models for checking you
design. 

For a given device type, the Parts utility displays the data sh
specifications, estimated model parameters, and graphs of t
device characteristics. Usually, you will enter or modify data
sheet information for each device characteristic. The Parts 
utility then estimates the model parameters and generates a
graph displaying device characteristic behavior. Alternativel
you can edit model parameters directly to investigate their eff
on a device characteristic (see Figure 5-2). 

graph of device
characteristic

PSpice
equation

evaluation

parts
estimation

user
data-entry

model

device data from
data sheets

“what-if” model data

parameters

Figure 5-1 Process and Data Flow for the Parts Utility
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Starting the Parts Utility
The Parts utility can be started from the schematic editor or 
symbol editor.

To start the Parts utility from the schematic editor:

1 Select Model from the Edit menu.

2 Click on Edit Instance Model (Parts).

To start the Parts utility from the symbol editor:

1 Select Model from the Edit menu.

2 Click on Edit Model (Parts).

Once it is started, the Parts utility creates instance models o
base models, respectively. Models are saved to model files 
automatically configured for use with Schematics.
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Note The model parameter 
defaults used by the Parts 
utility are different than those 
used by the base models 
intrinsic to PSpice.
Supported Device Types
The Parts utility produces either a .MODEL definition of the 
device or a .SUBCKT definition of the device. Devices such 
diodes and bipolar transistors are derived from PSpice’s 
intrinsic template models and use the .MODEL statement.

Opamps, on the other hand, are defined as a macromodel o
subcircuit whereby a collection of circuit elements are bound
together in a single package. Table 5-1 summarizes the device 
model types supported in the Parts utility.

Table 5-1 Device Models Supported in the Parts Utility

Device Type
Definition 
Form

Prefix (PSpice 
Device Type)

diode .MODEL “D”

bipolar transistor .MODEL “Q”

IGBT .MODEL “Z”

JFET .MODEL “J”

power MOSFET .MODEL “M”

operational amplifier .SUBCKT “X”

voltage comparator .SUBCKT “X”

nonlinear magnetic core .MODEL “K”

voltage regulator .SUBCKT “X”

voltage reference .SUBCKT “X”
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Parts Model Files (.lib or .mod)
The .MODEL and .SUBCKT definitions generated by the Pa
utility are output to one or more model files, depending upon
platform. The files are ordinary text files which can be copied
changed with a text editor.

Once a configured model file (usually with the .lib  extension) 
is opened, all new and/or modified .MODEL and .SUBCKT 
definitions are saved to the open model file. 

If, from within Schematics, the part instance refers to a base
model definition contained in the model library, then a defau
file named <schematic name>.lib  is opened into which an 
instance model is created. That is, the base model is copied
the file and its name is changed to a unique name, thus crea
the instance model. The instance model name is of the form
<base model name>-X<n>  where <n> is <blank1 | 2 | ... >. If 
desired, the currently opened file can be saved to a new file
using Save As on the File menu.

Configuring parts model files

Within the schematic editor, Library and Include Files on the
Analysis menu allows you to view the list of model files 
pertaining to your current schematic, or to manually add, dele
or change the model file configuration (see Configuring the 
Library on page 5-36). The Library Files list box displays all of
the currently configured model files. One file is specified per
line. Files can be configured as either global to the Schema
environment (using Add Library*) or local to the current 
schematic (using Add Library). Global files are marked with a
asterisk (*) after the file name.

Any model files created by default (<schematic name>.lib , for 
example) are automatically configured (added to the list) as
local to the current schematic. However, if you create a new
model file using Save As on the File menu, the new file must
manually configured into the list.
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Note If you have defined device models with the same 
names as those in other configured model files and 
you want to use the new definitions during 
simulation instead, care must be taken when 
positioning the file names in the configuration list. 
If the new files and the existing files are configured 
with the same scope (either all local or all global), 
be sure to position the new files before the existing 
files. Note that PSpice searches locally configured 
files before the global files. So, if your new model 
files are configured locally, and the duplicate 
definitions exist in globally configured files (such 
as the central model library), your new definitions 
are still used by PSpice. See Search order on 
page 5-38 for a complete discussion on search 
order.

Automatic Model Configuration
1 Start the Parts utility from either the schematic editor or t

symbol editor:

From the schematic editor: 

a Select the part instance to be modified.

b Select Model from the Edit menu.

c Click on Edit Instance Model (Parts).

Schematics searches the list of configured model files fo
match. If a match is found, the model file containing the 
instance model is opened. If no match is found, it is assum
to be a new device model which is by default saved to 
<schematic name>.lib , and the Parts utility is initialized 
with a copy of the base model.

From the symbol editor: 

a Edit or create a symbol with the following attributes 
defined:

PART Symbol name; it is good practice to have
the symbol name match the MODEL nam
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b Select Model from the Edit menu.

c Click on Edit Model (Parts).

2 The main Parts utility window is displayed with a list of th
device characteristics and a list of all model parameters.
desired, performance curves can be viewed by selecting
device characteristic then selecting Display from the Plo
menu (see Figure 5-3).

To enter device data from the data sheet for any or all of 
device characteristics, in any order:

a Select the device characteristic in the Model Spec lis
box.

b Select Spec from the Edit menu.

c Fill in the Edit Model Spec dialog controls and click o
Add.

d Click on OK to exit the dialog box.

e Repeat steps a-d for as many characteristics as need 
specification.

MODEL Model name as defined in the Parts utility

Figure 5-2 Parts Utility Window with Data for a Bipolar 
Transistor
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If you opened an existing model 
file to which model definitions 
were appended, then this step 
can be skipped.
3 Extract all model parameters for the current specification
using Parameters on the Extract menu.

4 Repeat steps 2-3 until the model meets target behaviors.

5 Save the model by selecting Save from the Part menu.

6 Update the model file by selecting Save Library from the
File menu.

7 End the Parts utility session by selecting Exit from the Fi
menu.

Manual Model Configuration
Note Although you can configure models manually as 

described in this section, it is recommended to use 
automatic configuration as described in Automatic 
Model Configuration on page 5-10 instead.

1 Configure Part’s output files into your schematic:

a Select Library and Include Files from the Analysis 
menu.

b Enter the file name as <model file name>.lib  
(mycir.lib , for example).

c If the model definitions are for local use in the curren
schematic, click on the Add Library (or Add Include) 
button. For global configuration, use Add Library* (or
Add Include*) instead.

d Click on OK.

2 Either part instances or symbols can be modified to 
reference the new model.

To change model references locally for a part instance: 

a Select one or more part instances.

b Select Model from the Edit menu.

c Click on Change Model Reference and type in the 
appropriate model name.
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See Chapter 4,Creating 
Symbols, for a description of how 
to create and edit symbols.

This method does not support 
the variable parameters 
construct, PARAMS:, the local 
.PARAM command, or the local 
.FUNC command. To refine the 
subcircuit definition for these 
constructs, use the model editor 
described in Using the Model 
Editor (Text Editor) on 
page 5-21.

Figure 5-3 Schematic for a 
Half-Wave Rectifier
To change model references globally for a symbol: 

a Enter the symbol editor by selecting Edit Library from
the File menu.

b Create or change a symbol definition, making sure to
define the following attributes:

Creating Model and Subcircuit 
Definitions by Characterization
The Parts utility is available to facilitate the characterization 
new semiconductor devices by simply entering data sheet va
for the required stock parts.   This utility runs stand-alone, 
producing complete device model (.MODEL) and subcircuit 
(.SUBCKT/.ENDS) definitions written to existing or new files
which, by default, have the .lib  extension

Parts Utility Tutorial
In this section, we step through modeling a simple diode dev
We first create the schematic for a simple half-wave rectifier
We then run the Parts utility from the schematic editor to cre
an instance model for the diode in our schematic. The model 
containing the new definition will be automatically configured
for use with the current schematic.

Creating the half-wave rectifier schematic

1 Start Schematics. From within the schematic editor, draw
the simple half-wave rectifier shown in Figure 5-4.

PART Symbol name; it is good practice to 
have the symbol name match the 
MODEL name.

MODEL Model name as defined in the Parts 
utility .
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Figure 5-4 Dbreak-X Instance 
Model
2 Place one each of the following symbols using Get New P
from the Draw menu (reference designator shown in 
parentheses):

• Dbreak (D1 diode)

• C (C2 capacitor)

• R (R2 resistor)

• VSIN (V2 sine wave source)

• AGND (0 analog ground).

3 Connect the symbols as shown in Figure 5-4 using Wire
from the Draw menu or by pressing C+W.

4 Save the schematic drawing by selecting Save As from 
File menu. Type rectfr  at the prompt. The schematic is 
saved to rectfr.sch .

Note For simulation, V1 requires a DC, AC, and/or 
transient specification by appropriately defining its 
attributes. The Attributes dialog box can be 
displayed by double-clicking on the V1 symbol. 
Since we will not be running a simulation in this 
tutorial, this step is skipped. 

Starting the Parts utility for the D1 diode

1 Click on the D1 symbol. The symbol is highlighted.

2 Select Model from the Edit menu.

3 Click on Edit Instance Model (Parts).

4 Schematics searches the configured set of model library
files for a model instance corresponding to this symbol. 
Since it does not exist, Schematics will ask whether a ne
default model file, rectfr.lib  should be created. Click on
OK at the prompt to do so. Schematics automatically 
configures rectfr.lib  into the set of local model library 
files.

The parts window is displayed. Notice also that the D1 instan
in the schematic references a unique instance model name,
Dbreak-X. 
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Entering data sheet information

The parts window is initialized with the diode model 
characteristics listed in the Model Spec box and the Dbreak
model parameter values in the Parameters box as shown in
Figure 5-6. 

Each model characteristic listed in the Model Spec list can b
modified with new values from the data sheets. This informati
is then fit into new model parameter values.

Data sheet information is updated by selecting a model 
characteristic from the Model Spec list, and entering the valu
in the displayed edit dialog. There are two types of edit dialo
requiring either device curve data (point pairs) or single-valu
data. For the diode, Forward Current, Junction Capacitance, 
Reverse Leakage expect device curve data. Reverse Breakd
and Reverse Recovery require single-valued data.

Table 5-2 lists the data sheet information we would like to hav
incorporated into the Dbreak-X model. 

Figure 5-5 Diode Model Characteristics and Parameter 
Values for the Dbreak-X Instance Model
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To change the Forward Current characteristic

1 Double-click on the Forward Current entry in the Model 
Spec box. The Edit Model Spec-Forward Current dialog b
is displayed. This dialog box accepts curve data.

2 Type 1.3  in the Vfwd text box.

3 Press F to move to the Ifwd text box (or click in the Ifwd
text box), and type 0.2 .

4 Click on Add or press J. The new values will appear in 
the Vfwd-Ifwd table for the Edit Model Spec-Forward 
Current dialog box.

5 Click on OK. 

To change the values for Junction Capacitance and Revers
Leakage, use the same technique as for Forward Current to
invoke the dialog, enter the device curve data, and exit.

To change the Reverse Breakdown characteristic:

1 Double-click on the Reverse Breakdown entry in the Mod
Spec box. The Edit Model Spec-Reverse Breakdown dia
box is displayed. This dialog accepts single-valued data.

2 Type 7.5  in the Vz text box.

3 Press F to move to the Iz text box (or click in the Iz text
box), and type 20m. Note that the Parts utility accepts the 
same scale factors normally accepted by PSpice.

4 Press F to move to the Zz text box (or click in the Zz tex
box), and type 5.

5 Click on OK to end this dialog.

Table 5-2 Sample Diode Data Sheet Values

Model Characteristic Data Sheet Information

Forward Current (1.3, 0.2)

Junction Capacitance (1m, 120p) (1, 73p) (3.75, 45p)

Reverse Leakage (6, 20n)

Reverse Breakdown (Vz=7.5, Iz=20m, Zz=5)

Reverse Recovery no changes
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Extracting model parameters

To generate new model parameter values from the entered 
sheet information, select Parameter from the Extract menu. T
new values appear in the Parameters box.

To display the curves corresponding to the five diode 
characteristics:

1 Select all of the entries in the Model Spec box by clickin
on Forward Current and dragging the mouse down to th
end of the list.

2 Select Display from the Plot menu. Any one of the plots c
be brought to the foreground by clicking on its title bar (o
anywhere in the plot window). Any plot can be freely 
moved (dragged) to a new position in the parts window. P
and zoom functions are available on the View menu; axe
can be scaled using the Plot menu.

A few of the plots are shown in Figure 5-7, after having 
moved them to new locations. (Arrange on the Window 
menu can also help with this.) 

By default, device curves are computed at 27°C. For any given 
characteristic, additional curves can be added to the plot at o
temperatures. To do this for Forward Current:

1 Click on the Forward Current plot window to bring it to th
foreground.

2 Select Add from the Trace menu or press Z.

3 Enter the new temperature as 100  (in °C). Click on OK. The 
Forward Current plot should now appear as in Figure 5-8
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Figure 5-6 Assorted Device Characteristic Curves for a Diod

Figure 5-7 Forward Current Device Curve at Two 



5-18 Creating Models

ers 
ate 
ers 

ity 
r it 

e 

ice 

n 

ile 
Completing the model definition

The model can be refined by modifying the data sheet 
information as described before or by editing model paramet
directly. Individual model parameters can be selected for upd
by double-clicking on the corresponding entry in the Paramet
box of the main parts window.

For instance, double-clicking on BV brings up the Edit 
Parameter BV dialog box. This dialog gives you the opportun
to define a valid range for the model parameter and whethe
should be excluded from the extraction process.   For now, w
will leave the model parameters at their current settings. 

To save the current model parameter values to our new dev
model for use in our schematic:

1 Select Save from the Part menu. This saves the current 
model definition to the list of model definitions contained i
rectfr.lib .

2 Select Save from the File menu to write the latest model f
updates to disk.

We can now return to Schematics and proceed to set up a 
simulation.

Note Using Save on the Part menu and Save on the File 
menu ensure that the model instance name and 
model file name remain the same as those created 
by Schematics. This automatically configures 
the new model definition into our schematic 
without further intervention. If we had chosen to 
change the model instance name using Save As 
on the Part menu, then we would need to manually 
change the model reference for the D1 symbol by 
selecting Model from the Edit menu and clicking on 
Change Model Reference. If we had created a new 
model file using Save As on the File menu, we 
would need to configure the new model file using 
Library and Include Files on the Analysis menu. 
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See Chapter 4,Creating 
Symbols, for a description of how 
t t b l

See Configuring the Library on 
page 5-36, for a description of 
the Library and Include File 

it

See Using the Model Editor 
(Text Editor) on page 5-21, for a 
description of subcircuit 
definition with the model editor.
Subcircuits
Create Subcircuit on the Tools menu in the schematic editor
creates a subcircuit definition for the current level of hierarch
in your schematic, including all lower levels. This is written t
a file named <schematic name>.sub . Any named interface 
ports at the current level of hierarchy are mapped into the 
terminal nodes in the .SUBCKT statement.

To create a subcircuit definition for an existing 
schematic

1 Place interface ports (IF_IN for input ports and IF_OUT fo
output ports) in your schematic using Get New Part on th
Draw menu.

2 Save the schematic using Save on the File menu.

3 Generate the subcircuit definition using Create Subcircu
on the Tools menu.

4 Using the symbol editor, create a symbol to accompany 
subcircuit definition.

5 Make the model file containing the subcircuit definition 
available to PSpice by configuring it as either a library or
include file using Library and Include Files on the Analys
menu.

6 If necessary, further refine the subcircuit definition for th
new symbol or for a part instance in a schematic using t
model editor.

For example, you could extend the subcircuit definition 
using the variable parameters construct, PARAMS:, or th
local .PARAM or .FUNC commands. 
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Using the Model Editor 
(Text Editor)
Schematics supports general model and subcircuit editing b
providing the model editor for manipulation of .MODEL and 
.SUBCKT definitions in the model library, or in model files tha
are local to a schematic. The model editor allows you to edi
definitions, create new definitions, associate definitions with
symbols, or derive new definitions from existing ones.

Implementation of Model Editing
Both the schematic editor and the symbol editor have a Mod
menu item on the Edit menu which allows you to edit the 
.MODEL or .SUBCKT definition for a part. The behavior of thi
menu item depends on whether it is run from the schematic
editor or from the symbol editor.

The schematic editor modifies local instances of a part for a
given schematic, while the symbol editor modifies the globa
definition of a part in the model library. These definitions are
saved to model files and automatically configured as local a
global library files, respectively (as shown in the Library and
Include Files dialog box).

The model editor selects model or subcircuit definitions by 
attempting to match the MODEL attribute value of a part to t
.MODEL or .SUBCKT name in a library or include file. The 
local list specified in the Library and Include Files dialog is 
searched before the global list specified in the same dialog. T
first model or subcircuit name that matches the value of the 
MODEL attribute is the one used by the model editor.
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Editing Model Definitions in the 
Schematic Editor
From within the schematic editor, selecting Model from the E
menu makes an individual copy of a model or subcircuit 
representation, allowing you to modify a local copy. By defau
this new model is named <old model name>-X. Changes only 
apply to that specific part instance in the schematic or any ot
part instance in the same schematic that references the new
model. By default, these individual instance models or 
subcircuits are written to a file with the name 
<schematic name>.lib  which is configured for use with the 
current schematic only. The default model/subcircuit name a
model file name can be modified.

To edit a model or subcircuit definition from within the 
schematic editor, first select a part or parts, then select Mod
from the Edit menu. The Edit Model dialog box is displayed 
the part has a MODEL attribute. 

If a MODEL attribute exists, then the dialog box gives you th
choice of changing the name of the model/subcircuit referenc
by this part or editing an instance model/subcircuit (copy) of
that part. Suppose, for example, that you are in the schema
editor and have placed an instance of a Q2N2222 whose mo
parameters you want to modify or to which you want to add 
DEV and/or LOT tolerances for Monte Carlo analysis. When
you select this part and then select Model from the Edit men
the Edit Model dialog box is displayed.

The Change Model Reference button initiates a dialog that 
allows you to enter the name of another model or subcircuit 
the current part instance. The Edit Instance Model (Text) 
command allows you to edit a copy of the model or subcircu
definition.

The schematic editor does not allow you to edit the underlyi
base model or subcircuit definition of the symbol; this must b
done from the symbol editor. If an instance model/subcircuit
(copy) does not already exist, the schematic editor creates a 
instance definition that is a copy of the original model/
subcircuit. The only difference between the copy and the 
original is that the schematic editor appends a -X<n> to the 
model/subcircuit name to make the name unique, where <n> is 
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<blank | 1 | 2 | ... >. If an instance model/subcircuit already 
exists, it is displayed in the edit dialog.

Editing Model Definitions in the 
Symbol Editor
From within the symbol editor, the model or subcircuit 
representation associated with a symbol maintained in the 
symbol library is available for edit. Changes are made to the
actual model or subcircuit definition, and have global scope. 
default, these changes are written to a file called user.lib  
which is configured for global access. Thus, model/subcircu
changes made in the symbol editor affect all instances of the
corresponding symbol, no matter what schematic the symbo
used in.

When select Model from the Edit menu in the symbol editor, t
Edit Model dialog box is displayed with the base model or 
subcircuit definition associated with that part, if one exists. 
Otherwise, you are presented with a blank dialog box in whi
you can create a new model or subcircuit definition. From 
within the symbol editor, you are free to change the names of
model/subcircuit and model file.

Model Editor Dialog Box
The model or subcircuit definition is presented in a text-edit 
work area (a mini text editor). If you are editing a model 
definition, then the text-edit work area will contain one 
parameter per line. This makes it easier to add DEV/LOT 
tolerances to model parameter lines for Monte Carlo or wors
case analysis.

The Expand AKO button will search through any AKOs on 
which the model is based, adding the new parameters to thi
model. In essence, this command “flattens” a hierarchy of 
AKOs into one model in which you can see all the paramete
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Subcircuit definitions are brought into the text-edit work area
the same format as read from the model file. All of the 
comments immediately before or after the model or subcircu
definition are included for editing. Note that this will sometime
mean that comments intended for the previous or next mode
definition will be included in the edit dialog.

Model Editing Example
Suppose you have a schematic named my.sch  which contains 
several instances of a Q2N2222, and you are interested in t
effect of base resistance spread on one specific device—Q6
example. To investigate this, you must select Q6 in your 
schematic and Model from the Edit menu from within the 
schematic editor. The Edit Model dialog box is displayed wit
the current value of Q6’s MODEL attribute: Q2N2222.

Clicking on the Edit Instance Model (Text) button, the mode
editor automatically creates a copy of the Q2N2222 model 
definition with the default name of Q2N2222-X. A dialog box i
displayed to allow you to edit the newly copied definition. 

You can edit the model definition to specify a tolerance on t
parameter(s) on which a Monte Carlo analysis is to be 
performed. In Figure 5-9, a tolerance of 5% has been added
the Rb parameter. You must also specify a new part name a
model file, or use the defaults provided. Figure 5-9 shows th
Q2N2222-MC has been entered for the new model name. T
model file name my.lib  remains unchanged.

When you click on OK, the model editor writes the model 
definition to my.lib  in the current working directory. If my.lib  
does not already exist, it is created.

If this model file is a new file, it is automatically added to the
Library Files list box in the Library and Include Files dialog fo
the current schematic. If you select Library and Include Files
from the Analysis menu, you see the standard nom.lib  file that 
is part of the global model library (annotated with an asterisk
and the newly created my.lib  which is local to the current 
schematic (no asterisk).
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Now you can select Setup from the Analysis menu to set up
parameters as required for a Monte Carlo or worst-case analy
You are then ready to select Simulate from the Analysis me
to run the simulations.

If you want to change the model reference for this part back
Q2N2222, you can select the part in the schematic editor, se
Model from the Edit menu, click on Change Model Referenc
and type in the original model name.

Figure 5-8 Model Editor Dialog Box for Q2N2222 with a DEV
Tolerance Set on Rb
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Breakout Parts
For non-stock passive and semiconductor devices, Schematics 
provides a set of “breakout” parts designed for customizing 
model parameters for simulation. These are useful for setting up 
Monte Carlo and worst-case analyses with device and/or lot 
tolerances specified for individual model parameters.

Basic breakout part names consist of the intrinsic PSpice device 
letter from the set [BCDJKLMQRSTWZ] plus the suffix 
BREAK. By default, the model name is the same as the part 
name and references the appropriate device model with all 
parameters set at their default. For instance, the DBREAK part 
references the DBREAK model which is derived from the 
intrinsic PSpice D model (.MODEL DBREAK D).

Resistors, capacitors, and inductors

For breakout parts RBREAK, CBREAK, and LBREAK, the 
effective value is computed from a formula that is a function of 
the specified VALUE attribute.

Table 5-3 Resistors, Capacitors, and Inductors

Part Type
Symbol 
Name

Symbol Library 
File

Attribu
te

Description

capacitor
(PSpice ‘C’ device)

CBREAK breakout.slb VALUE capacitance

IC initial voltage across the capacitor 
during bias point calculation

MODEL CAP model name

inductor
(PSpice ‘L’ device)

LBREAK breakout.slb VALUE inductance

IC initial current through the inductor 
during bias point calculation

MODEL IND model name

resistor
(PSpice ‘R’ device)

RBREAK breakout.slb VALUE resistance

MODEL RES model name

Another approach is to use the 
model editor to derive an 
instance model and customize 
this. For example, you could add 
device and/or lot tolerances to 
model parameters.

Also see Resistors, Capacitors, 
and Inductors on page 3-2.
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Using the KBREAK symbol

The inductor coupling symbol, KBREAK, can be used to couple 
up to six independent inductors on a schematic. A MODEL 
attribute is provided for using nonlinear magnetic core (CORE) 
models, if desired. By default, KBREAK references the 
KBREAK model contained in breakout.lib ; this model, in 
turn, uses the default CORE model parameters.

The KBREAK symbol can be used to:

• Effect linear coupling between inductors.

• Reference a CORE model in a configured model library file.

• Define a user-defined CORE model with custom model 
parameter values.

The dot convention for the coupling is related to the direction in 
which the inductors are connected. The dot is always next to the 
first pin to be netlisted. For example, when the inductor symbol, 
L, is placed without rotation, the dotted pin is the left one. Rotate 
on the Edit menu (C+r), rotates the inductor +90°, making 
this pin the one at the bottom.

Using the KBREAK symbol in a schematic

1 Draw the schematic and assign the desired reference 
designator names to all of the part instances. To change 
default names, double-click on the reference designator 
label, and enter a new name in the Edit Reference 
Designator dialog box.

2 Place a coupling symbol on the schematic for each group of 
coupled inductors. Notice that the symbol has no pins.

3 Define the coupled inductors: Double-click on the coupling 
symbol’s box with the enclosed “K,” and enter the reference 

Table 5-4 KBREAK Symbol

Part Type
Symbol 
Name

Symbol Library 
File

Attribute Description

inductor coupling
(PSpice ‘K’ device)

KBREAK breakout.slb COUPLING coupling factor

Li inductor reference
designator

Figure 5-10 KBREAK Symbol
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designator names for the coupled inductors as values for Li 
(i=1,2,...,6).

For nonlinear coupling: L1 must have a value; the rest 
may be left blank.

For linear coupling: L1 and at least one other Li must have 
values; the rest may be left blank.

4 Change the coupling symbol’s MODEL attribute reference:

a click on the symbol’s box with the enclosed “K.”

b Select Model from the Edit menu.

c Click on Change Model Reference in the Edit Model 
dialog box.

d Change the name as required in the Model Name text 
box. These rules apply:

For nonlinear coupling: The model must reference a 
CORE model such as those contained in magnetic.lib  
or other user-defined models.

For linear coupling: The model reference must be 
blank.

5 Set the value of the COUPLING attribute to the value of the 
coupling factor, K.

6 Set the value (VALUE attribute) for each of the coupled 
inductors (L symbol instances). These rules apply:

For nonlinear coupling: VALUE is set to the number of 
windings.

For linear coupling: VALUE must be in Henries.

Nonlinear coupling
is not included in

PSpice Basics
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Transformers

Table 5-5 lists attributes that can be set per instance of a 
nonlinear transformer part. Also see Transformers on page 3-4.

To use XFRM_NONLINEAR, the MODEL attribute must be 
set appropriately. However, the MODEL attribute of a given 
instance can be modified to reference a CORE model provided 
in the magnetic.lib  model library file or in a user-defined 
model file.

Table 5-5 Transformers

Part Type
Symbol 
Name

Symbol Library 
File

Attribute Description

transformer
(PSpice ‘K’ and ‘L’ 
devices)

XFRM_
NONLINEA
R

breakout.slb L1_TURNS
L2_TURNS

number of turns on each 
winding

COUPLING coefficient of mutual 
coupling (must lie between 0 
and 1)

MODEL nonlinear CORE model n me

not
included

in:

See Using the Inductor Coupling 
Symbols in the Application Notes 
Manual for a description of 
techniques for creating 
additional transformer 
configurations.
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Ideal switches

Table 5-6 summarizes the available switch part types provided 
in the breakout.slb  symbol library. The switches may be 
voltage or current-controlled. To create a time-controlled 
switch, simply connect the switch control pins to a voltage 
source with the appropriate voltage vs. time values (transient 
specification).

The VSWITCH and ISWITCH models define the on/off 
resistance and the on/off control voltage or current thresholds. 
These switches have a finite “on” resistance and “off” 
resistance, and change smoothly between the two as their 
control voltage (or current) changes. This behavior is important, 
allowing PSpice to find a continuous set of solutions to the 
circuit being simulated. In practice, the “on” resistance may be 
made very small compared to the other circuit impedances, and 
the “off” resistance may be made very large compared to the 
other circuit impedances.

As with current-controlled sources (F, FPOLY, H, and 
HPOLY), WBREAK contains a current-sensing voltage source. 
When netlisted, WBREAK generates two device declarations to 
the circuit file set:

• one for the controlled switch

• one for the independent current-sensing voltage source

If you choose to create a new symbol for a current-controlled 
switch (with, for example, different on/off resistance and current 
threshold settings in the ISWITCH model), the TEMPLATE 
attribute must account for the additional current-sensing voltage 
source.

Table 5-6 Ideal Switch Parts in breakout.slb

Part Type Symbol Name Model Type

Voltage-Controlled 
Switch
(PSpice ‘S’ device)

SBREAK VSWITCH

Current-Controlled 
Switch
(PSpice ‘W’ device)

WBREAK ISWITCH
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Semiconductor Parts
Semiconductor parts can be divided into two classifications. 
One class is described by model definitions derived from 
intrinsic PSpice device model types: diodes, bipolar transistors, 
junction field effect transistors (JFETs), metal-oxide-silicon 
field effect transistors (MOSFETs), gallium arsenide field effect 
transistors (GaAsFETs), and insulated gate bipolar transistors 
(IGBT). The other class is described by subcircuit definitions: 
opamps, silicon controlled rectifiers (SCRs), triacs, unijunction 
transistors (UJTs), and more.

Intrinsically modeled semiconductors

Table 5-7 lists the semiconductor parts that reference models 
derived from intrinsic PSpice device model types. The varieties 
of breakout devices in a given technology vary according to the 
kind of model referenced and/or the number of pins. Table 5-8 
summarizes the classes of semiconductor models.

Operating temperature can be set to one that is different from the 
global circuit temperature by defining one of the model 
parameters, T_ABS, T_REL_GLOBAL, or T_REL_LOCAL. 
Additionally, model parameters can be assigned unique 
measurement temperatures using the T_MEASURED model 
parameter. Refer to the PSpice Reference Manual for a 
description of model parameters.

Table 5-9 lists the attributes that can be set for the 
semiconductor breakout parts. The AREA attribute provided 
with the GaAsFET, diode, IGBT, JFET, and bipolar transistor 
parts allows equivalent part instances to be scaled relative to one 
another. For example, instance Q1 of the QBREAKL part, with 
AREA set to 1.5, will have 1.5 times the junction capacitance, 
1.5 times the base-emitter conductance, and so on, of another 
QBREAKL instance with AREA left unset.
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Table 5-7 Intrinsically Modeled Semiconductor Parts

Part Type
Symbol 
Name

Model 
Type

Symbol Library 
File

Bipolar Transistor
(PSpice ‘Q’ device)

QBREAKL LPNP breakout.slb

QBREAKN
QBREAKN3
QBREAKN4

NPN

QBREAKP
QBREAKP3
QBREAKP4

PNP

Diode
(PSpice ‘D’ device)

DBREAK
DBREAK3
DBREAKCR
DBREAKVV
DBREAKZ

D, X breakout.slb

GaAsFET
(PSpice ‘B’ device)

BBREAK GASFET breakout.slb

IGBT
(PSpice ‘Z’ device)

ZBREAKN IGBT breakout.slb

JFET
(PSpice ‘J’ device)

JBREAKN NJF breakout.slb

JBREAKP PJF

MOSFET
(PSpice ‘M’ device)

MBREAKN
MBREAKN3
MBREAKN4

NMOS breakout.slb

MBREAKP
MBREAKP3
MBREAKP4

PMOS

Table 5-8 Semiconductor Model Types

Device 
Type

Model Type
Basis for Enhanced PSpice 
Model

GaAsFET GASFET, Level 1 Curtice N-channel GaAsFET

GASFET, Level 2 Raytheon (or Statz) N-channel 
GaAsFET

GASFET, Level 3 Triquint N-channel GaAsFET

GASFET, Level 4 Parker-Skellern MESFET

GASFET, Level 5 TOM-2

Note The IGBT 
model is not 
supported by 
PSpice Basics.

Note GASFET 
levels 1, 3, 4, 
and 5 are not 
supported by 
PSpice Basics.
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Diode D SPICE2G6 diode

JFET NJF Schichman-Hodges N-channel JFET

PJF Schichman-Hodges P-channel JFET

MOSFET NMOS, Level 1 Schichman-Hodges N-channel 
MOSFET

NMOS, Level 2 Grove-Frohman N-channel MOSFET

NMOS, Level 3 Semi-empirical short channel N-
channel MOSFET

NMOS, Level 4 BSIM N-channel MOSFET

NMOS, Level 6 BSIM3, Berkeley version 2.0, N-
channel MOSFET

PMOS, Level 1 Schichman-Hodges P-channel 
MOSFET

PMOS, Level 2 Grove-Frohman P-channel MOSFET

PMOS, Level 3 Semi-empirical short channel P-
channel MOSFET

PMOS, Level 4 BSIM P-channel MOSFET

PMOS, Level 6 BSIM3, Berkeley version 2.0, P-
channel MOSFET

Bipolar 
Transistor

NPN Gummel-Poon/Ebers-Moll NPN 
transistor

PNP Gummel-Poon/Ebers-Moll PNP 
transistor

LPNP Gummel-Poon/Ebers-Moll lateral 
PNP transistor

IGBT NIGBT N-channel IGBT

Table 5-8 Semiconductor Model Types (continued)

Device 
Type

Model Type
Basis for Enhanced PSpice 
Model

Note The IGBT 
model is not 
supported by 
PSpice Basics.
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Table 5-9 Semiconductor Part Attributes

Symbol 
Name

Attribut
e

Description

BBREAK AREA
MODEL

area scaling factor
GASFET model name

DBREAK
DBREAKCR
DBREAKVV
DBREAKZ

AREA
MODE
L

area scaling factor
D model name

JBREAKN
JBREAKP

AREA
MODE
L

area scaling factor
NJF or PJF model name

QBREAKL
QBREAKN
QBREAKN3
QBREAKN4
QBREAKP
QBREAKP3
QBREAKP4

AREA
MODE
L

 area scaling factor
NPN, PNP, or LNP model name

DBREAK3 MODEL D model name

MBREAKN

MBREAKN3

MBREAKN4

MBREAKP

MBREAKP3

MBREAKP4

L channel length

W channel width

AD drain diffusion area

AS source diffusion area

PD drain diffusion perimeter

PS source diffusion perimeter

NRD relative drain resistivity (in squares)

NRS relative source resistivity (in squares)

NRG relative gate resistivity (in squares)

NRB relative substrate resistivity (in squares)

M device multiplier (simulating parallel devices)

MODEL NMOS or PMOS model name
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ZBREAKN AGD gate-drain overlap area

AREA area of the device

KP MOS transconductance

TAU ambipolar recombination lifetime

WB Metallurgical base width

MODEL NIGBT model name

Table 5-9 Semiconductor Part Attributes (continued)

Symbol 
Name

Attribut
e

Description

Note The 
ZBREAKN 
symbol is not 
supported by 
PSpice Basics.
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A third list box contains stimulus 
files. See Configuring Stimulus 
Files on page 10-5 for more 
information.
Configuring the Library
The Schematics environment can be set up such that all or 
subset of model files are available for reference from any 
schematic. These files have global scope in the Schematics
environment meaning that the simulator will, by default, sear
these model files for unresolved device definitions. 
Conceptually, the model files with global status constitute th
model library and should be stored in a centralized location. S
Library directory paths on page 5-39 for how to specify the 
directory paths to these files.

In other cases, it may be desirable to have model files with lo
impact to one schematic. These model files are not conside
part of the model library, and are stored, by default, with the
schematic for which they were originally created. The simula
will search the local model files before those in the model libra
when the schematic referencing them is being simulated.

Global and local model files

The Library and Include Files dialog presents two list boxes
identify model and include files pertaining to your schematic
(named Library Files and Include Files, respectively). One fi
is specified per line. Files are grouped into two distinct class
global to the Schematics environment and local to a given 
schematic. Global files are marked with an asterisk (*) after t
file name. 

At installation, all of the files referenced in nom.lib  are global 
to the Schematics environment. The Library and Include File
dialog box (accessed from the Analysis menu) displays the 
nom.lib*  entry in the Library Files list box. The asterisk to th
right of the file name indicates that nom.lib  has global status 
and is available to all schematics.

New model files can be added to either the library or include 
by entering file names in the File Name text box and then 
clicking on the Add Library, Add Include, Add Library*, or Add
Include* button. The commands with an asterisk configure t
file as a global file. By configuring model files into the Library
Files list box, the simulator will automatically generate an ind
file (if an up-to-date index does not already exist) and use th
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index to access only the model and/or subcircuit definitions 
relevant to the simulation. Model files configured into the 
Include File list box are explicitly written to the circuit file set
and read by the simulator in their entirety.

The Add Library* button is used to incorporate new model file
into the model library (with global status). For instance, to ma
the device definitions contained in the user-defined model fi
mymodels.lib  available to the simulator at all times, this file 
name must be added to the list of globally accessible model fi
This requires typing its name in the File Name text box and 
clicking on Add Library*. After doing this, a new global entry
will appear in the library files list as mymodels.lib* . Note that 
this technique avoids any additions to the nom.lib  file.

Additional model files can be added, old files deleted, globa
local status modified, or the library/include status modified 
through this same dialog. The Delete button deletes the sele
file from its list box. The Change button copies the selected 
from the list box up to the edit control and deletes it from the li
allowing you to modify it. The Browse button brings up a dialo
allowing you to browse the directory structure and select a f
name. 

To set up model files for local use with the current schemati
you can use the Add Library button (no asterisk). Suppose y
current schematic is called mydesign , and mymodels.lib  
contains device models specifically for mydesign . 
Mymodels.lib  should be added to the library list using 
Add Library. This produces the mymodels.lib  entry in the 
library files list without an asterisk, indicating local file status
When simulating mydesign , the simulator searches this mode
file before those with global status.
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Note Care should be taken when configuring model files 
with the Add Include* (global) and Add Include 
(local) buttons in this dialog box. This method can 
have disadvantages when the model file is large. 
Rather than selecting only the model and 
subcircuit definitions needed, the simulator will 
load the entire file into memory. However, when 
developing device models and/or subcircuits, it 
can be useful to initially treat the model file as an 
include file. This avoids the rebuilding of index files 
every time the model file changes. Then, once the 
model definitions are stable, the model file can be 
reconfigured as a library file. The simulator will 
build the associated index file once. Henceforth, 
the simulator will read in only those definitions 
required for the simulation.

Search order

The simulator always searches local model files before glob
model files in the model library. However, within each class 
local or global files, the order in which they are specified in th
Library Files list box dictates the order in which the simulato
will search the files to resolve references. Optimizing the sea
order can significantly reduce search time. Where device nam
are alike across model files, search order will determine whi
of the devices is selected for simulation. The simulator alwa
uses the first instance.

In the Library and Include Files dialog box (accessed from th
Analysis menu), new files are always added after the curren
selected item in the Library Files list box. To add a file name
a certain position in the list, select the file name in the list abo
where you want the new file name to placed, then select the
Add_Library* (global) or Add_Library (local) command as 
required. 

If you have configured your model files by listing multiple .lib  
commands within a single file (like mymodels.lib ), and search 
order is critical, then you will need to manually edit the file 
contents with your platform’s text editor. In the standard mod
library, only diodes.lib  and ediodes.lib  (European 
manufactured diodes) have identically named device 



5-38 Creating Models

se 

o 

 to 

st 
then 
h 

 

at 
)

 
g 
definitions. If your schematic uses a device out of one of the
files, you must insure that the model file containing the 
definition of choice is listed first. If your system is configured t
use nom.lib  for the model library, and the file order is not in 
accordance with your circuit requirements, then you will have
edit this file.

Library directory paths

For model files without explicit path names, the simulator fir
searches the directory where the current schematic resides, 
steps down the list of directories specified in the Library Pat
text box of the dialog under Editor Configuration (accessed 
from the Option menu).

To ensure that model files added to the model library will be
located, it is necessary to do one of the following:

• Place the model files in the standard library directory (th
is, where the standard symbol and model files are stored

• Update the library path definition to include any new 
directories

• Use the full path name when adding the model file to the
Library Files list box in the Library and Include Files dialo
box described above
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We recommend that model files belonging to the model libra
(global status) reside in a centralized location. If this location
includes more than one directory, the directory paths can be
listed in the Library Path text box. Entries must be separated
semicolons.

For example, while the standard model files shipped with the
MicroSim simulation software might reside in C:\MSIM\LIB, a
second directory, for example C:\MYLIBS, might contain all o
your custom model files. To ensure that the simulator searc
both C:\MSIM\LIB and C:\MYLIBS for model files, type the 
new directory path name in the Library Path text box of the 
Editor Configuration dialog box (accessed from the Options 
menu) and click on OK.

Schematics and simulator interaction

When generating the circuit file set for simulation, Schemati
outputs a .LIB or .INC command for each model file specifie
in the Library Files or Include Files list box in the Library and
Include Files dialog box (accessed from the Analysis menu)
The list order is preserved, thus directing the simulator to sea
the specified model files for unresolved model and subcircu
references in the given order.

When the simulator runs, only those models and subcircuits
referenced by the parts in your schematic are actually read fr
the model files and put into main memory (RAM). This avoid
using up main memory for definitions which are not used. It a
means that there is no memory penalty for having large mod
files. Read-in time is also kept to a minimum.
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Chapter Overview
This chapter describes how to use Analog Behavioral Model
(ABM) feature provided in PSpice. This chapter includes the
following sections:

Overview of Analog Behavioral Modeling on page 6-2

The abm.slb Symbol Library File on page 6-3

Placing and Specifying ABM Parts on page 6-4

ABM Part Templates on page 6-6

Control System Parts on page 6-7

PSpice-Equivalent Parts on page 6-28

Cautions and Recommendations for Simulation and Analysis on 
page 6-41

Basic Controlled Sources on page 6-47
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Overview of Analog 
Behavioral Modeling
The Analog Behavioral Modeling (ABM) feature provided in 
PSpice allows for flexible descriptions of electronic componen
in terms of a transfer function or lookup table. In other words
mathematical relationship is used to model a circuit segmen
that the segment need not be designed component by 
component.

The symbol library contains several ABM parts that can be 
classified as either control system parts or as PSpice-equiva
parts. See Basic Controlled Sources on page 6-47 for an 
introduction to these parts, how to use them, and the distinct
between those with general-purpose application and those w
special purpose application.

Control system parts are defined with the reference voltage 
preset to ground so that each controlling input and the output
represented by a single pin in the symbol. These are describe
Control System Parts on page 6-7.

PSpice-equivalent parts reflect the structure of the PSpice “
and “G” device types which respond to a differential input an
have double-ended output. These are described in PSpice-
Equivalent Parts on page 6-28.

For compatibility with Berkeley SPICE, the polynomial transfe
function is also supported and is discussed in Basic Controlled 
Sources on page 6-47. However, the mathematical expression
offered with ABM can usually replace this method.

The Device Equations option (described in the PSpice Reference
Manual) can also be used for modeling of this type, but we 
recommend using the ABM feature wherever possible. With
Device Equations, the PSpice source code is actually modifi
While this is more flexible and the result executes faster, it i
much more difficult to use and prone to error. In addition, an
changes made to source code must be reapplied whenever
PSpice update is installed. Parts built using ABM can be use
for most cases of interest, are much easier to use, and are 
unaffected by PSpice updates.
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The abm.slb Symbol 
Library File
The symbol file abm.slb  contains the ABM components. This
file can logically be thought of as consisting of two sections.

The first section contains symbols that can be quickly connec
to form “control system” types of circuits. These component
have names like SUM, GAIN, LAPLACE, and HIPASS.

The second section contains symbols that are useful for mo
traditional “controlled source” forms of schematic parts. The
PSpice-equivalent symbols have names like EVALUE and 
GFREQ and are based on extensions to traditional PSpice “
and “G” device types.

ABM components are implemented using PSpice primitives
there is no corresponding abm.lib  file. A small number of 
components generate multi-line netlist entries, but the major
are implemented as single PSpice “E” or “G” device 
declarations. See ABM Part Templates on page 6-6 for a 
discussion of TEMPLATE attributes and their role in generati
netlist declarations. See Implementation of PSpice-Equivalent 
Parts on page 6-29 for more on PSpice “E” and “G” syntax.
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The name of an interface port 
does not extend to any 
connected nets. To refer to a 
signal originating at an interface 
port, connect the port to an 
offpage connector of the desired 
name.
Placing and Specifying 
ABM Parts
ABM parts are placed and connected in the same way as ot
part symbols. Once an ABM symbol is placed, the instance 
attributes can be edited, effectively customizing the operatio
behavior of the part. This is equivalent to defining an ABM 
expression describing how inputs are transformed into outpu
The following sections discuss some of the rules for specifyi
ABM expressions.

Net Names and Device Names in 
ABM Expressions
In ABM expressions, it is natural to refer to signals by name
This is also considerably more convenient than having to 
connect a wire from a pin on an ABM component to a point 
carrying the voltage of interest.

If you used an expression such as V(2), then the referenced
(2 in this case) is interpreted as the name of a local or global 
A local net is a labeled wire or bus segment in a hierarchica
schematic, or a labeled offpage connector. A global net is a
labeled wire or bus segment at the top level, or a global 
connector. 

MicroSim Schematics recognizes these constructs in ABM 
expressions:

V(< net name>)
V(< net name>,< net name>)
I(< vdevice>)

When one of these is recognized, Schematics searches for 
<net name> or <vdevice> in the net name space or the device
name space, respectively. Names are searched for first at th
hierarchical level of the part being netlisted. If not found ther
then the set of global names is searched. If the fragment is 
found, then a warning is issued but Schematics still outputs 
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resulting netlist. When a match is found, the original fragmen
replaced by the fully qualified name of the net or device.

For example, suppose we have a hierarchical part U1. Inside
schematic representing U1 we have an ABM expression 
including the term V(Reference). If “Reference” is the name 
a local net, then the fragment written to the netlist will be 
translated to V(U1_Reference). If “Reference” is the name o
global net, the corresponding netlist fragment will be 
V(Reference).

Names of voltage sources are treated similarly. For example
expression including the term I(Vsense) will be output as 
I(V_U1_Vsense) if the voltage source exists locally, and as 
I(V_Vsense) if the voltage source exists at the top level.

Forcing the Use of a Global 
Definition 
If a net name exists both at the local hierarchical level and at
top level, the search mechanism used by Schematics will fin
the local definition. You can override this, and force Schemat
to use the global definition, by prefixing the name with a sing
quote (') character.

For example, suppose there is a net called Reference both in
hierarchical part U1 and at the top level. Then, the ABM 
fragment V(Reference) will result in V(U1_Reference) in the
netlist, while the fragment V('Reference) will produce 
V(Reference).



6-6 Analog Behavioral Modeling

e E 
ge 

 
are 
rd 
e 

ice 

R 
 
 

ree 
 the 
.

 
ode. 
t 

For clarity, the template is shown 
on three lines although the actual 
template is a single line.
ABM Part Templates
For most ABM symbols, a single PSpice “E” or “G” device 
declaration is output to the netlist per symbol instance. The 
TEMPLATE attribute in these cases is straightforward. For 
example the LOG symbol defines an expression variant of th
device with its output being the natural logarithm of the volta
between the input pin and ground:

E^@REFDES %out 0 VALUE { LOG(V(%in)) }

The fragment E^@REFDES is standard. The “E” specifies a
PSpice controlled voltage source (E device); %in and %out 
the input and output pins, respectively; VALUE is the keywo
specifying the type of ABM device; and the expression insid
the curly braces defines the logarithm of the input voltage.

Several ABM symbols produce more than one primitive PSp
device per symbol instance. In this case, the TEMPLATE 
attribute may be quite complicated. An example is the DIFFE
(differentiator) symbol. This is implemented as a capacitor in
series with a current sensor together with an E device which
outputs a voltage proportional to the current through the 
capacitor.

The template has several unusual features: it gives rise to th
primitives in the PSpice netlist, and it creates a local node for
connection of the capacitor and its current-sensing V device

C^@REFDES %in $$U^@REFDES 1\n
V^@REFDES $$U^@REFDES 0 0v\n
E^@REFDES %out 0 VALUE {@GAIN * 
I(V^@REFDES)}

The fragments C^@REFDES, V^@REFDES, and 
E^@REFDES create a uniquely named capacitor, current 
sensing V device, and E device, respectively. The fragment
$$U^@REFDES creates a name suitable for use as a local n
The E device generates an output proportional to the curren
through the local V device.
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Control System Parts
Control system parts have single-pin inputs and outputs. Th
reference for input and output voltages is analog ground (0). 
enhancement to PSpice means that these components can 
connected together with no need for dummy load or input 
resistors.

Table 6-1 lists the control system parts, grouped by function.
Also listed are characteristic attributes that may be set. In th
sections that follow, each part and its attributes are describe
more detail.

Table 6-1 Control System Parts

Category Symbol Description Attributes

Basic 
Components

CONST constant VALUE

SUM adder

MULT multiplier

GAIN gain block GAIN

DIFF subtracter

Limiters LIMIT hard limiter LO, HI

GLIMIT limiter with gain LO, HI, GAIN

SOFTLIM soft (tanh) limiter LO, HI, GAIN

Chebyshev 
Filters

LOPASS lowpass filter FP, FS, RIPPLE, 
STOP

HIPASS highpass filter FP, FS, RIPPLE, 
STOP

BANDPASS bandpass filter F0, F1, F2, F3, 
RIPPLE, STOP

BANDREJ band reject (notch) 
filter

F0, F1, F2, F3, 
RIPPLE, STOP

Integrator and
Differentiator

INTEG integrator GAIN, IC

DIFFER differentiator GAIN

Table Look-Ups TABLE lookup table ROW1...ROW5

FTABLE frequency lookup 
table

ROW1...ROW5
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Laplace 
Transform

LAPLACE Laplace expression NUM, DENOM

Math Functions
(where ‘x’ is the 
input)

ABS |x|

SQRT x1/2

PWR |x|EXP EXP

PWRS xEXP EXP

LOG ln(x)

LOG10 log(x)

EXP ex 

SIN sin(x)

COS cos(x)

TAN tan(x)

ATAN tan-1(x)

ARCTAN tan-1(x)

Expression 
Functions

ABM no inputs, V out EXP1...EXP4

ABM1 1 input, V out EXP1...EXP4

ABM2 2 inputs, V out EXP1...EXP4

ABM3 3 inputs, V out EXP1...EXP4

ABM/I no input, I out EXP1...EXP4

ABM1/I 1 input, I out EXP1...EXP4

ABM2/I 2 inputs, I out EXP1...EXP4

ABM3/I 3 inputs, I out EXP1...EXP4

Table 6-1 Control System Parts (continued)

Category Symbol Description Attributes
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Basic Components
The basic components provide fundamental functions and in
many cases, do not require specifying attribute values. Thes
parts are described below.

CONST

The CONST part outputs the voltage specified by the VALU
attribute. This part provides no inputs and one output.

SUM

The SUM part evaluates the voltages of the two input sourc
adds the two inputs together, then outputs the sum. This pa
provides two inputs and one output.

MULT

The MULT part evaluates the voltages of the two input sourc
multiplies the two together, then outputs the product. This p
provides two inputs and one output.

GAIN

The GAIN part multiplies the input by the constant specified b
the GAIN attribute, then outputs the result. This part provide
one input and one output.

DIFF

The DIFF part evaluates the voltage difference between two
inputs, then outputs the result. This part provides two inputs a
one output.

VALUE is a constant value

GAIN is a constant gain value
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Limiters
The Limiters can be used to restrict an output to values betw
a set of specified ranges. These parts are described below.

LIMIT

The LIMIT part constrains the output voltage to a value betwe
an upper limit (set with the HI attribute) and a lower limit (se
with the LO attribute). This part takes one input and provide
one output.

GLIMIT

The GLIMIT part functions as a one-line opamp. The gain is
applied to the input voltage, then the output is constrained to
limits set by the LO and HI attributes. This part takes one inp
and provides one output.

SOFTLIMIT

The SOFTLIMIT part provides a limiting function much like the
LIMIT device, except that it uses a continuous curve limiting
function, rather than a discontinuous limiting function.   This
part takes one input and provides one output.

HI is a value representing the upper limit

LO is a value representing the lower limit

HI is a value representing the upper limit

LO is a value representing the lower limit

GAIN is a constant gain value

HI is a value representing the upper limit

LO is a value representing the lower limit

GAIN is a constant gain value

A, B, V, 
TANH

are internal variables used to define the limitin
function
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We recommend looking at one or 
more of the references cited in 
Frequency-Domain Device 
Models on page 6-35, as well as 
some of the following references 
on analog filter design:

1 Ghavsi, M.S. & Laker, K.R., 
Modern Filter Design, 
Prentice-Hall, 1981.

2 Gregorian, R. & Temes, G., 
Analog MOS Integrated 
Circuits, Wiley-Interscience, 
1986.

3 Johnson, David E., 
Introduction to Filter Theory, 
Prentice-Hall, 1976.

4 Lindquist, Claude S., Active 
Network Design with Signal 
Filtering Applications, 
Steward & Sons, 1977.

5 Stephenson, F.W. (ed), RC 
Active Filter Design 
Handbook, Wiley, 1985.

6 Van Valkenburg, M.E., 
Analog Filter Design, Holt, 
Rinehart & Winston, 1982.

7 Williams, A.B., Electronic 
Filter Design Handbook, 
McGraw-Hill, 1981.

Figure 6-1 LOPASS Filter 
Chebyshev Filters
The Chebyshev filters allow filtering of the signal based on a 
of frequency characteristics. The output of a Chebyshev filte
depends upon the analysis being done.

For DC and bias point, the output is simply the DC response
the filter. For AC analysis, the output for each frequency is t
filter response at that frequency. For transient analysis, the 
output is then the convolution of the past values of the input w
the impulse response of the filter. These rules follow the 
standard method of using Fourier transforms.

Note PSpice computes the impulse response of each 
Chebyshev filter used in a transient analysis during 
circuit read-in. This may require considerable 
computing time. A message is displayed on your 
screen indicating that the computation is in 
progress.

Note To obtain a listing of the filter Laplace coefficients 
for each stage, select Setup from the Analysis 
menu, click on Options, and turn on LIST in the 
Options dialog box.

Each of the Chebyshev filter parts is described in the followi
pages.

LOPASS

The LOPASS part is characterized by two cutoff frequencies
that delineate the boundaries of the filter pass band and sto
band. The attenuation values, RIPPLE and STOP, define th
maximum allowable attenuation in the pass band, and the 
minimum required attenuation in the stop band, respectively
The LOPASS part provides one input and one output.

Figure 6-1 shows an example of a LOPASS filter device. Th
filter provides a pass band cutoff of 800 Hz and a stop band
cutoff of 1.2 kHz. The pass band ripple is 0.1 dB and the 

FS is the stop band frequency

FP is the pass band frequency

RIPPLE is the pass band ripple in dB

STOP is the stop band attenuation in dB
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Figure 6-2 HIPASS Filter Part 
E l
minimum stop band attenuation is 50 dB. Assuming that the
input to the filter is the voltage at net 10 and output is a volta
between nets 5 and 0, this will produce a PSpice netlist 
declaration like this:

ELOWPASS 5 0 CHEBYSHEV {V(10)} = LP 800 
1.2K .1dB 50dB

HIPASS

The HIPASS part is characterized by two cutoff frequencies t
delineate the boundaries of the filter pass band and stop ba
The attenuation values, RIPPLE and STOP, define the 
maximum allowable attenuation in the pass band, and the 
minimum required attenuation in the stop band, respectively
The HIPASS part provides one input and one output.

Figure 6-2 shows an example of a HIPASS filter device. This
a high pass filter with the pass band above 1.2 kHz and the 
band below 800 Hz. Again, the pass band ripple is 0.1 dB a
the minimum stop band attenuation is 50 dB. This will produ
a PSpice netlist declaration like this:

EHIGHPASS 5 0 CHEBYSHEV {V(10)} = HP 1.2K 
800 .1dB 50dB

BANDPASS

The BANDPASS part is characterized by four cutoff 
frequencies. The attenuation values, RIPPLE and STOP, de
the maximum allowable attenuation in the pass band, and th
minimum required attenuation in the stop band, respectively
The BANDPASS part provides one input and one output.

FS is the stop band frequency

FP is the pass band frequency

RIPPLE is the pass band ripple in dB

STOP is the stop band attenuation in dB

RIPPLE is the pass band ripple in dB

STOP is the stop band attenuation in dB

F0, F1, 
F2, F3

are the cutoff frequencies
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Figure 6-3 BANDPASS Filter 
Example Part

Figure 6-4 BANDREJ Filter 
Figure 6-3 shows an example of a BANDPASS filter device.
This is a band pass filter with the pass band between 1.2 kHz
2 kHz, and stop bands below 800 Hz and above 3 kHz. The p
band ripple is 0.1 dB and the minimum stop band attenuation
50 dB. This will produce a PSpice netlist declaration like this

EBANDPASS 5 0 CHEBYSHEV {V(10)} = BP 800 
1.2K 2K 3K .1dB 50dB

BANDREJ

The BANDREJ part is characterized by four cutoff frequencie
The attenuation values, RIPPLE and STOP, define the 
maximum allowable attenuation in the pass band, and the 
minimum required attenuation in the stop band, respectively
The BANDREJ part provides one input and one output.

Figure 6-4 shows an example of a BANDREJ filter device. Th
is a band reject (or “notch”) filter with the stop band between 1
kHz and 2 kHz, and pass bands below 800 Hz and above 3 kH
The pass band ripple is 0.1 dB and the minimum stop band 
attenuation is 50 dB. This will produce a PSpice netlist 
declaration like this:

ENOTCH 5 0 CHEBYSHEV {V(10)} = BR 1.2K 800 
3K 2K .1dB 50dB

RIPPLE is the pass band ripple in dB

STOP is the stop band attenuation in dB

F0, F1, 
F2, F3

are the cutoff frequencies
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 If more than five values are 
required, the symbol can be 
customized through the symbol 
editor. Insert additional row 
variables into the template using 
the same form as the first five, 
and add ROWn attributes as 
needed to the list of attributes.
Integrator and Differentiator 
The integrator and differentiator parts are described below.

INTEG

The INTEG part implements a simple integrator. A current 
source/capacitor implementation is used to provide support 
setting the initial condition.

DIFFER

The DIFFER part implements a simple differentiator. A voltag
source/capacitor implementation is used. The DIFFER part 
provides one input and one output.

Table Look-Up Parts
TABLE and FTABLE parts provide a lookup table which is 
used to correlate an input and an output based on a set of d
points. These parts are described below and in the following
pages.

TABLE

The TABLE part allows the response to be defined by a table
one to five values. Each row contains an input and a 
corresponding output value. Linear interpolation is performe
between entries.

For values outside the table’s range, the device’s output is a
constant with a value equal to the entry with the smallest (or
largest) input. This characteristic can be used to impose an u
and lower limit on the output. The TABLE part provides one
input and one output.

IC is the initial condition of the integrator output

GAIN is the value of the gain

GAIN is the value of the gain

ROWn is an (input, output) pair; by default, up to five
triplets are allowed where n=1, 2, 3, 4, or 5
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If more than five values are 
required, the symbol can be 
customized through the symbol 
editor. Insert additional row 
variables into the template using 
the same form as the first five, 
and add ROWn attributes as 
needed to the list of attributes.
FTABLE

The FTABLE part is described by a table of frequency respon
in either the magnitude/phase domain (R_I= ) or complex 
number domain (R_I=YES). The entire table is read in and 
converted to magnitude in dB and phase in degrees.

Interpolation is performed between entries. Magnitude is 
interpolated logarithmically; phase is interpolated linearly. Fo
frequencies outside the table’s range, 0 (zero) magnitude is
used. This characteristic can be used to impose an upper an
lower limit on the output.

The DELAY attribute increases the group delay of the 
frequency table by the specified amount. The delay term is 
particularly useful when a frequency table device generates
non-causality warning message during a transient analysis. 
warning message issues a delay value that can be assigned 
symbol’s DELAY attribute for subsequent runs, without 
otherwise altering the table.

The output of the part depends on the analysis being done. 
DC and bias point, the output is the zero frequency magnitu
times the input voltage. For AC analysis, the input voltage is
linearized around the bias point (similar to EVALUE and 

ROWn is either an (input frequency, magnitude, 
phase) triplet, or an (input frequency, real 
part, imaginary part) triplet describing a 
complex value; by default, up to five triplets 
are allowed where n=1, 2, 3, 4, or 5

DELAY group delay increment; defaults to 0 if left 
blank

R_I defines the table type; if left blank, the 
frequency table is interpreted in the (input 
frequency, magnitude, phase) format; if 
defined with any value (such as YES), the 
table is interpreted in the (input frequency, 
real part, imaginary part) format

MAGUNITS units for magnitude where the value can be 
DB (decibels) or MAG (raw magnitude); 
defaults to DB if left blank

PHASEUNITS units for phase where the value can be DEG
(degrees) or RAD (radians); defaults to DEG
if left blank
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Figure 6-5 FTABLE Part 
GVALUE parts, Modeling Mathematical or Instantaneous 
Relationships on page 6-30). The output for each frequency is 
then the input times the gain, times the value of the table at 
frequency.

For transient analysis, the voltage is evaluated at each time
point. The output is then the convolution of the past values w
the impulse response of the frequency response. These rule
follow the standard method of using Fourier transforms. We
recommend looking at one or more of the references cited in 
Frequency-Domain Device Models on page 6-35 for more 
information. 

Note The table’s frequencies must be in order from 
lowest to highest. The TABLE part provides one 
input and one output.

Example

A device, ELOFILT, is used as a frequency filter. The input t
the frequency response is the voltage at net 10. The output 
voltage across nets 5 and 0. The table describes a low pass 
with a response of 1 (0 dB) for frequencies below 5 kilohertz a
a response of 0.001 (-60 dB) for frequencies above 6 kilohe
The phase lags linearly with frequency. This is the same as 
constant time delay. The delay is necessary so that the imp
response is causal. That is, so that the impulse response doe
have any significant components before time zero. The 
FTABLE part in Figure 6-5 could be used.

This part is characterized by the following attributes:

ROW1 = 0Hz 0 0
ROW2 = 5kHz 0 -5760
ROW3 = 6kHz -60 -6912
DELAY =
R_I =
MAGUNITS =
PHASEUNITS = 

Since R_I, MAGUNITS, and PHASEUNITS are undefined, 
each table entry is interpreted as containing frequency, 
magnitude value in dB, and phase values in degrees. Delay
defaults to 0.

This produces a PSpice netlist declaration like this:
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ELOFILT 5 0 FREQ {V(10)} = (0,0,0) (5kHz,0,-5760)
(6kHz,-60,-6912)

Since constant group delay is calculated from the values for
given table entry as:

group delay = phase / 360 / frequency 

An equivalent FTABLE instance could be defined using the 
DELAY attribute. For this example, the group delay is 3.2 ms
(6912 / 360 / 6k = 5760 / 360 / 6k = 3.2m). Equivalent attribu
assignments are:

ROW1 = 0Hz 0 0
ROW2 = 5kHz 0 0
ROW3 = 6kHz -60 0
DELAY = 3.2ms
R_I = 
MAGUNITS = 
PHASEUNITS = 

This produces a PSpice netlist declaration like this:

ELOFILT 5 0 FREQ {V(10)} = (0,0,0) (5kHz,0,0) (6kHz,-60,0)
+ DELAY=3.2ms
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Laplace Transform Part
The LAPLACE part specifies a Laplace transform which is us
to determine an output for each input value. 

LAPLACE

The LAPLACE part uses a Laplace transform description. T
input to the transform is a voltage. The numerator and 
denominator of the Laplace transform function are specified
attributes for the symbol.

Note Voltages, currents, and TIME may not appear in a 
Laplace transform specification. 

The output of the part depends on the type of analysis being
done. For DC and bias point, the output is the zero frequenc
gain times the value of the input. The zero frequency gain is 
value of the Laplace transform with s=0. For AC analysis, th
output is then the input times the gain times the value of the
Laplace transform. The value of the Laplace transform at a 
frequency is calculated by substituting j·ω for s, where ω is 
2π·frequency. For transient analysis, the output is the 
convolution of the input waveform with the impulse response
the transform. These rules follow the standard method of us
Laplace transforms.

Example 1

The input to the Laplace transform is the voltage at net 10. T
output is a voltage and is applied between nets 5 and 0. For 
the output is simply equal to the input, since the gain at s = 0
1. The transform, 1/(1+.001·s), describes a simple, lossy 
integrator with a time constant of 1 millisecond. This can be
implemented with an RC pair that has a time constant of 1 
millisecond.

For AC analysis, the gain is found by substituting j·ω for s. This 
gives a flat response out to a corner frequency of 1000/(2π) = 
159 hertz and a roll-off of 6 dB per octave after 159 Hz. The
is also a phase shift centered around 159 Hz. In other words

NUM is the numerator of the Laplace expression

DENOM is the denominator of the Laplace 
expression
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Figure 6-6 LAPLACE Part 
E l 1

Figure 6-8 LAPLACE Part 
E l
gain has both a real and an imaginary component. For trans
analysis, the output is the convolution of the input waveform
with the impulse response of 1/(1+.001·s). The impulse respo
is a decaying exponential with a time constant of 1 millisecon
This means that the output is the “lossy integral” of the inpu
where the loss has a time constant of 1 millisecond. The 
LAPLACE part shown in Figure 6-6 could be used for this 
purpose.

The transfer function is the Laplace transform (1/[1+.001*s])
This LAPLACE part is characterized by the following 
attributes:

NUM = 1
DENOM = 1 + .001*s

The gain and phase characteristics are shown in Figure 6-7

This produces a PSpice netlist declaration like this: 

ERC 5 0 LAPLACE {V(10)} = {1/(1+.001*s)}

Example 2

The input is V(10). The output is a current applied between n
5 and 0. The Laplace transform describes a lossy transmiss

Figure 6-7 Lossy Integrator Example: Viewing Gain and 
Phase Characteristics with Probe
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line. R, L, and C are the resistance, inductance, and capacita
of the line per unit length. 

If R is small, the characteristic impedance of such a line is 
Z = ((R + j·ω·L)/(j·ω·C))1/2, the delay per unit length is (L C)1/2, 
and the loss in dB per unit length is 23·R/Z.   This could be 
represented by the device in Figure 6-8.

The parameters R, L, and C can be defined in a .PARAM 
statement contained in a model file. (Refer to the PSpice 
Reference Manual for more information about using .PARAM 
statements.) More useful, however, is for R, L, and C to be 
arguments passed into a subcircuit. This part has the follow
characteristics:

NUM = EXP(-SQRT(C*s*(R+L*s)))
DENOM = 1

This produces a PSpice netlist declaration like this: 

GLOSSY 5 0 LAPLACE {V(10)} = {exp(-sqrt(C*s*(R + L*s)))}

The Laplace transform parts are, however, an inefficient way
both computer time and memory, to implement a delay. For
ideal delays we recommend using the transmission line part
instead.
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Math Functions
The ABM math function parts are shown in Table 6-2. For each 
device, the corresponding template is shown, indicating the 
order in which the inputs are processed, if applicable.

Math function parts are based on the PSpice “E” device type
Each provides one or more inputs, and a mathematical func
which is applied to the input. The result is output on the outp
net.

Table 6-2 ABM Math Function Parts

Device Description

ABS Output is the absolute value of the input

SQRT Output is the square root of the input

PWR Output is the result of raising the absolute value o
the input to the power specified by EXP

PWRS Output is the result of raising the (signed) input 
value to the power specified by EXP

LOG Output is the LOG of the input

LOG10 Output is the LOG10 of the input

EXP Output is the result of e raised to the power 
specified by the input value (ex where x is the 
input)

SIN Output is the sin of the input (where the input is in 
radians)

COS Output is the cos of the input (where the input is in 
radians)

TAN Output is the tan of the input (where the input is in 
radians)

ATAN,
ARCTAN

Output in radians is the tan-1 of the input
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ABM Expression Parts 
The expression parts are shown in Table 6-3. These parts can be
customized to perform a variety of functions depending on yo
requirements. Each of these parts has a set of four express
building block attributes of the form:

EXPn

where n = 1, 2, 3, or 4.

During netlist generation, the complete expression is formed
concatenating the building block expressions in numeric ord
thus defining the transfer function. Hence, the first expressio
fragment should be assigned to the EXP1 attribute, the seco
fragment to EXP2, and so on.

Expression attributes can be defined using a combination of
arithmetic operators and input designators. You may use an
the standard PSpice arithmetic operators (see Table 3-5 on 
page 3-10) within an expression statement. You may also us
the EXPn attributes as variables to represent nets or constan

The following examples illustrate a variety of ABM expressio
part applications.

Table 6-3 ABM Expression Parts

Device Inputs Output

ABM none V

ABM1 1 V

ABM2 2 V

ABM3 3 V

ABM/I none I

ABM1/I 1 I

ABM2/I 2 I

ABM3/I 3 I
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Figure 6-9 ABM Expression 
Part Example 1

Figure 6-10 ABM Expression 
Part Example 2
Example 1

Suppose you want to set an output voltage on net 4 to 5 vol
times the square root of the voltage between nets 3 and 2. Y
could use an ABM2 part (which takes two inputs and provide
voltage output) to define a part like the one shown in Figure 6

In this example of an ABM device, the output voltage is set to
volts times the square root of the voltage between net 3 and
net 2. The attribute settings for this part are as follows:

EXP1 = 5V *
EXP2 = SQRT(V(%IN2,%IN1))

This will produce a PSpice netlist declaration like this: 

ESQROOT 4 0 VALUE = {5V*SQRT(V(3,2))}

Example 2

GPSK is an oscillator for a PSK (Phase Shift Keyed) modulat
Current is pumped from net 11 through the source to net 6. 
value is a sine wave with an amplitude of 15 mA and a frequen
of 10 kHz. The voltage at net 3 can shift the phase of GPSK
1 radian/volt. Note the use of the TIME parameter in the EX
expression. This is the PSpice internal sweep variable used
transient analyses. For any analysis other than transient, TI
= 0. This could be represented with an ABM1/I part (single 
input, current output) like the one shown in Figure 6-10.

This part is characterized by the following attributes:

EXP1 = 15ma * SIN(
EXP2 = 6.28*10kHz*TIME
EXP3 = + V(%IN))

 This produces a PSpice netlist declaration like this: 

GPSK   11 6 VALUE = 
{15MA*SIN(6.28*10kHz*TIME+V(3))}
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Figure 6-11 ABM Expression 
Part Example 3

Figure 6-12 ABM Expression 
Part Example 4
Example 3

A device, EPWR, computes the instantaneous power by 
multiplying the voltage across nets 5 and 4 by the current 
through VSENSE. Sources are controlled by expressions wh
may contain voltages or currents or both. The ABM2 part (tw
inputs, current output) in Figure 6-11 could represent this.

This part is characterized by the following attributes:

EXP1 = V(%IN2,%IN1) *
EXP2 = I(VSENSE)

This produces a PSpice netlist declaration like this: 

EPWR    3 0 VALUE = {V(5,4)*I(VSENSE)}

Example 4

The output of a component, GRATIO, is a current whose val
(in amps) is equal to the ratio of the voltages at nets 13 and 2
V(2) = 0, the output depends upon V(13) as follows: 

if V(13) = 0, output = 0 
if V(13) > 0, output = MAXREAL 
if V(13) < 0, output = -MAXREAL 

where MAXREAL is a PSpice internal constant representing
very large number (on the order of 1e30). In general, the res
of evaluating an expression is limited to MAXREAL. This is 
modeled with an ABM2/I (two input, current output) part like
this one in Figure 6-12.

This part is characterized by the following attributes: 

EXP1 = V(%IN2)/V(%IN1)

Note that output of GRATIO can be used as part of the 
controlling function. This produces a PSpice netlist declarati
like this:

GRATIO 2 3 VALUE = {V(13)/V(2)} 

Note Letting a current approach ±1e30 will almost 
certainly cause convergence problems. To avoid 
this, use the limit function on the ratio to keep the 
current within reasonable limits. 
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An Instantaneous Device 
Example: Modeling a Triode
This section provides an example of using various ABM parts
model a triode vacuum tube. The schematic of the triode 
subcircuit is shown in Figure 6-13. 

Figure 6-13 Triode Circuit

Assumptions: In its main operating region, the triode’s curre
is proportional to the 3/2 power of a linear combination of th
grid and anode voltages: 

ianode = k0*(vg + k1*va)1.5 

For a typical triode, k0 = 200e-6 and k1 = 0.12.

Looking at the upper left-hand portion of the schematic, noti
the a general-purpose ABM part used to take the input volta
from anode, grid, and cathode. Assume the following 
associations: 

• V(anode) is associated with V(%IN1) 

• V(grid) is associated with V(%IN2) 

• V(cathode) is associated with V(%IN3) 

The expression attribute EXP1 then represents V(grid, catho
and the expression attribute EXP2 represents 0.12[V(anode
cathode)]. When the template substitution is performed, the
resulting VALUE is equivalent to the following: 

V = V(grid, cathode) + 0.12*V(anode, cathode)

The part would be defined with the following characteristics:
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EXP1 = V(%IN2,%IN3)+
EXP2 = 0.12*V(%IN1,%IN3)

This works for the main operating region but does not model 
case in which the current stays 0 when combined grid and an
voltages go negative. We can accommodate that situation a
follows by adding the LIMIT part with the following 
characteristics:

HI = 1E3
LO = 0

This part instance, LIMIT1, converts all negative values of 
vg+.12*va to 0 and leaves all positive values (up to 1 kV) alon
For a more realistic model, we could have used TABLE to 
correctly model how the tube turns off at 0 or at small negat
grid voltages.

We also need to make sure that the current becomes zero w
the anode alone goes negative. To do this, we can use a DI
device, (immediately below the ABM3 device) to monitor the
difference between V(anode) and V(cathode), and output th
difference to the TABLE part. The table translates all values
or below zero to zero, and all values greater than or equal to
to one. All values between 0 and 30 are linearly interpolated
The attributes for the TABLE part are as follows:

ROW1 = 00
ROW2 = 301

The TABLE part is a simple one, and ensures that only a ze
value is output to the multiplier for negative anode voltages.

The output from the TABLE part and the LIMIT part are 
combined at the MULT multiplier part. The output of the MULT
part is the product of the two input voltages. This value is th
raised to the 3/2 or 1.5 power using the PWR part. The 
exponential attribute of the PWR part is defined as follows:

EXP = 1.5

The last major component is an ABM expression componen
take an input voltage and convert it into a current. The relev
ABM1/I part attribute looks like this:

EXP1 = 200E-6 * V(%IN)

A final step in the model is to add device parasitics. For 
example, a resistor can be used to give a finite output 
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impedance. Capacitances between the grid, cathode, and a
are also needed. The lower part of the schematic in Figure 6
shows a possible method for incorporating these effects. To
complete the example, one could add a circuit which produc
the family of I-V curves (shown in Figure 6-14).

Figure 6-14 Triode Subcircuit Producing a Family of I-V 
Curves
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There are no equivalent “F” or 
“H” part types in the symbol 
library since PSpice “F” and “H” 
devices do not support the ABM 
extensions.
PSpice-Equivalent Parts
PSpice-equivalent parts respond to a differential input and h
double-ended output. These parts reflect the structure of PS
“E” and “G” devices, thus having two pins for each controllin
input and the output in the symbol. Table 6-4 summarizes the 
PSpice-equivalent parts available in the symbol library.

PSpice-equivalent ABM parts can be classified as either “E”
part types or “G” part types. The E part type provides a volta
output, and the G part type provides a current output. The pa
transfer function can contain any mixture of voltages and 
currents as inputs. Hence, there is no longer a division betw
voltage-controlled and current-controlled parts. Rather the p
type is dictated only by the output requirements. If a voltage
output is required, use an E part type. If a current output is 
necessary, use a G part type.

Each E or G part type in the abm.slb  symbol file is defined by 
a template that provides the specifics of the transfer function

Table 6-4 PSpice-Equivalent Parts

Category Symbol Description
Attribut
es

Mathematical 
Expression

EVALUE general purpose EXPR

GVALUE

ESUM special purpose (none)

GSUM

EMULT

GMULT

Table Look-Up ETABLE general purpose EXPR

GTABLE TABLE

Frequency 
Table Look-Up

EFREQ general purpose EXPR

GFREQ TABLE

Laplace 
Transform

ELAPLACE general purpose EXPR

GLAPLACE XFORM
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Other attributes in the model definition can be edited to 
customize the transfer function. By default, the template can
be modified directly using Attributes on the Edit menu in 
Schematics. Rather, the values for other attributes (such as
expressions used in the template) are usually edited, then th
values are substituted into the template. However, the symb
editor can be used to modify the template or designate the 
template as modifiable from within Schematics. This way, 
custom symbols can be created for special-purpose applica

Implementation of PSpice-
Equivalent Parts
Although you generally use Schematics to place and specify
PSpice-equivalent ABM parts, it is useful to know the PSpic
command syntax for “E” and “G” devices. This is especially 
true when creating custom ABM symbols since symbol 
templates must adhere to PSpice syntax.

The general forms for PSpice “E” and “G” extensions are

E < name> < connecting nodes > < ABM keyword> < ABM function>

G <name> < connecting nodes > < ABM keyword> < ABM function>

where

<name> is the device name appended to the E o
G device type character

<connecting 
nodes>

specifies the <(+ node name, - node 
name)> pair between which the device is
connected

<ABM 
keyword>

specifies the form of the transfer function
to be used, as one of:
VALUE arithmetic expression
TABLE lookup table
LAPLACE  Laplace transform
FREQ frequency response table
CHEBYSHEV Chebyshev filter

characteristics
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Refer to the PSpice Reference Manual for detailed information. 

Modeling Mathematical or 
Instantaneous Relationships  

The instantaneous models (using VALUE and TABLE 
extensions to PSpice “E” and “G” devices in the symbol 
templates) enforce a direct response to the input at each mom
in time. For example, the output might be equal to the squar
root of the input at every point in time. Such a device has no
memory, or, a flat frequency response. These techniques ca
used to model both linear and nonlinear responses.

Note For AC analysis, a nonlinear device is first 
linearized around the bias point, and then the 
linear equivalent is used.

EVALUE and GVALUE parts

The EVALUE and GVALUE parts allow an instantaneous 
transfer function to be written as a mathematical expression
standard notation. These parts take the input signal, perform
function specified by the EXPR attribute on the signal, and 
output the result on the output pins.

In controlled sources, EXPR may contain constants and 
parameters as well as voltages, currents, or time. Voltages m
be either the voltage at a net, such as V(5), or the voltage ac
two nets, such as V(4,5). Currents must be the current throug
voltage source (V device), for example, I(VSENSE). Voltage
sources with a value of 0 are handy for sensing current for u
in these expressions.

Functions may be used in expressions, along with arithmetic
operators (+, -, *, and /) and parentheses. Available built-in 
functions are summarized in Table 3-6 on page 3-11.

<ABM 
function>

specifies the transfer function as a 
formula or lookup table as required by 
the specified <ABM keyword>
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Figure 6-15 EVALUE Part 
Example

Figure 6-16 GVALUE Part 
Example
The EVALUE and GVALUE symbols are defined, in part, by
the following attributes (default values are shown):

EVALUE

EXPR V(%IN+, %IN-)

GVALUE

EXPR V(%IN+, %IN-)

Sources are controlled by expressions which may contain 
voltages, currents, or both. The following examples illustrate
customized EVALUE and GVALUE parts.

Example 1

In the example of an EVALUE device shown in Figure 6-15, th
output voltage is set to 5 volts times the square root of the 
voltage between pins %IN+ and %IN-.

The attribute settings for this device are as follows:

EXPR = 5v * SQRT(V(%IN+,%IN-))

Example 2

Consider the device in Figure 6-16. This device could be used
an oscillator for a PSK (Phase Shift Keyed) modulator.

A current through a source is a sine wave with an amplitude
15 mA and a frequency of 10 kHz. The voltage at the input p
can shift the phase by 1 radian/volt. Note the use of the TIM
parameter in this expression. This is the PSpice internal swe
variable used in transient analyses. For any analysis other t
transient, TIME = 0. The relevant attribute settings for this 
device are shown below:

EXPR = 15ma*SIN(6.28*10kHz*TIME+V(%IN+,%IN-))

EMULT, GMULT, ESUM, and GSUM

The EMULT and GMULT parts provide output which is base
on the product of two input sources. The ESUM and GSUM
parts provide output which is based on the sum of two input
sources. The complete transfer function may also include ot
mathematical expressions.
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Figure 6-17 EMULT Part 
Example 1

Consider the device in Figure 6-17. This device computes th
instantaneous power by multiplying the voltage across pins 
%IN+ and %IN- by the current through VSENSE. This device
behavior is built-in to the TEMPLATE attribute as follows:

TEMPLATE=E^@REFDES %OUT+ %OUT- VALUE {V(%IN1+,%IN1-)
*V(%IN2+,%IN2-)}

You can use the symbol editor to change the characteristics
the template to accommodate additional mathematical 
functions, or to change the nature of the transfer function its
For example, you may want to create a voltage divider, rath
than a multiplier. This is illustrated in the following example.

Example 2

Consider the device in Figure 6-18.

Figure 6-18 GMULT Part Example

With this device, the output is a current is equal to the ratio 
the voltages at input pins 1 and input pins 2. If V(%IN2+, %IN
) = 0, the output depends upon V(%IN1+, %IN1-) as follows

if V(%IN1+, %IN1-) = 0, output = 0
if V(%IN1+, %IN1-) > 0, output = MAXREAL
if V(%IN1+, %IN1-) < 0, output = -MAXREAL

where MAXREAL is a PSpice internal constant representing
very large number (on the order of 1e30). In general, the res
of evaluating an expression is limited to MAXREAL. Note tha
the output of the symbol can also be used as part of the 
controlling function. 

To create this device, you would first make a new symbol, 
GDIV, based on the GMULT part. Edit the GDIV template to
divide the two input values rather than multiply them. 
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Lookup Tables (ETABLE and 
GTABLE)
The ETABLE and GTABLE parts use a transfer function 
described by a table. These device models are well suited for
with measured data.

The ETABLE and GTABLE symbols are defined in part by th
following attributes (default values are shown):

ETABLE

TABLE (-15, -15), (15,15)
EXPR V(%IN+, %IN-)

GTABLE

TABLE (-15, -15), (15,15)
EXPR V(%IN+, %IN-)

First, EXPR is evaluated, and that value is used to look up a
entry in the table. EXPR is a function of the input (current or
voltage) and follows the same rules as for VALUE expressio

The table consists of pairs of values, the first of which is an 
input, and the second of which is the corresponding output. 
Linear interpolation is performed between entries. For values
EXPR outside the table’s range, the device’s output is a cons
with a value equal to the entry with the smallest (or largest) 
input. This characteristic can be used to impose an upper an
lower limit on the output.

An example of a table declaration (using the TABLE attribut
would be the following:
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TABLE =

+ (0, 0) (.02, 2.690E-03) (.04, 4.102E-03) (.06, 4.621E-03)

+ (.08, 4.460E-03) (.10, 3.860E-03) (.12, 3.079E-03) (.14,
+ 2.327E-03)

+ (.16, 1.726E-03) (.18, 1.308E-03) (.20, 1.042E-03) (.22,
+ 8.734E-04)

+ (.24, 7.544E-04) (.26, 6.566E-04) (.28, 5.718E-04) (.30,
+ 5.013E-04)

+ (.32, 4.464E-04) (.34, 4.053E-04) (.36, 3.781E-04) (.38,
+ 3.744E-04)

+ (.40, 4.127E-04) (.42, 5.053E-04) (.44, 6.380E-04) (.46,
+ 7.935E-04)

+ (.48, 1.139E-03) (.50, 2.605E-03) (.52, 8.259E-03) (.54,
+ 2.609E-02)

+ (.56, 7.418E-02) (.58, 1.895E-01) (.60, 4.426E-01)
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Moving back and forth between 
the time and frequency-domains 
can cause surprising results. 
Often the results are quite 
different than what one would 
intuitively expect. For this 
reason, we strongly recommend 
familiarity with a reference on 
Fourier and Laplace transforms. 
A good one is:

1 R. Bracewell, The Fourier 
Transform and Its 
Applications, McGraw-Hill, 
Revised Second Edition 
(1986)

We also recommend familiarity 
with the use of transforms in 
analyzing linear systems.   Some 
references on this subject:

2 W. H. Chen, The Analysis of 
Linear Systems, McGraw-Hill 
(1962)

3 J. A. Aseltine, Transform 
Method in Linear System 
Analysis, McGraw-Hill (1958)

4 G. R. Cooper and C. D. 
McGillen, Methods of Signal 
and System Analysis, Holt, 
Rinehart, and Winston (1967)

Voltages, currents, and TIME 
cannot appear in a Laplace 
transform.
Frequency-Domain Device 
Models
Frequency-domain models (ELAPLACE, GLAPLACE, 
EFREQ, and GFREQ) are characterized by output that depe
on the current input as well as the input history. The relations
is therefore non-instantaneous. For example, the output may
equal to the integral of the input over time. In other words, th
response depends upon frequency.

During AC analysis, the frequency response determines the
complex gain at each frequency. During DC analysis and bi
point calculation, the gain is the zero-frequency response. 
During transient analysis, the output of the device is the 
convolution of the input and the impulse response of the dev

Laplace Transforms (LAPLACE)
The ELAPLACE and GLAPLACE parts allow a transfer 
function to be described by a Laplace transform function. Th
ELAPLACE and GLAPLACE symbols are defined, in part, b
the following attributes (default values are shown):

ELAPLACE

EXPR V(%IN+, %IN-)
XFORM 1/s

GLAPLACE

EXPR V(%IN+, %IN-)
XFORM 1/s

The LAPLACE parts use a Laplace transform description. T
input to the transform is the value of EXPR, where EXPR 
follows the same rules as for VALUE expressions (see 
EVALUE and GVALUE parts on page 6-30). XFORM is an 
expression in the Laplace variable, s. It follows the rules for 
standard expressions as described for VALUE expressions w
the addition of the s variable.

The output of the device depends on the type of analysis be
done. For DC and bias point, the output is simply the zero 
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frequency gain times the value of EXPR. The zero frequenc
gain is the value of XFORM with s = 0. For AC analysis, EXP
is linearized around the bias point (similar to the VALUE parts
The output is then the input times the gain of EXPR times th
value of XFORM. The value of XFORM at a frequency is 
calculated by substituting j·w for s, where w is 2p·frequency. F
transient analysis, the value of EXPR is evaluated at each ti
point. The output is then the convolution of the past values o
EXPR with the impulse response of XFORM. These rules 
follow the standard method of using Laplace transforms. We
recommend looking at one or more of the references cited in
Frequency-Domain Device Models on page 6-35 for more 
information.

Example

The input to the Laplace transform is the voltage across the in
pins, or V(%IN+, %IN-). The EXPR attribute may be edited t
include constants or functions, as with other parts. The 
transform, 1/(1+.001·s), describes a simple, lossy integrator
with a time constant of 1 millisecond. This can be implement
with an RC pair that has a time constant of 1 millisecond.

Using the symbol editor, you would define the XFORM and 
EXPR attributes as follows:

XFORM = 1/(1+.001*s)
EXPR = V(%IN+, %IN-)

The default template remains:

TEMPLATE= E^@REFDES %OUT+ %OUT- LAPLACE 
{@EXPR}= (@XFORM)

After netlist substitution of the template, the resulting transfe
function would become:

V(%OUT+, %OUT-) = LAPLACE {V(%IN+, %IN-)}= (1/1+.001*s))

The output is a voltage and is applied between pins %OUT+ a
%OUT-. For DC, the output is simply equal to the input, sinc
the gain at s = 0 is 1.
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For AC analysis, the gain is found by substituting j·ω for s. This 
gives a flat response out to a corner frequency of 1000/(2π) = 
159 Hz and a roll-off of 6 dB per octave after 159 Hz. There
also a phase shift centered around 159 Hz. In other words, 
gain has both a real and an imaginary component. The gain 
phase characteristic is the same as that shown for the equiva
control system part example using the LAPLACE part (see 
Figure 6-7 on page 6-19).

For transient analysis, the output is the convolution of the inp
waveform with the impulse response of 1/(1+.001·s). The 
impulse response is a decaying exponential with a time cons
of 1 millisecond. This means that the output is the “lossy 
integral” of the input, where the loss has a time constant of 1
millisecond.

This will produce a PSpice netlist declaration similar to:

ERC 5 0 LAPLACE {V(10)} = {1/(1+.001*s)}

Frequency Response Tables 
(EFREQ and GFREQ)
The EFREQ and GFREQ parts are described by a table of 
frequency responses in either the magnitude/phase domain
complex number domain. The entire table is read in and 
converted to magnitude in dB and phase in degrees. 
Interpolation is performed between entries. Phase is interpola
linearly; magnitude is interpolated logarithmically. For 
frequencies outside the table’s range, 0 (zero) magnitude is
used.
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EFREQ and GFREQ attributes are defined as follows:

The DELAY attribute increases the group delay of the 
frequency table by the specified amount. The delay term is 
particularly useful when an EFREQ or GFREQ device genera
a non-causality warning message during a transient analysis
The warning message issues a delay value that can be assi
to the symbol’s DELAY attribute for subsequent runs, withou
otherwise altering the table.

The output of the device depends on the analysis being done
DC and bias point, the output is simply the zero frequency 
magnitude times the value of EXPR. For AC analysis, EXPR
linearized around the bias point (similar to EVALUE and 
GVALUE parts). The output for each frequency is then the inp
times the gain of EXPR times the value of the table at that 
frequency. For transient analysis, the value of EXPR is 
evaluated at each time point. 

EXPR is the value used for table lookup; 
defaults to V(%IN+, %IN-) if left blank.

TABLE is a series of either (input frequency, 
magnitude, phase) triplets, or (input 
frequency, real part, imaginary part) 
triplets describing a complex value; 
defaults to (0,0,0) (1Meg,-10,90) if left 
blank.

DELAY group delay increment; defaults to 0 if 
left blank.

R_I defines the table type; if left blank, the 
frequency table is interpreted in the 
(input frequency, magnitude, phase) 
format; if defined with any value (such as
YES), the table is interpreted in the 
(input frequency, real part, imaginary 
part) format.

MAGUNITS units for magnitude where the value ca
be DB (decibels) or MAG (raw 
magnitude); defaults to DB if left blank.

PHASEUNITS units for phase where the value can be
DEG (degrees) or RAD (radians); 
defaults to DEG if left blank.
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Figure 6-19 EFREQ Part 
The output is then the convolution of the past values of EXP
with the impulse response of the frequency response. These
rules follow the standard method of using Fourier transforms
We recommend looking at one or more of the references cite
Frequency-Domain Device Models on page 6-35 for more 
information.

Note The table’s frequencies must be in order from 
lowest to highest.

Figure 6-19 shows an EFREQ device used as a low pass fil
The input to the frequency response is the voltage across th
input pins. The table describes a low pass filter with a respo
of 1 (0 dB) for frequencies below 5 kilohertz and a response
.001 (-60 dB) for frequencies above 6 kilohertz. The output i
voltage across the output pins.

This part is defined by the following attributes: 

TABLE = (0, 0, 0) (5kHz, 0, -5760) (6kHz, -60, -6912)
DELAY = 
R_I =
MAGUNITS =
PHASEUNITS =

Since R_I, MAGUNITS, and PHASEUNITS are undefined, 
each table entry is interpreted as containing frequency, 
magnitude value in dB, and phase values in degrees. Delay
defaults to 0.

The phase lags linearly with frequency meaning that this tab
exhibits a constant time (group) delay. The delay is necessar
that the impulse response is causal. That is, so that the imp
response does not have any significant components before 
zero.

The constant group delay is calculated from the values for a
given table entry as follows:

group delay = phase / 360 / frequency

For this example, the group delay is 3.2 msec (6912 / 360 / 6
5760 / 360 / 6k = 3.2m). An alternative specification for this 
table could be:
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TABLE = (0, 0, 0) (5kHz, 0, 0) (6kHz, -60, 0)
DELAY = 3.2ms
R_I =
MAGUNITS =
PHASEUNITS =

This produces a PSpice netlist declaration like this:

ELOWPASS 5 0 FREQ {V(10)} = (0,0,0) (5kHz,0,0) (6kHz-60,0)
+ DELAY = 3.2ms
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Figure 6-20 Voltage Multiplier 
Circuit (Mixer)
Cautions and 
Recommendations for 
Simulation and Analysis

Instantaneous Device Modeling 
During AC analysis, nonlinear transfer functions are handled 
same way as other nonlinear parts: each function is linearize
around the bias point and the resulting small-signal equivalen
used.

Consider the voltage multiplier (mixer) shown in Figure 6-20
This circuit has the following characteristics: 

Vin1: DC=0v   AC=1v
Vin2: DC=0v   AC=1v 

where the output on net 3 is V(1)*V(2).

During AC analysis, V(3) = 0 due to the 0 volts bias point 
voltage on nets 1, 2, and 3. The small-signal equivalent there
has 0 gain (the derivative of V(1)*V(2) with respect to both V(1
and V(2) is 0 when V(1)=V(2)=0).   So, the output of the mixe
during AC analysis will be 0 regardless of the AC values of V(
and V(2).

Another way of looking at this is that a mixer is a nonlinear 
device and AC analysis is a linear analysis. The output of th
mixer has 0 amplitude at the fundamental. (Output is nonzer
DC and twice the input frequency, but these are not included
a linear analysis.) 

If you need to analyze nonlinear functions, such as a mixer, 
transient analysis. Transient analysis solves the full, nonline
circuit equations. It also allows you to use input waveforms w
different frequencies (for example, VIN1 could be 90 MHz an
VIN2 could be 89.8 MHz). AC analysis does not have this 
flexibility, but in return it uses much less computer time.
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Frequency-Domain Parts
Some caution is in order when moving between frequency a
time domains. This section discusses several points that are
involved in the implementation of frequency-domain parts. 
These discussions all involve the transient analysis, since b
the DC and AC analyses are straightforward.

The first point is that there are limits on the maximum values
and on the resolution of both time and frequency. These are
related: the frequency resolution is the inverse of the maxim
time and vice versa. The maximum time is the length of the 
transient analysis, TSTOP. Therefore, the frequency resolut
is 1/TSTOP.

Laplace Transforms
For Laplace transforms, PSpice starts off with initial bounds 
the frequency resolution and the maximum frequency 
determined by the transient analysis parameters as follows. 
frequency resolution is initially set below the theoretical limit t
(.25/TSTOP) and is then made as large as possible without 
inducing sampling errors. The maximum frequency has an 
initial upper bound of (1/(RELTOL*TMAX)), where TMAX is 
the transient analysis Step Ceiling value, and RELTOL is th
relative accuracy of all calculated voltages and currents. If a
Step Ceiling value is not specified, PSpice uses the Transie
Analysis Print Step, TSTEP, instead.

Note TSTOP, TMAX, and TSTEP values are configured 
using Transient on the Setup menu. The RELTOL 
attribute is set using Options on the Setup menu.

PSpice then attempts to reduce the maximum frequency by
searching for the frequency at which the response has fallen
RELTOL times the maximum response. For instance, for the
transform:

1/(1+s)

the maximum response, 1.0, is at s = j·ω = 0 (DC). The cutoff 
frequency used when RELTOL=.001, is approximately 1000
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(2π) = 159 Hz. At 159 Hz, the response is down to .001 (dow
by 60 db). Since some transforms do not have such a limit, th
is also a limit of 10/RELTOL times the frequency resolution, o
10/(RELTOL·TSTOP). For example, consider the transform:

e-0.001·s 

This is an ideal delay of 1 millisecond and has no frequency
cutoff. If TSTOP = 10 milliseconds and RELTOL=.001, then
PSpice imposes a frequency cutoff of 10 MHz. Since the tim
resolution is the inverse of the maximum frequency, this is 
equivalent to saying that the delay cannot resolve changes in
input at a rate faster than .1 microseconds. In general, the ti
resolution will be limited to RELTOL·TSTOP/10.

A final computational consideration for Laplace parts is that t
impulse response is determined by means of an FFT on the
Laplace expression. The FFT is limited to 8192 points to kee
tractable, and this places an additional limit on the maximum
frequency, which may not be greater than 8192 times the 
frequency resolution.

If your circuit contains many Laplace parts which can be 
combined into a more complex single device, it is generally 
preferable to do this. This saves computation and memory si
there are fewer impulse responses. It also reduces the numb
opportunities for numerical artifacts that might reduce the 
accuracy of your transient analyses.

Laplace transforms can contain poles in the left half-plane. S
poles will cause an impulse response that increases with tim
instead of decaying. Since the transient analysis is always fo
finite time span, PSpice does not have a problem calculating
transient (or DC) response. However, you need to be aware 
such poles will make the actual device oscillate.

Non-causality and Laplace transforms

PSpice applies an inverse FFT to the Laplace expression to
obtain an impulse response, and then convolves the impuls
response with the dependent source input to obtain the outp
Some common impulse responses are inherently non-causa
This means that the convolution must be applied to both past
future samples of the input in order to properly represent the
inverse of the Laplace expression.
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A good example of this is the expression {S}, which 
corresponds to differentiation in the time domain. The impul
response for {S} is an impulse pair separated by an infinitesim
distance in time. The impulses have opposite signs, and are
situated one in the infinitesimal past, the other in the 
infinitesimal future. In other words, convolution with this 
corresponds to applying a finite-divided difference in the tim
domain.

The problem with this for PSpice is that the simulator only h
the present and past values of the simulated input, so it can 
apply half of the impulse pair during convolution. This will 
obviously not result in time-domain differentiation. PSpice ca
detect, but not fix this condition, and issues a non-causality 
warning message when it occurs. The message tells what 
percentage of the impulse response is non-causal, and how m
delay would need to be added to slide the non-causal part in
causal region. {S} is theoretically 50% non-causal. Non-
causality on the order of 1% or less is usually not critical to t
simulation results.

One more point about {S}. You can delay it to keep it causal, b
keep in mind that the separation between the impulses is 
infinitesimal. This means that a very small time step is need
For this reason, it is usually better to use a macromodel to 
implement differentiation.

Here are some useful guidelines:

• In the case of a Laplace device (ELAPLACE), multiply th
Laplace expression by e to the (-s ∗ <the suggested delay>)

• In the case of a frequency table (EFREQ or GFREQ), do
either of the following:

• Specify the table with DELAY=<the suggested delay

• Compute the delay by adding a phase shift.

Chebyshev filters

All of the considerations given above for Laplace parts also 
apply to Chebyshev filter parts. However, PSpice also attem
to deal directly with inaccuracies due to sampling by applyin
Nyquist criteria based on the highest filter cutoff frequency. 
This is done by checking the value of TMAX. If TMAX is not
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specified it is assigned a value, or if it is specified, it may be
reduced. 

For low pass and band pass filters, TMAX is set to (0.5/FS),
where FS is the stop band cutoff in the case of a low pass fil
or the upper stop band cutoff in the case of a band pass filte

For high pass and band reject filters, there is no clear way to
apply the Nyquist criterion directly, so an additional factor of
two is thrown in as a safety margin. Thus, TMAX is set to (0.2
FP), where FP is the pass band cutoff for the high pass cas
the upper pass band cutoff for the band reject case. It may b
necessary to set TMAX to something smaller if the filter inpu
has significant frequency content above these limits.

Frequency tables

For frequency response tables, the maximum frequency is tw
the highest value. It will be reduced to 10/(RELTOL⋅TSTOP) or 
8192 times the frequency resolution if either value is smalle

The frequency resolution for frequency response tables is ta
to be either the smallest frequency increment in the table or 
fastest rate of phase change, whichever is least. PSpice the
checks to see if it can be loosened without inducing samplin
errors.
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Trading Off Computer 
Resources For Accuracy
It should be clear from the foregoing discussion that there is
significant trade-off between accuracy and computation time 
parts modeled in the frequency domain. The amount of 
computer time and memory scale approximately inversely to
RELTOL. Therefore, if you can use RELTOL=.01 instead of th
default .001, you will be ahead. However, you should first 
assure yourself based on the relevant criteria described abo
that this will not adversely affect the impulse response. You m
also wish to vary TMAX and TSTOP, since these also come in
play.

Since the trade-off issues are fairly complex, it is advisable 
first simulate a small test circuit containing only the frequenc
domain device, and then after proper validation, proceed to 
incorporate it in your larger design. The PSpice defaults will 
appropriate most of the time if accuracy is your main concer
but it is still worth checking.

Note Do not set RELTOL to a value above 0.01. This 
can seriously compromise the accuracy of your 
simulation.
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The EPOLY and GPOLY parts 
are made obsolete by the Analog 
Behavioral Modeling extensions 
provided with PSpice “E” and “G” 
devices.
Basic Controlled 
Sources
As with basic SPICE, PSpice has basic controlled sources, 
including a built-in polynomial capability (POLY keyword) 
where functions are in the form of a polynomial of any degre
and any dimension. POLY is explained in detail under E, F, 
and H device types in the PSpice Reference Manual.

The basic controlled source parts available in the symbol libr
are derived from the standard SPICE E, F, G, and H device
including their polynomial forms.

The POLY form is no longer necessary since ABM parts 
provide an easier and more flexible method for specifying 
expressions.

This section provides a brief overview of the POLY form, and
comparison of POLY and ABM parts. The standard SPICE 
implementation of POLY has these limitations:

• many transfer functions are not well represented by 
polynomials

• the syntax for specifying the polynomial is quite difficult to
use

• there is no way to specify frequency-dependent behavio

• you cannot parameterize the coefficients on a POLY 
statement

The ABM parts eliminate these restrictions.

Table 6-5 summarizes the linear controlled source types 
provided in the standard symbol library. Table 6-6 lists their 
attributes.
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Basic SPICE Polynomial 
Expressions (POLY)
PSpice (and SPICE) use the following syntax:

<controlled source>  < connecting nodes>
+ POLY(<dimension> ) < controlling input>  < coefficients>

where

Table 6-5 Basic Controlled Sources in analog.slb

Part Type
Symbol 
Name

Controlled Voltage Source
(PSpice “E” device)

E

EPOLY

Current-Controlled Current Source
(PSpice “F” device)

F

FPOLY

Controlled Current Source
(PSpice “G” device)

G

GPOLY

Current-Controlled Voltage Source
(PSpice “H” device)

H

HPOLY

<controlled 
source>

is <[E][F][G][H] device name>, meaning 
the device type is one of E, F, G, or H

<connecting 
nodes>

specifies <(+node_name, -node_name)> 
pair between which the device is connecte

<dimension> is the dimension <value> of the 
polynomial describing the controlling 
function

<controlling 
input>

specifies <(+node_name, -node_name)>* 
pairs used as input to the voltage controlle
source (device types E and G), or 
<V device name>* for the current 
controlled source (device types F and H)
and where the number of controlling input
for either case equals <dimension>
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Caution must be exercised with 
the POLY form. For instance,

EWRONG 1 0 POLY(1) (1,0) 
.5 1.0

tries to set node 1 to .5 volts 
greater than node 1. In this case, 
any analyses which you specify 
will fail to calculate a result. In 
particular, PSpice cannot 
calculate the bias point for a 
circuit containing EWRONG. 
This also applies to the VALUE 
form of EWRONG (EWRONG 1 
0 VALUE = {0.5 * V(1)}).
If the source is one-dimensional (there is only one controllin
source), “POLY(1)” is required unless the linear form is used
the source is multidimensional (there is more than one 
controlling source), the dimension needs to be included in th
keyword, for instance “POLY(2).”

PSpice has a built-in capability allowing controlled sources t
be defined with a polynomial transfer function of any degree a
any dimension. Polynomials have associated coefficients fo
each term. Consider a voltage-controlled source with voltag
V1, V2, ... Vn. The coefficients are associated with the 
polynomial according to this convention:

Vout = P0 +

P1·V1 + P2·V2 + ··· Pn·Vn +

Pn+1·V1·V1 + Pn+2·V1·V2 + ··· Pn+n·V1·Vn + 

P2n+1·V2·V2 + P2n+2·V2·V3 + ··· P2n+n-1·V2·Vn +

.

.

.

Pn!/(2(n-2)!)+2n·Vn·Vn +

Pn!/(2(n-2)!)+2n+1·V1
2·V1 + Pn!/(2(n-2)!)+2n+2·V1

2·V2 + ···

.

.

.

<coefficients
>

specifies the coefficient <values>* for the 
polynomial transfer function

Table 6-6 Basic Controlled Source Attributes

Symbol Name
Attribut
e

Description

E

F

G

H

GAIN gain

gain

transconductance

transresistance

EPOLY, FPOLY,
GPOLY, HPOLY

COEFF polynomial coefficient
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The above is written for a voltage-controlled voltage source, 
the form is similar for the other sources.

The POLY part types shown in Table 6-5 are defined with a 
dimension of one, meaning there is only one controlling sour
However, similar parts can be defined of any degree and 
dimension by creating part symbols with appropriate coefficie
and TEMPLATE attributes, and the appropriate number of inp
pins. 

The current-controlled parts (F, FPOLY, H, and HPOLY), 
contain a current-sensing voltage source. When netlisted, th
generate two device declarations to the circuit file set: one f
the controlled source and one for the independent current-
sensing voltage source.

When defining a current-controlled source symbol of higher 
dimension, the TEMPLATE attribute must account for the sam
number of current-sensing voltage sources (equal to the 
dimension value). For example, a two dimensional current-
controlled voltage source is described by the following 
polynomial equation:

Vout = C0 + C1I1 + C2I2 + C11I1
2 + C12I1I2 + C22I2

2 

To create the two dimensional HPOLY2 symbol, these 
attributes must be defined:

COEFF0 = 1
COEFF1 = 1
COEFF2 = 1
COEFF11 = 1
COEFF12 = 1
COEFF22 = 1
COEFFS = @COEFF0 @COEFF1 @COEFF2 
@COEFF11 @COEFF12 @COEFF22
TEMPLATE = H^@REFDES %5 %6 POLY(2) 
VH1^@REFDES VH2^@REFDES

\n+ @COEFFS \nVH1^@REFDES %1 %2 0V 
\nVH2^@REFDES %3 %4 0V

The TEMPLATE definition is actually contained on a single 
line. The VH1 and VH2 fragments after the \n characters 
represent the device declarations for the two current-sensin
voltage sources required by this part. Also, the symbol graph
must have the appropriate number of pins. When placing an
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must be appropriately set.

Implementation Examples
Following are some examples of traditional SPICE POLY 
constructs and equivalent ABM parts which could be used 
instead.

Example 1: Four-Input Voltage Adder

This is an example of a device which takes four input voltag
and sums them to provide a single output voltage.

The representative polynomial expression would be as follo

Vout = 0.0 + (1.0)V1 + (1.0)V2 + (1.0)V3 + (1.0)V4 

The corresponding SPICE POLY form would be as follows:

ESUM 100 101 POLY(4) (1,0) (2,0) (3,0) (4,0) 0.0 1.0 1.0
+ 1.0 1.0

This could be represented with a single ABM expression dev
configured with the following expression attributes: 

EXP1 = V(1,0) +
EXP2 = V(2,0) +
EXP3 = V(3,0) +
EXP4 = V(4,0) 

Following template substitution for the ABM device, the outp
becomes:

V(OUT) = { V(1,0) + V(2,0) + V(3,0) + V(4,0) }

Example 2: Two-Input Voltage Multiplier

This is an example of a device which takes two input voltage
and multiplies them together resulting in a single output voltag

The representative polynomial expression would be as follo

Vout = 0.0 + (0.0)V1 + (0.0)V2 + (0.0)V1
2 + (1.0)V1V2 

The corresponding SPICE POLY form would be as follows:

EMULT 100 101 POLY(2) (1,0) (2,0) 0.0 0.0 0.0 0.0 1.0
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This could be represented with a single MULT device, which
described in Basic Components on page 6-9. For additional 
examples of a voltage multiplier device, see Basic Components 
on page 6-9 and EMULT, GMULT, ESUM, and GSUM on 
page 6-31.

Example 3: Voltage Squarer

This is an example of a device that outputs the square of the
input value.

For the one-dimensional polynomial, the representative 
polynomial expression reduces to:

Vout = P0 + P1·V + P2·V2 + ... Pn·Vn

The corresponding SPICE POLY form would be as follows:

ESQUARE 100 101 POLY(1) (1,0) 0.0 0.0 1.0

This could be represented by a single instance of the MULT
part, with both inputs from the same net. This results in the 
following:

Vout = (Vin)2 
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See Creating a New Symbol on 
page 4-2 for a description of how 
to create a custom symbol.

Refer to the PSpice Reference 
Manual for more information 
about “E” and “G” devices.
Creating custom ABM parts

When you require a controlled source that is not provided with
the special purpose set, or that exhibits more elaborate beha
than is provided with the general purpose parts (with multipl
controlling inputs, for example), we recommend building the
functionality into a custom symbol similar to the special purpo
parts introduced above.

The transfer function can be built into the symbol either of th
following ways:

• directly in the TEMPLATE definition

• by defining the part’s EXPR and related attributes (if any

Familiarity with the PSpice syntax for declaring “E” and “G” 
devices will help you form a suitable TEMPLATE definition.
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Part Three describes how to set up and run analyses and prov
setup information specific to each analysis type.

Chapter 7,Setting Up Analyses and Starting Simulation, 
provides an overview of setting up analyses and starting 
simulation which applies to any analysis type.

Chapter 8,DC Analyses, describes how to set up DC analyse
including DC sweep, bias point detail, small-signal DC transf
and DC sensitivity.

Chapter 9,AC Sweep Analysis, describes how to set up AC 
sweep and noise analyses.

Chapter 10,Transient Analysis, describes how to set up a 
transient analysis. This chapter includes a variety of topics 
related to transient analysis, including using the Stimulus Edi

Chapter 11,Parametric and Temperature Analysis, describes 
how to set up parametric, temperature, and performance 
analyses. 

Chapter 12,Monte Carlo and Sensitivity/Worst-Case Analyse, 
describes how to set up Monte Carlo and sensitivity/worst-ca
analyses.
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Chapter Overview
This chapter provides an overview of setting up analyses an
starting simulation which applies to any analysis type. The ot
chapters in Part Three, Setting Up and Running Analyses 
provide specific analysis setup information for each analysis
type.

This chapter includes the following sections:

Analysis Types on page 7-2

Setting Up Analyses on page 7-3

Starting Simulation on page 7-11
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Note Parametric 
analysis is not 
supported by 
PSpice Basics.

See Part Four, Viewing Results, 
for information about using 
Probe.

Note Monte Carlo 
and sensitivity/
worst-case 
analyses are not 
supported by 
PSpice Basics.
Analysis Types
Table 7-1 provides a summary of the available PSpice analys
and the corresponding dialog box (accessed using Setup on
Analysis menu) where the analysis parameters are specified

The Probe waveform analyzer is used to display and graphic
analyze the results of PSpice simulations for swept analyses
Supplementary analysis information is generated to the 
simulation output file in the form of lists and tables.

Table 7-1 Classes of PSpice Analyses

Analysis
Analysis Setup
Dialog Box

Swept 
Variable

Standard analyses 

DC sweep DC sweep source

parameter

temperature

bias point bias point detail

small-signal DC transfer transfer function

DC sensitivity sensitivity

frequency response AC sweep frequency

noise (requires a frequency
response analysis)

AC sweep frequency

transient response transient time

Fourier (requires transient
response analysis)

transient time

Simple multi-run analyses 

parametric parametric

temperature temperature

Statistical analyses 

Monte Carlo Monte Carlo/
worst-case

Sensitivity/worst-case Monte Carlo/
worst-case
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Shortcut: Click on .

Specific information for setting 
up each type of analysis is 
discussed in the following 
chapters.

See Output Variables on 
page 7-4 for a description of the 
output variables that can be 
entered in the setup options 
dialog box displayed for an 
analysis type.
Setting Up Analyses
To set up one or more analyses

1 Select Analysis from the Setup menu in the schematic 
editor.

2 At the Analysis Setup dialog box, click on an analysis 
button.

3 If a setup options dialog box is displayed for the selected
analysis type, complete the dialog box as needed. 

4 If needed, click on the check box next to the button for th
analysis type so that the analysis is enabled (check box 
checked on).

5 Set up any other analyses you want to perform for the 
circuit.
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Execution Order for Standard 
Analyses
During simulation, any analyses that are enabled are perform
in the order shown in Table 7-2. Each type of analysis is done a
most once per run.

Several of the analyses (small-signal transfer, DC sensitivity
and frequency response) depend upon the bias point calcula
Since so many analyses use the bias point, PSpice calculat
automatically.

.

Output Variables
Certain analyses (such as noise, Monte Carlo, sensitivity/wo
case, DC sensitivity, Fourier, and small-signal DC transfer 
function) require you to specify output variables for voltages
and currents at specific points on the schematic. Depending
upon the analysis type, you may need to specify the followin

• voltage on a net, a pin, or at a terminal of a semiconduc
device

• current through a part or into a terminal of a semiconduc
device

• a device name

If output variables or other information are required, a dialog
box is displayed when you click on the button for the analys
type in the Analysis Setup dialog box.

Table 7-2 Execution Order for Standard Analyses

1. DC sweep 5. DC sensitivity

2. Bias point 6. Small-signal DC transfer

3. Frequency response 7. Transient response

4. Noise 8. Fourier components



Setting Up Analyses 7-5

d 

 by 

 

r 
as 

 
nd 

n 
Voltage

Specify voltage in the following format:

v[modifiers](<out id>[,<out id>]) (1)

where <out id > is:

<net id> or <pin id> (2)

<net id> is a fully qualified net name (3)

<pin id> is <fully qualified device name>:<pin name> (4)

A fully qualified net name (as referred to in line 3 above) is 
formed by prefixing the visible net name (from a label applie
to one of the segments of a wire or bus, or an offpage port 
connected to the net) with the full hierarchical path, separated
periods. At the top level of hierarchy, this is just the visible 
name.

A fully qualified device name (from line 4 above) is 
distinguished by specifying the full hierarchical path followed
by the device’s reference designator, separated by period 
characters. For example, a resistor with reference designato
R34 inside part Y1 placed on a top-level page is referred to 
Y1.R34 when used in an output variable.

A <pin id> (from line 4) is uniquely distinguished by specifying
the full part name (as described above) followed by a colon, a
the pin name. For example, the pins on a capacitor with 
reference designator C31 placed on a top-level page and pi
names 1 and 2 would be identified as C31:1 and C31:2, 
respectively.

Current

Specify current in the following format:

i[modifiers](<out device>[:modifiers])

where <out device> is a fully qualified device name.
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Modifiers

The basic syntax for output variables can be modified to indic
terminals of semiconductors and/or AC specifications. The 
modifiers come before <out id> or <out device>. Or, when 
specifying terminals (such as source or drain), the modifier i
the pin name contained in <out id>, or is appended to 
<out device> separated by a colon.

Modifiers can be specified as follows:

• For voltage:

v[AC suffix](<out id>[, out id])
v[terminal]*(< out device>)

• For current:

i[AC suffix](<out device>[:terminal])
i[ terminal][AC suffix](<out device>])

where

These building blocks can be used for specifying output 
variables as shown in Table 7-3 (which summarizes the 
accepted output variable formats) and Tables 7-4 through 7-7 
(which list valid elements for two-terminal, three or four-
terminal, transmission line devices, and AC specifications).

terminal specifies one or two terminals for devices wit
more than two terminals, such as D (drain), G
(gate), S (source)

AC suffix specifies the quantity to be reported for an A
analysis, such as M (magnitude), P (phase),
(group delay)

out id specifies either the <net id> or <pin id>  
(<fully qualified device name>:<pin name>)

out device specifies the <fully qualified device name>
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Table 7-3 PSpice Output Variable Formats

Format Meaning

V[ac](< + out id >) voltage at out id

V[ac](< +out id >,< - out id >) Voltage across + and - out 
id’s

V[ac](< 2-terminal device out id >) Voltage at a 2-terminal 
device out id

V[ac](< 3 or 4-terminal device out id 
>) or

V<x>[ac](< 3 or 4-terminal out device 
>)

Voltage at non-grounded 
terminal x of a 3 or 4-
terminal device

V<x><y>[ac](< 3 or 4-terminal out 
device >)

Voltage across terminals 
x and y of a 3 or 4-
terminal device

V[ac](< transmission line out id >) or

V<z>[ac](< transmission line out 
device >)

Voltage at one end z of a 
transmission line 
device

I[ac](< 3 or 4-terminal out device 
>:<x>) or

I<x>[ac](< 3 or 4-terminal out device 
>)

Current through non-
grounded terminal x of a 
3 or 4-terminal out 
device

I[ac](< transmission line out device 
>:<z>) or

I<z>[ac](< 3 or 4-terminal out device 
>)

Current through one end z 
of a transmission line 
out device

< DC sweep variable > Voltage or current source 
name
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Table 7-4 Element Definitions for 2-Terminal Devices

Device Type

<out id> or 
<out device>
Device 
Indicator

Output Variable 
Examples

capacitor C V(CAP:1)

I(CAP)

diode D V(D23:1)

I(D23)

voltage-controlled 
voltage source

E V(E14:1)

I(E14)

current-controlled 
current source

F V(F1:1)

I(F1)

voltage-controlled 
current source

G V(G2:1)

I(G2)

current-controlled 
voltage source

H V(HSOURCE:1)

I(HSOURCE)

independent current 
source

I V(IDRIV:+)

I(IDRIV)

inductor L V(L1:1)

I(L1)

resistor R V(RC1:1)

I(RC1)

voltage-controlled 
switch

S V(SWITCH:+)

I(SWITCH)

independent voltage 
source

V V(VSRC:+)

I(VSRC)

current-controlled 
switch

W V(W22:-)

I(W22)



Setting Up Analyses 7-9

Note The 
IGBT device 
type is not 
supported by 
PSpice Basics.
Table 7-5 Element Definitions for 3- or 4-Terminal Devices

Device Type

<out 
id> or 
<out 
device>
Device 
Indicator

<pin id>
Output 
Variable
Examples

GaAs MESFET B D (Drain terminal)

G (Gate terminal)

S (Source terminal)

V(B11:D)

ID(B11)

Junction FET J D (Drain terminal)

G (Gate terminal)

S (Source terminal)

VG(JFET)

I(JFET:G)

MOSFET M B (Bulk, substrate
terminal)

D (Drain terminal)

G (Gate terminal)

S (Source terminal)

VDG(M1)

ID(M1)

bipolar transistor Q B (Base terminal)

C (Collector terminal)

E (Emitter terminal)

S (Source terminal)

V(Q1:B)

I(Q1:C)

IGBT Z C (Collector terminal)

E (Emitter terminal)

G (Gate terminal)

V(Z1:C)

I(Z1:C)

Table 7-6 Element Definitions for Transmission Line 
Devices

Device Type

<out id> or 
<out device>
Device 
Indicator

<z>
Output 
Variable
Examples

transmission
line

T A (Port A)

B (Port B)

V(T32:A+)

I(T32:B-)
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The INOISE, ONOISE, DB(INOISE), and DB(ONOISE) 
output variables are predefined for use with noise (AC swee
analysis.

Table 7-7 Element Definitions for AC Analysis Specific 
Elements

<ac suffix>
Device 
Symbol

Meaning
Output 
Variable
Examples

(none) Magnitude (default) V(V1)

I(V1)

M Magnitude VM(CAP1:1)

IM(CAP1:1)

DB Magnitude in decibels VDB(R1)

P Phase IP(R1)

R Real part VR(R1)

I Imaginary part VI(R1)
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Simulate icon:  
Starting Simulation
Once you have used MicroSim Schematics to enter your circ
design and set up the analyses to be performed, you can st
simulation from Schematics by selecting Simulate from the 
Analysis menu. When you enter and set up your circuit this w
the files needed for simulation are automatically created by 
Schematics and the simulator is started from Schematics.

There may be situations, however, when you want to run PSp
outside of Schematics. You may want to simulate a circuit th
wasn’t created in Schematics, for example, or you may wan
run simulations of multiple circuits in batch mode.

This section includes the following:

Starting Simulation from Schematics, below

Starting Simulation Outside of Schematics on page 7-12

Setting Up Batch Simulations on page 7-12

The Simulation Status Window on page 7-14

Starting Simulation from 
Schematics
Once you have set up the analyses for the circuit, you can s
simulation from Schematics any of the following ways:

• Select Simulate from the Analysis menu

• Press ! 

• Click on the Simulate icon
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Starting Simulation Outside of 
Schematics

To start PSpice outside of Schematics

1 Double-click on the PSpice icon in the MicroSim Program
Group.

2 Select Open from the File menu.

3 Do one of the following:

• Double-click on the circuit file name in the list box. 

• Enter the name of the circuit file to be simulated in th
File Name text box.

Setting Up Batch Simulations
Multiple simulations can be run in batch mode when starting
PSpice directly with circuit file input. You can use batch mod
for example, to run a number of simulations overnight witho
user intervention. There are two ways to do this as describe
below.

Multiple simulation setups within one circuit file

Multiple circuit/simulation descriptions can be concatenated
into a single circuit file and simulated with one invocation of 
PSpice. Each circuit/simulation description in the file must 
begin with a title line and end with a .END statement.

The simulator reads all the circuits in the circuit file and then
processes each one in sequence. The Probe data file and 
simulation output file contain the outputs from each circuit in
the same order as they appeared in the circuit file. The effec
the same as if you had run each circuit separately and then 
concatenated all of the outputs.
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Running simulations with multiple circuit files

You can direct PSpice to simulate multiple circuit files using
one of the following methods.

Method 1

1 Click on the PSpice icon in the MicroSim program group

2 Select Properties from the File menu.

3 Include the following switch in the command line:

/wNO_NOTIFY

This turns off the message that pops up each time a 
simulation is completed.

4 Select Open from the File menu from the PSpice status 
window.

5 Do one of the following:

• Type each file name in the File Name text box separa
by a space.

• Use the combination keystrokes and mouse clicks in t
list box as follows: C+click to select file names one a
a time, and V+click to select groups of files.

Method 2

1 Click on the PSpice icon in the MicroSim program group

2 Select Properties from the File menu.

3 Include the following switch in the command line:

/wNO_NOTIFY

This turns off the message that pops up each time a 
simulation is completed.

4 Update the command line in one of the following ways: 

• Include a list of circuit file names separated by space

• Read a file of run time properties (using the @<file 
name> syntax) which contains a list of circuit file 
names.
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Circuit file names may be fully qualified or contain the wild
card characters * and ?.

The Simulation Status Window
As PSpice performs the circuit simulation, a status window i
displayed so that you can monitor the progress of the simulat
Figure 7-1 shows an example of the PSpice status window.

Figure 7-1 PSpice Status Window

The status window includes the following:

• Title bar
This area at the top of the window identifies the name of t
circuit file currently under simulation, and the name of th
simulation output file where audit trail information will be
written.

• Menus
The menus accessed from the menu bar include items t
control the simulator and customize the window display 
characteristics. These are especially useful when invokin
PSpice directly.

• Simulation progress display
The lower portion of the window displays the progress o
each simulation as it proceeds.



DC Analyses
des 
8

Chapter Overview
This chapter describes how to set up DC analyses and inclu
the following sections:

DC Sweep on page 8-2

Bias Point Detail on page 8-7

Small-Signal DC Transfer on page 8-8

DC Sensitivity on page 8-10
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See Setting Up Analyses on 
page 7-3 for a description of the 
Analysis Setup dialog box.

Figure 8-1 DC Sweep Setup 
Example
DC Sweep

Minimum Requirements to Run a 
DC Sweep Analysis

Minimum circuit design requirements

Minimum software setup requirements

• In the Analysis Setup dialog box, click on the DC Sweep
button. Complete the DC Sweep dialog box as needed.

• If needed, click on the DC Sweep check box in the Analy
Setup dialog box so that it is checked on (enabled).

• Start the simulation as described in Starting Simulation on 
page 7-11.

Note Do not specify a DC sweep and a parametric 
analysis for the same variable.

Table 8-1 DC Sweep Circuit Design Requirements

Swept Variable 
Type

Requirement

voltage source voltage source with a DC specification 
(VDC, for example)

temperature none

current source current source with a DC specification 
(IDC, for example)

model parameter PSpice model (.MODEL)

global parameter global parameter defined with a paramete
block (.PARAM)
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Shortcut: Click on  or 
double-click on the symbol.

The example circuit 
example.sch  is provided with 
the MicroSim software 
installation.
Overview of DC Sweep
The DC sweep analysis causes a DC sweep to be performe
the circuit. DC sweep allows you to sweep a source (voltage
current), a global parameter, a model parameter, or the 
temperature through a range of values. The bias point of the
circuit is calculated for each value of the sweep. This is use
for finding the transfer function of an amplifier, the high and lo
thresholds of a logic gate, and so on.

For the DC sweep analysis specified in Figure 8-1, the volta
source V1 is swept from -0.125 volts to 0.125 volts by steps
0.005. This means that the output has (0.125 + 0.125)/0.005
= 51 lines.

A source with a DC specification (such as VDC or IDC) must 
used if the swept variable is to be a voltage type or current 
source. To set the DC attribute, select Attributes from the Ed
menu.

The default DC value of V1 is overridden during the DC swe
analysis and is made to be the swept value. All of the other 
sources retain their values.

After running the analysis, the simulation output file 
(example.out  for the example.sch  circuit in Figure 8-2) 
contains a table of voltages relating V1, node OUT1, and no
OUT2.

Figure 8-2 Example Schematic example.sch
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To calculate the DC response of an analog circuit, PSpice 
removes time from the circuit. This is done by treating all 
capacitors as open circuits, all inductors as shorts, and usin
only the DC values of voltage and current sources.

In order to solve the circuit equations, PSpice uses an iterat
algorithm using continuous equations.

Nested DC Sweeps
A second sweep variable can be selected once a primary sw
value has been specified in the DC Sweep dialog box. When 
specify a secondary sweep variable, it forms the outer loop 
the analysis. That is, for every increment of the second swe
variable, the first sweep variable is stepped through its entir
range of values.

To set up a nested sweep

1 Click on the Nested Sweep button in the DC Sweep dial
box.

2 Specify a secondary DC sweep in the DC Nested Swee
dialog box.

3 Click on the Enable Nested Sweep check box.

4 Click on Main Sweep to return to the DC Sweep dialog bo
or click on OK to return to the Analysis Setup dialog box
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Figure 8-3 Curve Family 
Example Schematic

Use Mark Current Into Pin in 
MicroSim Schematics on the 
Markers menu to add a current 
marker.

V_VD is the hierarchical name 
for VD created by netlisting the 
schematic. This is the name 
used by Probe.
Curve Families for DC Sweeps
Whenever a nested DC sweep is performed, the entire curv
family is displayed. That is, the nested DC sweep is treated a
single Probe data section (or you can think of it as a single 
PSpice run).

For the circuit shown in Figure 8-3, you could set up a DC 
sweep analysis with an outer sweep of the voltage source V
and an inner sweep of the voltage source VG as listed in 
Table 8-2.

When the DC sweep analysis is run, add a current marker at
drain pin of M1 and display the simulation result in Probe. T
result will look like Figure 8-4.

We can add the load line for a resistor by adding a trace wh
computes the load line from the sweep voltage. Assume that
X axis variable is the sweep voltage V_VD, which runs from
to 5 volts. The expression which will add a trace that is the lo
line for a 50 kohm resistor is:

(5V-V_VD)/50K

This can be useful for determining the bias point for each 
member of a curve family as shown in Figure 8-5. 

Table 8-2 Curve Family Example Setup

Outer Sweep Nested Sweep

Swept Var 
Type

Voltage Source Voltage Source

Sweep Type Linear Linear

Name VD VG

Start Value 0 0

End Value 5 2

Increment 0.1 0.5



8-6 DC Analyses

r 
Figure 8-4 Device Curve Family

Figure 8-5 Operating Point Determination for Each Membe
of the Curve Family
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See Setting Up Analyses on 
page 7-3 for a description of the 
Analysis Setup dialog box.

Also see Save and Load Bias 
Point on page A-2.
Bias Point Detail

Minimum Requirements to Run a 
Bias Point Detail Analysis

Minimum circuit design requirements

None.

Minimum software setup requirements

• Click on the Bias Point Detail check box in the Analysis 
Setup dialog box so that it is checked on (enabled).

• Start the simulation as described in Starting Simulation on 
page 7-11.

Overview of Bias Point Detail
The bias point is calculated for any analysis whether or not 
Bias Point Detail analysis is enabled in the Analysis Setup 
dialog box. However, additional information is reported whe
the Bias Point Detail analysis is enabled.

When Bias Point Detail analysis is not enabled, only node 
voltages are reported to the output file.

When the Bias Point Detail analysis is enabled, the following
information is reported to the output file:

• A list of all analog node voltages

• The currents of all voltage sources and their total power

• A list of the small-signal parameters for all devices

If Bias Point Detail is enabled, you can suppress the reporting
the bias point analog:

1 Select Setup from the Analysis menu.
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See Setting Up Analyses on 
page 7-3 for a description of the 
Analysis Setup dialog box.
2 In the Analysis Setup dialog box, click on Options.

3 In the Yes/No options for the Options dialog box, set 
NOBIAS to Y (for yes).

Small-Signal DC 
Transfer

Minimum Requirements to Run a 
Small-Signal DC Transfer 
Analysis

Minimum circuit design requirements

• The circuit should contain an input source, such as VSR

Minimum software setup requirements

• In the Analysis Setup dialog box, click on the Transfer 
Function button. In the Transfer Function dialog box, 
specify the name of the input source desired. See Output 
Variables on page 7-4 for a description of output variable 
formats.

• If needed, click on the Transfer Function check box in th
Analysis Setup dialog box so that it is checked on (enable

• Start the simulation as described in Starting Simulation on 
page 7-11.
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Overview of Small-Signal DC 
Transfer
The small-signal DC transfer analysis causes the small-sign
transfer function to be calculated by linearizing the circuit 
around the bias point. The small-signal gain, input resistanc
and output resistance are calculated and reported.

To calculate the small-signal gain, input resistance, and outp
resistance, you need to specify an output voltage or current
through a voltage source in the Transfer Function dialog box

For example, entering V(a,b) as the output variable specifie
that the output variable is the output voltage between two ne
a and b. Entering I(VDRIV) as the output variable specifies th
the output variable is the current through a voltage source 
VDRIV.

You also need to specify the input source name in the Trans
Function dialog box. The gain from the input source to the 
output variable is output along with the input and output 
resistances.

For example, if you enter V(OUT2)  as the output variable and V1 
as the input source, the input resistance for V1 is calculated,
output resistance for V(OUT2) is calculated, and the gain fro
V1 to V(OUT2) is calculated. All calculations are reported to
the simulation output file.
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See Setting Up Analyses on 
page 7-3 for a description of the 
Analysis Setup dialog box.

See Output Variables on 
page 7-4 for a description of 
output variables.
DC Sensitivity

Minimum Requirements to Run a 
DC Sensitivity Analysis

Minimum circuit design requirements

None.

Minimum software setup requirements

• In the Analysis Setup dialog box, click on the Sensitivity 
button. In the Sensitivity Analysis dialog box, enter the 
output variable desired.

• If needed, click on the Sensitivity check box in the Analys
Setup dialog box so that it is checked on (enabled).

• Start the simulation as described in Starting Simulation on 
page 7-11.

Overview of DC Sensitivity
DC sensitivity analysis calculates and reports the sensitivity
one node voltage to each device parameter for the following
device types:

• resistors

• independent voltage and current sources

• voltage and current-controlled switches

• diodes

• bipolar transistors

The sensitivity is calculated by linearizing all devices around t
bias point.
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Chapter Overview
This chapter describes how to set up an AC sweep analysis
includes the following sections:

Overview of AC Sweep Analysis on page 9-2

Nonlinear Components in an AC Sweep Analysis on page 9-4

Noise Analysis on page 9-5
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See Setting Up Analyses on 
page 7-3 for a description of the 
Analysis Setup dialog box.

Figure 9-1 AC Sweep Setup 
Example
Overview of AC Sweep 
Analysis

Minimum Requirements to Run 
an AC Sweep Analysis

Minimum circuit design requirements

• An AC source with an AC specification, such as VAC or 
IAC.

Minimum software setup requirements

• In the Analysis Setup dialog box, click on the AC Sweep
button. Complete the AC Sweep and Noise Analysis dial
box as needed.

• If needed, click on the AC Sweep check box in the Analys
Setup dialog box so that it is checked on (enabled).

• Start the simulation as described in Starting Simulation on 
page 7-11.

Overview of AC Sweep
The frequency response analysis calculates the small-signa
response of the circuit, linearized around the bias point, to a
combination of inputs.

Nonlinear devices, such as voltage-controlled or current-
controlled switches, behave in a similar manner. That is, the
are linearized about their bias point value and then a linear 
(small-signal) analysis is performed. In the case of the nonlin
controlled switches, the switch acts as a resistor based upon
controlling input value at the bias point.
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The example circuit 
example.sch  is provided with 
the MicroSim software 
installation.
For the AC sweep analysis specified in Figure 9-1, the 
frequency is swept from 100 kHz to 10 GHz by decades, with
points per decade. Unlike DC sweep, the AC sweep analysi
does not specify an input source. Instead, each independen
source contains its own AC specification for magnitude and 
phase.

In the example circuit in Figure 9-2, V1 has the AC attribute 
equal to 1 volt and a relative phase of 0 degrees by default.
During the AC sweep analysis, the contributions from all 
sources are propagated throughout the circuit and summed a
the nodes. V1 is the only input to an amplifier, so it is the on
source to have a nonzero AC value.

Figure 9-2 Example Schematic example.sch
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Nonlinear Components 
in an AC Sweep Analysis
An AC Sweep analysis is a linear or small-signal analysis. In
order to perform a traditional small-signal analysis of a 
transistor amplifier, for example, you would go through the 
following steps:

1 Compute the DC bias point for the circuit.

2 Compute the transconductances at this bias point.

3 Do linear circuit analysis.

You would generally use a number of simplifying 
approximations. For example, a bipolar transistor in commo
emitter mode would be replaced by a constant transconducta
(collector current proportional to base-emitter voltage), plus 
number of constant impedances.

PSpice performs exactly the same sequence of operations. 
determines partial derivatives for nonlinear devices at the bi
point, and these are then used for small-signal analysis.

Other nonlinear devices are treated in exactly the same way.
example, suppose we have a behavioral modeling block tha
multiplies V(1) by V(2). Multiplication is a nonlinear operation
so AC sweep analysis requires that this block be replaced by
linear equivalent. Unless the bias point is known, however, t
linear equivalent cannot be determined.

Suppose a 2 volt DC source is connected between node 1 a
ground (with suitable dummy resistors). Then, at the bias po
for the circuit, V(1) = 0 volts and V(2) = 2 volts. You can now
replace the multiplier block with an equivalent block that has
fixed gain of 2 so that the output is 2*V(1) + 0*V(2). AC swee
analysis correctly shows the transfer function of the circuit a
having a gain of 2.

Consider another example. Suppose the 2 volt DC source in
above example is replaced with an AC source with amplitude
When the bias point is computed, there are no DC sources in
circuit, so all nodes are at 0 volts at the bias point. Now the lin
equivalent of the multiplier block is a block with gain 0, whic
means that there is no output voltage at the fundamental 
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Output variables are described in 
Output Variables on page 7-4.
frequency. This is exactly how a double-balanced mixer 
behaves (in practice, just a multiplier). Of course, a double-
balanced mixer produces outputs at DC and at twice the inp
frequency, but these terms cannot be seen with a linear, sm
signal analysis.

Noise Analysis
Noise analysis is an AC sweep option that is run when the No
Analysis check box is checked on in the AC Sweep and Noi
Analysis dialog box. Noise analysis calculates noise 
contributions from each resistor and semiconductor device a
performs an RMS sum at a specified output node. This 
calculation is done for all the frequencies specified for the A
sweep analysis.

Output voltage requires that you enter an output variable. I/
V Source specifies the name of an independent voltage or 
current source at which to calculate the equivalent input noi
For example, if you enter V1 as the I/V Source, V1 is the place
at which an equivalent input noise is calculated.

Interval specifies the print interval. For every nth frequency 
where n is the print interval, a detailed table is printed showin
the individual contributions of all the circuit’s noise generato
to the total noise. If no value is specified, then no detailed ta
is printed.

For example, assume that you want to run a noise analysis on
circuit shown in Figure 9-2 on page 9-3. You would enable 
noise analysis by checking the Noise Analysis check box, th
you might enter the following values in the AC Sweep and No
Analysis dialog box:

Output Voltage V(OUT2)

I/V Source V1

Interval 30

This sets node OUT2 as the output node and V1 as the inpu
source). This does not mean that V1 is the noise source. Rathe
V1 is the place at which an equivalent input noise is calculat
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The noises are summed at node OUT2. This result is then 
divided by the gain from V1 to node OUT2 to get the amount
noise which, if injected at V1 into a noiseless circuit, would 
cause the previously calculated amount of noise at node OU
The interval value of 30 results in a detailed table of values 
every 30th frequency.

There are two types of reports from the noise analysis: deta
tables and summary tables. The detailed tables are specifie
the interval value in the Noise Analysis section of the dialog
box. In the preceding example, the value of 30 specifies that
every 30th frequency of the AC analysis, a detailed table is to
reported. These tables are labeled NOISE ANALYSIS in the
simulation output file.

The second type of output reported are summary outputs 
showing the RMS summed noise at node OUT2(ONOISE) a
the equivalent input noise at V1(INOISE).
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Chapter Overview
This chapter describes how to set up a transient analysis an
includes the following sections:

Overview of Transient Analysis on page 10-2

Stimulus Generation on page 10-3

Transient (Time) Response on page 10-14

Internal Time Steps in Transient Analyses on page 10-15

Switching Circuits in Transient Analyses on page 10-16

Plotting Hysteresis Curves on page 10-16

Fourier Components on page 10-18
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See Setting Up Analyses on 
page 7-3 for a description of the 
Analysis Setup dialog box.
Overview of Transient 
Analysis

Minimum Requirements to Run a 
Transient Analysis

Minimum circuit design requirements

Circuit should contain one of the following:

• An independent source with a transient specification (se
Table 10-1)

• An initial condition on a reactive element

• A controlled source that is a function of time

Minimum software setup requirements

• In the Analysis Setup dialog box, click on the Transient 
button. Complete the Transient dialog box as needed.

• If needed, click on the Transient check box in the Analys
Setup dialog box so that it is checked on (enabled).

• Start the simulation as described in Starting Simulation on 
page 7-11.
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See The Stimulus Editor Utility 
on page 10-5 for a description of 
how to use the Stimulus Editor.

Note PSpice Basics
 does not include the 
Stimulus Editor.
Stimulus Generation

Overview of Stimulus 
Generation
Parts which generate stimuli for your circuit can be divided in
two categories:

• stimulus parts whose transient behavior is characterized
graphically using the Stimulus Editor

• stimulus parts whose transient (if applicable) behavior is
characterized by manually defining their attributes within
MicroSim Schematics

Their symbols are summarized in Table 10-1.

Table 10-1 Stimulus Parts Classified by Transient 
Specification

Category Symbol Name Description

graphically
characterized

VSTIM voltage source

ISTIM current source

characterized
by attribute

VSRC
VEXP
VPULSE
VPWL
VPWL_ENH
VPWL_FILE
VSFFM
VSIN

voltage sources

ISRC
IEXP
IPULSE
IPWL
IPWL_ENH
IPWL_FILE
ISFFM
ISIN

current sources
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All of these parts are used by placing instances in your 
schematic and defining their attributes using Attributes on th
Edit menu. Each attribute-characterized stimulus has a disti
set of attributes depending upon the kind of transient behavio
represents. For VPWL_FILE, IPWL_FILE, and FSTIM, a 
separate file contains the stimulus specification.

As an alternative, the Stimulus Editor utility automates the 
process of defining the transient behavior of stimulus device
The Stimulus Editor allows you to create analog stimuli whic
generate sine wave, repeating pulse, exponential pulse, sin
frequency FM, and piecewise linear waveforms. This applies
both part instances placed in your schematic as well as new
stimulus symbols that you might create.

Figure 10-1 Relationship of Stimulus Editor with Schematic
and PSpice

The stimulus specification created using the Stimulus Editor
saved to a file, automatically configured into the schematic, a
associated with the corresponding VSTIM, ISTIM, or 
DIGSTIM part instance or symbol definition.

stimulus
files

input
waveforms

MicroSim
Schematics Stimulus Editor
MicroSim

PSpice
MicroSim
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MicroSim software versions 
without the Stimulus Editor must 
use the characterized-by-
attribute sources listed in 
Table 10-1 on page 10-3.
The Stimulus Editor 
Utility 
The Stimulus Editor is a utility which allows you to quickly se
up and verify the input waveforms for a transient analysis. Y
can create and edit voltage sources and current sources for 
circuit. Graphical feedback allows you to verify the waveform
quickly.

Stimulus Files
The Stimulus Editor produces a file containing the stimuli wi
their transient specification. These stimuli are defined as 
simulator device declarations using the V (voltage source) an
(current source) forms. Since the Stimulus Editor produces th
statements automatically, you will never have to be concern
with their syntax. However, if you are interested in a detailed
description of their syntax, see the descriptions of V and I 
devices in the PSpice Reference Manual.

Configuring Stimulus Files
In the schematic editor, Library and Include Files on the 
Analysis menu allows you to view the list of stimulus files 
pertaining to your current schematic, or to manually add, dele
or change the stimulus file configuration. The Stimulus Libra
Files list box displays all of the currently configured stimulus
files. One file is specified per line. Files can be configured a
either global to the Schematics environment or local to the 
current schematic. Global files are marked with an asterisk (
after the file name.

When starting the Stimulus Editor from Schematics, stimulu
files are automatically configured (added to the list) as local
the current schematic. Otherwise, new stimulus files can be
added to the list by entering the file name in the File Name t
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box and then clicking on the Add Stimulus (local configuratio
or Add Stimulus* (global configuration) button. All other 
commands work as described for model and include files in 
Global and local model files on page 5-36.

Starting the Stimulus Editor
The Stimulus Editor is fully integrated with Schematics and c
be run from either the schematic editor or symbol editor.

You can start the Stimulus Editor by the following methods:

• Double-click on a stimulus instance.

• Select one or more stimulus instances in the schematic 
select Stimulus from the Edit menu.

• Select Edit Stimulus from the Analysis menu.

When you first start the Stimulus Editor, you may need to adj
the scale settings to fit the trace you are going to add. You c
use Axis Settings on the Plot menu or the corresponding tool
button to change the displayed data, the extent of the scroll
region, and the minimum resolution for each of the axes. 
Displayed Data Range parameters determine what portion of
stimulus data set will be presented on the screen. Extent of 
Scrolling Region parameters set the absolute limits on the 
viewable range. Minimum Resolution parameters determine 
smallest usable increment (example: if it is set to 1 msec, th
you cannot add a data point at 1.5 msec).

Defining Stimuli
1 Place stimulus part instances from the symbols VSTIM a

ISTIM.

2 Start the Stimulus Editor as described in Starting the 
Stimulus Editor on page 10-6.

3 From within the Stimulus Editor:

a Edit the transient specification:
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• As indicated by the dialog boxes and prompts, or by

• Direct manipulation of the input waveform display for
analog piecewise linear stimuli.

b Save the edits by selecting Save from the File menu

Example: piecewise linear stimulus

1 Open an existing schematic or start a new one.

2 Select Get New Part from the Draw menu and either brow
the source.slb  Symbol Library file for VSTIM (and select 
it), or type VSTIM in the Part text box.

3 Place the symbol. It looks like a regular voltage source w
a STIMULUS attribute displayed.

4 Double-click on the STIMULUS label and type Vfirst . 
This names the stimulus that we are going to create.

5 If you are working in a new schematic, use Save As from t
File menu to save it. This is necessary since the schema
name is used to create the default stimulus file name.

6 Double-click on the VSTIM symbol. This starts the 
Stimulus Editor and displays the New Stimulus dialog bo
You can see that the stimulus already has the name of Vf

7 Select PWL in the dialog box and click on OK. The curso
looks like a pencil. The message in the status bar at the
bottom of the screen lets you know that you are in the 
process of adding new data points to the stimulus. The l
end of the bottom status bar displays the current coordina
of the cursor.

8 Move the cursor to (200ns, 1) and click the left mouse 
button. This adds the point. Notice that there is 
automatically a point at (0,0). Ignore it for now and continu
to add a couple more points to the right of the current on

9 Click-right to stop adding points.

10 Select Save from the File menu.

If you make a mistake or want to make any changes, reshape
trace by dragging any of the handles to a new location. The
dragged handle cannot pass any other defined data point.
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This example creates a 10 K sin 
wave with the amplitude 
parameterized so that it can be 
swept during a simulation.
To delete a point, click on its handle and press X. 

To add additional points, either select Add Point from the Ed
menu, press A+A, or click on the Add Point toolbar button.

At this point you can return to Schematics, edit the current 
stimulus, or go on to create another.

Example: sine wave sweep

1 Open an existing schematic or start a new one.

2 Place a VSTIM symbol on your schematic.

3 To name the stimulus, double-click on the STIMULUS 
attribute and type Vsin .

4 Double-click on the VSTIM symbol to start the Stimulus 
Editor.

5 Define the stimulus parameter for amplitude:

a Select Cancel while in the New Stimulus dialog. 

b Select Parameters from the Tools menu.

c Enter AMP=1 in the Definition text box, and click OK.

d Select New from the Stimulus menu or click on the Ne
Stimulus button in the toolbar.

e Give the stimulus the name of Vsin.

f Select SIN as the type of stimulus to be created, and
click OK.

6 Define the other stimulus properties:

a Enter 0 for Offset Value.

b Enter {AMP}  for Amplitude. The curly braces are 
required. They indicate that the expression needs to
evaluated at simulation time.

c Enter 10k  for Frequency and click on OK.

d Select Save from the File menu.

7 Within Schematics, place and define the PARAM symbo

a Select Get New Part from the Draw menu.
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b Either browse special.slb  for the PARAM symbol or 
type in the name.

c Place the symbol on your schematic and double-click 
it to edit the attributes.

d Set the value of the NAME1 attribute to AMP (no curl
braces)

e Set the value of the VALUE1 attribute to 1.

8 Set up the parametric sweep and other analyses:

a Select Setup from the Analysis menu, and click on th
Parametric button.

b Select Global Parameter in the Swept Var. Type fram

c Select Linear in the Sweep type frame.

d Enter AMP in the Name text box.

e Specify values for the Start Value, End Value, and 
Increment text boxes.

f You can now set up your usual Transient, AC, or DC
analysis and run the simulation.

Creating New Stimulus Symbols
1 Use the symbol editor to edit or create a symbol with the

following attributes:

2 Select Stimulus from the Edit menu. Schematics search
the configured list of global stimulus files. If you are 
creating a new stimulus symbol and the stimulus is not 
found, you are prompted for the name of the stimulus file
which the new definition should be saved.

STIMTYPE Type of stimulus; valid values is 
ANALOG. If this attribute is 
nonexistent, the stimulus is assumed t
be ANALOG.

STIMULUS Name of the stimulus model.
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PWL stimuli are a little different 
since they are a series of time/
value pairs.

This provides a fast way to scale 
a PWL stimulus.
3 From within the Stimulus Editor, edit the transient 
specification as indicated by the dialogs and prompts, or
direct manipulation of the input waveform display for 
analog piecewise linear stimuli. 

4 Select Save from the File menu. 

Editing a Stimulus

To edit an existing stimulus

1 Start the Stimulus Editor and select Get from the Stimulu
menu.

2 Double-click on the trace name. This opens the Stimulus
Attributes dialog box where you can modify the attributes 
the stimulus directly and immediately see the effect of th
changes.

To edit a PWL stimulus

1 Double click on the trace name. This displays the handle
for each defined data point.

2 Click on any handle to select it. To reshape the trace, dra
to a new location. To delete the data point, press X.

3 To add additional data points, either select Add from the
Edit menu or click on the Add Point icon. 

4 Right-click to end adding new points.

To select a time and value scale factor for PWL 
stimuli

1 Select the PWL trace by clicking on its name.

2 Select Attributes from the Edit menu or click on the 
corresponding toolbar button.
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Deleting and Removing Traces
To delete a trace from the displayed screen, select the trace n
by clicking on its name, then press X. This will only erase the 
display of the trace, not delete it from your file. The trace is s
available by selecting Get from the Stimulus menu.

To remove a trace from a file, select Remove from the Stimu
menu. Once a trace is removed, it is no longer retrievable. 
Delete traces with caution.

Manual Stimulus Configuration
Stimuli can be characterized by manually starting the Stimu
Editor and saving their specifications to a file. These stimulu
specifications can then be associated to stimulus instances 
your schematic or to stimulus symbols in the symbol library.
The procedure is described here.

To manually configure a stimulus

1 Start the Stimulus Editor by double-clicking on the Stimulu
Editor icon in the MicroSim program group.

2 Open a stimulus file using Open on the File menu. If the f
is not found in your current library search path, you are 
prompted for a new file name.

3 Create one or more stimuli to be used in your schematic. 
each stimulus:

a Name it whatever you want. This name will be used 
associate the stimulus specification to the stimulus 
instance in your schematic, or to the symbol in the 
symbol library.

b Provide the transient specification.

c Select Save from the File menu.
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4 In the schematic editor, configure the Stimulus Editor’s 
output file into your schematic:

a Select Library and Include Files from the Analysis 
menu.

b Enter the file name specified in step 2.

c If the stimulus specifications are for local use in the 
current schematic, click on the Add Stimulus (or Add
Include) button. For global use by a symbol in the 
Symbol Library or by any schematic, use Add 
Stimulus* (or Add Include*) instead.

d Click on OK.

5 Modify either the stimulus instances in the schematic or 
symbols in the symbol library to reference the new stimul
specification.

6 Associate the transient stimulus specification to a stimul
instance:

a Place a stimulus part in your schematic from the symb
set: VSTIM, ISTIM, and DIGSTIM.

b Click on the VSTIM, ISTIM, or DIGSTIM instance.

c Select Attributes from the Edit menu.

d Click on the STIMULUS= attribute, type in the name o
the stimulus, and click on Save Attr.

e Complete specification of any VSTIM or ISTIM 
instances by selecting Attributes from the Edit menu
and editing their DC and AC attributes.

Click on the DC= attribute, type its value in the Value
text box, and click on Save Attr.

Click on the AC= attribute, type its value in the Value
text box, and click on Save Attr.

Click on OK to return to the schematic.

7 To change stimulus references globally for a symbol:

a Select Edit Library from the File menu to start the 
symbol editor.
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See Chapter 4,Creating 
Symbols, for a description of how 
to create and edit symbols.

See Stimulus Generation on 
page 10-3 for a description of the 
Stimulus Editor.
b Create or change a symbol definition, making sure to
define the following attributes:

Using the VSTIM and ISTIM 
Sources
VSTIM and ISTIM source symbols are used to define voltag
and current sources, respectively, where the transient 
specification is graphically defined using the Stimulus Editor

To use the VSTIM or ISTIM source to define the 
transient stimulus behavior

1 Place the VSTIM or ISTIM source symbol in your 
schematic.

2 Double-click on the source instance to start the Stimulus
Editor. When you are asked whether you want to edit the
named stimulus, click on OK.

3 Fill in the transient specification according to the dialogs
and prompts. Piecewise linear stimuli can be specified b
direct manipulation of the input waveform display.

PART Symbol name. It is good practice to 
have the symbol name match the 
STIMULUS name.

STIMULUS Stimulus name as defined in the 
Stimulus Editor.
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Figure 10-2 Transient 
Analysis Setup for example.sch

The example circuit 
example.sch  is provided with 
the MicroSim software 
installation.
Transient (Time) 
Response
The Transient response analysis causes the response of the
circuit to be calculated from TIME = 0 to a specified time. A 
transient analysis specification is shown for the circuit 
example.sch  in Figure 10-2. (Example.sch  is shown in 
Figure 10-3.) The analysis is to span the time interval from 0
1000 nanoseconds and values should be reported to the 
simulation output file every 20 nanoseconds.

During a transient analysis, any or all of the independent sour
may have time-varying values. In example.sch , the only source 
which has a time-varying value is V1 (VSIN part) with 
attributes:

VOFF = 0v
VAMPL = 0.1v
FREQ = 5Meg

V1’s value varies as a 5 MHz sine wave with an offset voltag
of 0 volts and a peak amplitude of 0.1 volts.

Figure 10-3 Example Schematic example.sch

The transient analysis does its own calculation of a bias poin
start with, using the same technique as described for DC swe
This is necessary because the initial values of the sources ca
different from their DC values. If you want to report the sma
signal parameters for the transient bias point, you should use
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Transient command and enable Detailed Bias Point. Otherw
if all you want is the result of the transient run itself, you shou
only enable the Transient command.

In the simulation output file example.out , the bias-point report 
for the transient bias point is labeled INITIAL TRANSIENT 
SOLUTION. 

Internal Time Steps in 
Transient Analyses
During analog analysis, PSpice maintains an internal time s
which is continuously adjusted to maintain accuracy while n
performing unnecessary steps. During periods of inactivity, t
internal time step is increased. During active regions, it is 
decreased. The maximum internal step size can be controlle
specifying so in the Step Ceiling text box in the Transient dialo
PSpice will never exceed either the step ceiling value or two
percent of the total transient run time, whichever is less.

The internal time steps used may not correspond to the time
steps at which information has been requested to be reporte
The values at the print time steps are obtained by 2nd-order 
polynomial interpolation from values at the internal steps.
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This technique is described in:

V. Bello, “Computer 
Program Adds SPICE to 
Switching-Regulator 
Analysis,” Electronic 
Design, March 5, 1981.
Switching Circuits in 
Transient Analyses
Running transient analysis on switching circuits can lead to lo
run times. PSpice must keep the internal time step short 
compared to the switching period, but the circuit’s response
extends over many switching cycles.

One method of avoiding this problem is to transform the 
switching circuit into an equivalent circuit without switching. 
The equivalent circuit represents a sort of quasi steady-state
the actual circuit and can correctly model the actual circuit’s
response as long as the inputs do not change too fast.

Plotting Hysteresis 
Curves
Transient analysis can be used to look at a circuit’s hysteres
Consider, for instance, the circuit shown in Figure 10-4 (netl
in Figure 10-5).

Figure 10-4 ECL Compatible Schmitt Trigger



Plotting Hysteresis Curves 10-17

use 
 
n 

ne 

le 
e 
et 

r 
e 
st 
The QSTD model is defined as:

.MODEL QSTD NPN( is=1e-16 bf=50 br=0.1 rb=50 rc=10 
tf=.12ns tr=5ns
+ cje=.4pF pe=.8 me=.4 cjc=.5pF pc=.8 mc=.333 ccs=1pF 

va=50)

Instead of using the DC sweep to look at the hysteresis, we 
the transient analysis, (Print Step = .01ms and Final Time =
2ms) sweeping VIN from -1.8 volts to -1.0 volts and back dow
to -1.8 volts, very slowly. This has two advantages:

• it avoids convergence problems

• it covers both the upward and downward transitions in o
analysis

After the simulation, when we are in Probe, the X axis variab
is initially set to be Time. By selecting X Axis Settings from th
Plot menu and clicking on the Axis Variable button, we can s
the X axis variable to be V(1). Then we can use Add on the 
Trace menu to display V(7), and change the X axis to a use
defined data range from -1.8V to -1.0V (X Axis Settings on th
Plot menu). This plots the output of the Schmitt trigger again
its input, which is what we want. The result looks similar to 
Figure 10-6.

Figure 10-5 Netlist for Schmitt Trigger Circuit

* Schematics Netlist

R_RIN 1 2 50
R_RC1 0 3 50
R_R1 3 5 185
R_R2 5 8 760
R_RC2 0 6 100
R_RE 4 8 260
R_RTH2 7 0 85
C_CLOAD 0 7 5PF
V_VEE 8 0 dc -5
V_VIN 1 0
+PWL 0 -8 1MS -1.0V 2MS -1.8V
R_RTH1 8 7 125
Q_Q1 3 2 4 QSTD
Q_Q2 6 5 4 QSTD
Q_Q3 0 6 7 QSTD
Q_Q4 0 6 7 QSTD
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Figure 10-6 Hysteresis Curve Example: Schmitt Trigger

Fourier Components
The Fourier analysis is enabled through the transient analys
setup dialog box. Fourier analysis calculates the DC and Fou
components of the result of a transient analysis. By default, 
1st through 9th components are computed, however, more can
specified.

You must do a transient analysis in order to do a Fourier 
analysis. The sampling interval used during the Fourier 
transform is equal to the print step specified for the transien
analysis.

When selecting Fourier to run a harmonic decomposition 
analysis on a transient waveform, only a portion of the 
waveform is used. Using Probe, a Fast Fourier Transform (FF
of the complete waveform can be calculated and its spectru
displayed.

In the example Fourier analysis specification shown in 
Figure 10-2 on page 10-14, the voltage waveform at node OU
from the transient analysis is to be used and the fundament
frequency is to be 1 megahertz for the harmonic decompositi
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The period of fundamental frequency is 1 microsecond (inve
of the fundamental frequency). Only the last 1 microsecond 
the transient analysis is used, and that portion is assumed t
repeat indefinitely. Since V1’s sine wave does indeed repea
every 1 microsecond, this is sufficient. In general, however, y
must make sure that the fundamental Fourier period fits the
waveform in the transient analysis.
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Chapter Overview
This chapter describes how to set up parametric and tempera
analyses. Parametric and temperature are both simple multi
analysis types.

This chapter includes the following sections:

Parametric Analysis on page 11-2

Temperature Analysis on page 11-11
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See Setting Up Analyses on 
page 7-3 for a description of the 
Analysis Setup dialog box.
Parametric Analysis

Minimum Requirements to Run a 
Parametric Analysis

Minimum circuit design requirements

• Set up the circuit according to the swept variable type as
listed in Table 11-1.

• Set up a DC sweep, AC sweep, or transient analysis.

Minimum software setup requirements

• In the Analysis Setup dialog box, click on the Parametric
button. Complete the Parametric dialog box as needed.

• If needed, click on the Parametric check box in the Analy
Setup dialog box so that it is checked on (enabled).

• Start the simulation as described in Starting Simulation on 
page 7-11.

Note Do not specify a DC sweep and a parametric 
analysis for the same variable.

Table 11-1 Parametric Analysis Circuit Design 
Requirements

Swept Variable 
Type

Requirement

voltage source voltage source with a DC specification 
(VDC, for example)

temperature none

current source current source with a DC specification 
(IDC, for example)

model parameter PSpice model

global parameter global parameter defined with a paramete
block (PARAM)
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Overview of Parametric Analysis
Parametric analysis performs multiple iterations of a specifie
standard analysis while varying a global parameter, model 
parameter, component value, or operational temperature. T
effect is the same as running the circuit several times, once
each value of the swept variable.

See Parametric Analysis on page 2-22 for a description of how 
to set up a parametric analysis.

Example: RLC Filter
This example shows how to perform a parametric sweep an
how to analyze the results with performance analysis.

With performance analysis, values can be derived from a se
of simulator runs and plotted versus a parameter that varies
between those runs. For this example, the derived values w
wish to plot are the overshoot and the rise time versus the 
damping resistance of the filter. Deriving these values by ha
is quite involved and letting the simulator do the work for us 
an appealing alternative.

Entering the schematic

The schematic for the RLC filter (rlcfilt.sch ) is shown in 
Figure 11-1.

Figure 11-1 Passive Filter Schematic
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Shortcut: Click on  or press 
!

This series of PSpice runs varies the value of resistor R1 fro
0.5 to 1.5 ohms in 0.1 ohm steps. Since the time-constant of
circuit is about one second, we perform a transient analysis
approximately 20 seconds. 

Create the circuit in MicroSim Schematics by placing a 
piecewise linear independent current source (IPWL from 
source.slb ). Set the current source attributes as follows:

AC = 1a
T1 = 0s
I1 = 0a
T2 = 10ms
I2 = 0a
T3 = 10.1ms
I3 = 1a

Place an instance of a resistor and set its VALUE attribute to 
expression, {R}. To define R as a global parameter, place a
PARAM pseudocomponent defining its NAME1 attribute to R
and VALUE1 attribute to 0.5. Place an inductor and set its va
to 1H, place a capacitor and set its value to 1, and place an
analog ground symbol (AGND from port.slb ). Wire the 
schematic symbols together as shown in Figure 11-1.

Running the simulation

Run PSpice with the following analyses enabled:

After setting up the analyses, start the simulation by selectin
Simulate from the Analysis menu.

transient print step: 100ms
final time: 20s

parametric swept var. type: global parameter 
sweep type: linear
name: R
start value: 0.5
end value: 1.5
increment: 0.1
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To access the Add Traces dialog 
box, select Traces from the Add 
menu in Probe.

Troubleshooting tip

More than one PSpice run or 
data section is required for 
performance analysis because 
one data value is derived for 
each waveform in a related set of 
waveforms. A trace of the 
derived values cannot be 
displayed if there is only one run 
or data section because at least 
two data points are required to 
produce a trace.

However, you can use Eval Goal 
Functions on the Trace menu in 
Probe to evaluate a goal function 
on a single waveform, thus 
producing a single data point 
result.

The genrise and overshoot goal 
functions are contained in the file 
msim.prb  in the MSIM directory.
Using performance analysis to plot overshoot 
and rise time

After performing the PSpice simulation that creates the data 
called rlcfilt.dat , you can run Probe to compute the specifie
performance analysis goal functions.

When Probe is started, you are presented with a list of all th
sections or runs in the Probe data file produced by PSpice. 
use the data from every run, select All and click on OK in th
Available Selections dialog box. In the case of Figure 11-2, t
trace I(L1) from the ninth section was added by specifying th
following in the Add Traces dialog box:

I(L1)@9

Figure 11-2 Current of L1 when R1 is 1.5 Ohms

To run performance analysis:

1 Select X Axis Setting from the Plot menu in Probe.

2 Click on the Performance Analysis check box so that it is
checked on (enabled), then click on OK.

Probe resets the X axis variable for the graph to be the param
that changed between PSpice runs. In the example, this is th
parameter.

To see the rise time for the current through the inductor L1, 
select the Add from the Trace menu and then enter:

genrise( I(L1) )
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In Figure 11-3, we can see how the rise time decreases as t
damping resistance increases for the filter.

Another Y axis can be added to the plot for the overshoot of 
current through L1 by selecting Add Y Axis from the Plot men
The Y axis is immediately added. We now select Add from t
Trace menu and enter:

overshoot( I(L1) )

Figure 11-3 shows how the overshoot increases with increas
resistance.

Figure 11-3 Rise Time and Overshoot vs. Damping Resistan

Now we can use the multiple X axes feature to view the origin
waveform family for inductor L1 current along with the derive
rise time and overshoot data. We must first add a new plot b
selecting Add Plot from the Plot menu. To set this plot’s X ax
to a unique scale, select Unsync Plot from the Plot menu. Yo
notice that the new plot’s X axis is now labeled with range a
variable information. However, it is still set for Performance 
Analysis (with resistance R as the X axis label). We can tog
off the Performance Analysis feature by selecting X Axis 
Settings from the Plot menu and disabling the Performance 
Analysis check box. This affects only the current plot. (The p
marked with SEL>> is the current plot.)

Now we can add the trace for I(L1) as we’ve done before (A
on the Trace menu), changing the Y axis range to 0A - 1.5A 
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Axis Settings on the Plot menu), and the X axis range to 0s - 
(X Axis Settings on the Plot menu). This produces the displa
shown in Figure 11-4.

Figure 11-4 Inductor Waveform Data Viewed with Derived 
Rise Time and Overshoot Data
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Figure 11-5 RLC Filter 
Example Circuit
Example: Frequency Response 
vs. Arbitrary Parameter
Engineers often want to see a plot of the linear response of 
circuit at a specific frequency as one of the circuit paramete
varies (such as the output of a band pass filter at its center 
frequency vs. an inductor value). In this example, the value o
nonlinear capacitance is measured using a 10 kHz AC signal
plotted vs. its bias voltage. The capacitance is in parallel wit
resistor, so a Probe expression is used to calculate the 
capacitance from the complex admittance of the R-C pair.

This technique for measuring branch capacitances works we
both simple and complex circuits.

Setting up the circuit

Enter the circuit in Schematics as shown in Figure 11-5

To create the capacitor model in the schematic editor:

1 Place a Cbreak symbol.

2 Select it so that it is highlighted.

3 Select Model from the Edit menu.

4 Select Edit Instance Model Text. Enter the following:

.model Cnln CAP(C=1 VC1=-0.01 VC2=0.05)

Set up the circuit for a parametric AC analysis (sweep Vbias
and run PSpice. Include only the frequency of interest in the A
sweep.

Displaying results in Probe

Use Probe to display the capacitance calculated at the freque
of interest vs. the stepped parameter.

After analyzing the circuit with PSpice:

1 Run Probe.

2 Load all AC analysis sections.

3 Select Add from the Trace menu.
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IMG(-I(Vin)/V(1,0))/(2*3.1416*Frequency)

Or add the expression:

CvF(-I(Vin)/V(1,0))

Where CvF is a macro which measures the effective capacita
in a complex conductance. Macros are defined using Macro
the Trace menu. The CvF macro should be defined as:

CvF(G)= IMG(G)/(2*3.1416*Frequency)

Note that -I(Vin)/V(1) is the complex admittance of the R-C 
branch; the minus sign is required for correct polarity.

To use performance analysis to plot capacitance 
vs. bias voltage

1 In Probe, select Performance Analysis from the Trace me

2 Click on Wizard.

3 Click on Next>.

4 Click on YatX in the Choose a Goal Function list, and the
click on Next>.

5 In the Name of Trace text box, type the following:

CvF(-I(Vin)/V(1))

6 In the X value text box, type 10K.

7 Click on Next>. The wizard displays the gain trace for th
first run to text the goal function (YatX).

8 Click on Finish. The resultant Probe plot is shown in 
Figure 11-6.
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Figure 11-6 Probe Plot of Capacitance vs. Bias Voltage
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See Setting Up Analyses on 
page 7-3 for a description of the 
Analysis Setup dialog box.

Running multiple analyses for 
different temperatures can also 
be achieved using parametric 
analysis (see Parametric 
Analysis on page 11-2). With 
parametric analysis, the 
temperatures can be specified 
either by list, or by range and 
increments within the range.
Temperature Analysis

Minimum Requirements to Run a 
Temperature Analysis

Minimum circuit design requirements

None.

Minimum software setup requirements

• In the Analysis Setup dialog box, click on the Temperatu
button. Specify the temperature or list of temperatures in 
Temperature Analysis dialog box.

• If needed, click on the Temperature check box in the 
Analysis Setup dialog box so that it is checked on (enable

• Start the simulation as described in Starting Simulation on 
page 7-11.

Overview of Temperature 
Analysis
When a temperature analysis is run, PSpice reruns standard
analyses enabled in the Analysis Setup dialog box at differe
temperatures.

Temperature analysis allows zero or more temperatures to b
specified. If no temperature is specified, the circuit is run at 
27°C. If more than one temperature is listed, the effect is the
same as running the simulation several times, once for each
temperature in the list.

Setting the temperature to a value other than the default res
in recalculating the values of temperature-dependent devices
example.sch  (see Figure 11-7), the temperature for all of the
analyses is set to 35°C. The values for resistors RC1 and R
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The example circuit 
example.sch  is provided with 
the MicroSim software 
installation.
are recomputed based upon the CRES model which has 
parameters TC1 and TC2 reflecting linear and quadratic 
temperature dependencies.

Likewise, the Q3 and Q4 device values are recomputed usin
the Q2N2222 model which also has temperature-dependen
parameters. In the simulation output file, these recomputed 
device values are reported in the section labeled 
TEMPERATURE ADJUSTED VALUES.

Figure 11-7 Example Schematic example.sch
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Chapter Overview
This chapter describes how to set up Monte Carlo and 
sensitivity/worst-case analyses and includes the following 
sections:

Statistical Analyses on page 12-2

Monte Carlo Analysis on page 12-7

Worst-Case Analysis on page 12-21
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Generating statistical results 
for Probe

As the number of Monte Carlo or 
worst-case runs increase, 
simulation takes longer and the 
Probe data file gets larger. Large 
Probe data files may be slow to 
open and slow to draw traces.

One way to avoid this problem is 
to set up an overnight batch job 
to run the simulation and execute 
Probe commands. You can even 
set up the batch job to produce a 
series of plots on paper which 
are ready for you in the morning.
Statistical Analyses
Monte Carlo and sensitivity/worst-case are statistical analys
This section describes information common to both types of
analyses.

See Monte Carlo Analysis on page 12-7 for information specific 
to Monte Carlo analyses, and see Worst-Case Analysis on 
page 12-21 for information specific to sensitivity/worst-case 
analyses.

Overview of Statistical Analyses
The Monte Carlo and worst-case analyses vary the lot or dev
tolerances of devices between multiple runs of an analysis (D
AC, or transient). Before running the analysis, you must set 
the model and/or lot tolerances of the model parameter to b
investigated.

A Monte Carlo analysis causes a Monte Carlo (statistical) 
analysis of the circuit to be performed.

A worst-case analysis causes a sensitivity and worst-case 
analysis of the circuit to be performed.

Sensitivity/worst-case analyses are different from Monte Ca
analysis in that they compute the parameters using the 
sensitivity data rather than random numbers.

You can run either a Monte Carlo or a worst-case analysis, 
you cannot run both at the same time. Multiple runs of the 
selected analysis are done while parameters are varied. You
select only one analysis type (AC, DC, or transient) per run. T
analysis selected is repeated in subsequent passes of the 
analysis.
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For information about 
performance analysis, see 
Example: RLC Filter on 
page 11-3.

For information about 
histograms, see Creating 
histograms on page 12-17.
Output Control for Statistical 
Analyses
Monte Carlo and sensitivity/worst-case analyses can genera
the following types of reports:

• Model parameter values used for each run (that is, the val
with tolerances applied).

• Waveforms from each run, as a function of specifying da
collection, or by specifying output variables in the analys
set up.

• A summary of all the runs using a collating function.

Output is saved to the Probe data file for use by the Probe 
graphical waveform analyzer. For Monte Carlo analyses, Pro
offers a special facility through the performance analysis feat
to produce histograms of derived data.

Model Parameter Values Reports
The List option in the MC Options section of the Monte Carl
or Worst Case dialog box produces a list of the model 
parameters actually used for each run.

This list is written to the simulation output file at the beginnin
of the run and contains the parameters for each device, as 
opposed to the parameters for each .MODEL statement. Thi
because devices can have different parameter values when u
a model statement containing a DEV tolerance.

Note that for medium and large circuits, the List option can 
produce a large output file.
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In excess of about 10 runs, the 
Probe display tends to become 
more of a band than a set of 
individual waveforms. This can 
be useful for seeing the typical 
spread for a particular output 
variable. As the number of runs 
becomes larger, the spread 
more closely approximates the 
actual worst-case limits for the 
circuit.
Waveform Reports
For Monte Carlo analyses, there are four variations of the out
which can be specified in the Output section of the Monte Ca
or Worst Case dialog. These options are:

The * indicates that you can specify runs in the Value text b

Values for the output variables specified in the selected analy
are saved to the simulation output file and Probe data file. N
that even a modest number of runs can produce large outpu
files.

Collating Functions
You may want to compress the results of Monte Carlo and 
worst-case analyses further. Using the collating function 
specified in the Function section of the Monte Carlo or Wors
Case dialog box, each run can be represented by a single 
number. A table of deviations per run is reported in the 
simulation output file.

Collating functions are listed in Table 12-1.

All Forces all output to be generated (includin
nominal run).

First* Generates output only during the first n 
runs.

Every* Generates output for every nth run.

Runs* Does specified analysis and generates 
outputs only for the listed runs. Up to 25 
values can be specified in the list.

Table 12-1 Collating Functions Used in Statistical Analyse

Function Description

YMAX Find the greatest difference in each waveform 
from the nominal

MAX Find the maximum value of each waveform
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MIN Find the minimum value of each waveform

RISE_EDGE Find the first occurrence of the waveform 
crossing above a specified threshold value

FALL_EDGE Find the first occurrence of the waveform 
crossing below a specified threshold value

Table 12-1 Collating Functions Used in Statistical Analyse

Function Description
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Refer to Temperature Effects on 
Monte Carlo Analysis in the 
Application Notes manual for 
more information on this topic.

The example circuit 
example.sch  is provided with 
the MicroSim software 
installation.
Temperature Considerations in 
Statistical Analyses
The statistical analyses perform multiple runs, as does the 
temperature analysis. Conceptually, the Monte Carlo and wo
case loops are inside the temperature loop. However, since 
temperature and tolerances affect the model parameters, on
quickly gets into detailed questions about how the two intera
Therefore, we recommend not enabling temperature analys
when using the Monte Carlo or worst-case analyses.

Also, it will not work to sweep the temperature in a DC swee
analysis while performing one of these statistical analyses, o
put tolerances on temperature coefficients. You will notice in
example.sch  how the temperature value is fixed at 35°C.

Figure 12-1 Example Schematic example.sch
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TC1 is the linear temperature 
coefficient. TC2 is the quadratic 
temperature coefficient.

Figure 12-2 Monte Carlo 
Analysis Setup for example.sch
Monte Carlo Analysis
The Monte Carlo analysis computes the circuit response to 
changes in component values by randomly varying all of the
device model parameters for which a tolerance is specified. T
provides statistical data on the impact of a device paramete
variance.

With Monte Carlo analysis model parameters are given 
tolerances, and multiple analyses (DC, AC, or transient) are 
using these tolerances. A typical application of Monte Carlo
analysis is predicting yields on production runs of a circuit.

For example.sch  in Figure 12-1 on page 12-6, effects due to 
variances in resistors RC1 and RC2 values can be analyzed
assigning a model description to these resistors that include
5% device tolerance on the multiplier parameter R. Then, yo
can run a Monte Carlo analysis that runs a DC analysis first w
the nominal R multiplier value for RC1 and RC2, then the 
specified number of additional runs with the R multiplier varie
independently for RC1 and RC2 within 5% tolerance.

To modify example.sch and set up simulation

1 Replace RC1 and RC2 with RBREAK symbols, setting 
attribute values to match the resistors that are being repla
(VALUE=10k) and reference designators to match previo
names.

2 Select Model from the Edit menu, then select Edit Instan
Model. Create the model CRES as follows:

.MODEL CRES RES( R=1 DEV=5% TC1=0.02 TC2=0.0045 )

By default, MicroSim Schematics saves the definition to t
model file example.lib  and automatically configures the 
file for local use with the current schematic.

3 Click on the resistor instance. Select Model from the Edi
menu, then select Change Model Reference to change t
model reference to CRES.

4 Set up a new Monte Carlo analysis as shown in Figure 12
The analysis specification instructs PSpice to do one 
nominal run and four Monte Carlo runs, saving the DC 
analysis output from those five runs.
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PSpice starts as usual by running all of the analyses enabled in
the Analysis Setup dialog with all parameters set to their 
nominal values. However, with Monte Carlo enabled, the DC
sweep analysis results are saved for later reference and 
comparison.

After the nominal analyses are finished, more of the specifie
analysis runs are performed (DC sweep in this example). 
Subsequent runs use the same analysis specification as the
nominal with one major exception. Instead of using the 
nominal parameter values, the tolerances are applied to set
new parameter values and thus, new component values.

The summary report generated in this example specifies that
waveform generated from V(OUT1, OUT2) should be the 
subject of the collating function YMAX. In each of the last fou
runs, the new V(OUT1, OUT2) waveform is compared to the
nominal V(OUT1, OUT2) waveform for the first run, 
calculating the maximum deviation in the Y direction (YMAX
collating function). The deviations are printed in order of size
along with their run number (see Figure 12-3).

With the List option enabled, a report is also generated show
the parameter value used for each device in each run. In this 
(see Figure 12-4), run 3 exhibits the highest deviation.

Figure 12-3 Summary of Monte Carlo Runs for example.sc
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Probe offers a facility to generate 
histograms of data derived from 
Monte Carlo waveform families 
through the performance 
analysis feature.

For information about 
performance analysis, see 
Example: RLC Filter on 
page 11-3.

For information about 
histograms, see Creating 
histograms on page 12-17.
There is a trade-off in choosing the number of Monte Carlo ru
More runs provide better statistics, but take proportionally mo
computer time. The amount of computer time scales directly
with the number of runs: 20 transient analyses take 20 times
long as one transient analysis. During Monte Carlo runs, the
PSpice status display includes a line showing the run numbe
and the total number of runs to be done. This gives an idea 
how far the program has progressed.

Figure 12-4 Parameter Values for Monte Carlo Pass 3
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Tutorial: Monte Carlo Analysis of 
a Pressure Sensor
In this tutorial, the Monte Carlo analysis features provided in
Schematics and PSpice are demonstrated for a pressure se
circuit using a pressure-dependent resistor bridge. We will 
investigate how the performance of the circuit is affected by
manufacturing tolerances.

Drawing the schematic

The bridge is constructed according to the diagram shown in
Figure 12-5. Both V1 and Meter are generic voltage sources
(Get New Part VSRC on the Draw menu).

The remaining parts are resistors (Get New Part R on the D
menu). To rotate parts, use C+R while placing. To move 
values and/or reference designators, click on the value or 
reference designator to select it, then hold the mouse button
down and drag it to the desired location; release the mouse
button to place.

To specify values for the resistors, double-click on the curre
value (the default is 1K) and type the new value in the dialog
provided. The value which is given for R3 (example: 
{1k*(1+P*Pcoeff/Pnom)}, where Pcoeff=-0.06, P=0 and is 
swept, and Pnom=1.0) is an expression that represents line
dependence of resistance on pressure.    

Figure 12-5 Pressure Sensor Circuit
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Shortcut: Click on  or press 
C G
To set the value of the DC attribute on the V1 source, doubl
click on the V1 source, then double-click on the DC= line in th
Edit Attributes dialog, type 1.35v  in the Value text box, and 
click on the Save Attr button (or press J) to accept the 
changes. To make the value of the DC attribute (example: 1.3
visible on the schematic, click on the Change Display button
and select the Value radio button in the Display box. Click o
OK to accept the change. Click on OK to end the dialog and
return to the schematic. The Meter source has no DC value s
it is used only to measure current. The analog ground symbo
placed by using Get New Part on the Draw menu to place th
AGND symbol.

Setting up the parameters

To set up the parameters Pcoeff, P, and Pnom, place a PAR
symbol on the schematic (using Get New Part on the Draw 
menu). Double-click on the PARAM symbol, then double-clic
on each of the NAMEn, VALUEn pairs (where n=1, 2, 3) to 
define the parameters and their values. 

For example, double-click on NAME1 and type Pcoeff  in the 
Value text box; press J or click on the Save Attr button to 
accept the changes. Then, double-click on VALUE1 and typ-

0.06  in the Value text box; press J or click on the Save Attr 
button to accept the changes. When you are finished defining
three parameters, click on OK.

Varying the resistors

Once we've decided that we want to vary the resistors, and 
which resistors we want to vary, we will need to replace the 
desired R symbols on the page with Rbreak symbols (from 
breakout.slb ). This is because the R symbol does not have
associated model, and Monte Carlo analysis operates on de
(DEV) and lot (LOT) tolerances applied to model parameter

The Rbreak symbol does have an associated model, specifi
using the MODEL attribute on the symbol. Replace each of 
through R4 by selecting them (single-click), selecting Repla
from the Edit menu, using Rbreak as the Replacement, and
indicating Selected Parts Only. Click on OK to perform each
replacement operation.
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See Using the Model Editor 
(Text Editor) on page 5-21 for 
information about the model 
editor.
Note You can also select more than one resistor at a 
time using a selection box and/or pressing 
V+click to add more selections to the group of 
selected items. Remember that you can move the 
attributes by clicking once to select it, then holding 
the mouse button down and dragging it to the 
desired location; release the mouse button to 
place.

Saving the schematic

Before we can define models for the Rbreak resistors, we n
to save the schematic by selecting Save As from the File me
Type psensor.sch  in the File Name text box, then click on OK

Modifying the models for Monte Carlo

Now we need to define models for the resistors we are varyi
and assign device (DEV) and lot (LOT) tolerances to the mo
parameters. The model editor allows us to edit model definitio
of part instances. In this way, we can add whatever device a
or lot tolerances we may want to the model parameters of a
given part.

Select R1, then select Model from the Edit menu. The display
dialog box presents three main choices: Change Model 
Reference, Edit Instance Model (Text), and Edit Instance Mo
(Parts).

The first selection allows us to change the model referenced
that symbol. For example, if we already had a model called 
MyModel, we could change R1 to reference MyModel, inste
of Rbreak, by clicking on the Change Model Reference butto
and typing MyModel in the text box provided.

The second selection, Edit Instance Model (Text), allows us
edit the model definition for that symbol instance using a tex
editor. That is, when we select Model from the Edit menu fo
R1, the model definition which appears in the model editor 
dialog box is a copy of the RBREAK model. We cannot edit t
RBREAK model definition associated with every RBREAK 
part placed; that can only be done using the symbol editor 
(Symbol on the Edit menu).
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The third selection, Edit Instance Model (Parts), allows us to
edit the model definition for that symbol instance using the Pa
utility.

Now click on the Edit Instance Model (Text) button. The 
message Searching libraries, please wait...  appears in 
the status line at the bottom of the Schematics window. By 
default, the new name of the instance model is <old model 
name>-X (example: Rbreak-X); we can change this to whatev
we like. Let’s change it to RMonte1. Move the cursor to the 
beginning of Rbreak-X on the .model Rbreak-X RES line, pre
V+C+r to select Rbreak-X, and type RMonte1  in its place.

To add both a 2% device tolerance and a 10% lot tolerance to
resistance multiplier of this model, add R=1 DEV=2% 
LOT=10% on the line following the .MODEL statement. You
model editing box should look something like Figure 12-6.

Click on OK to accept the changes.

When we have finished editing this instance model (RMonte
click on OK. The .MODEL definition of the RMonte1 is saved
(by default) to the <schematic name>.lib  model file—
psensor.lib  in this case. This file is automatically added to th
set of model files associated with (local to) this schematic. If w
specified a model name which was contained in a library/
include file not already configured (via Library and Include 
Files on the Analysis menu), we would have to explicitly 

Figure 12-6 Model Definition for RMonte1
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configure it in order to be able to use the model during 
simulation (see Configuring the Library on page 5-36).

Now that RMonte1 is already defined, and saved to 
psensor.lib , we can reference this new model definition, by
name, for R2 and R4. Select each of these symbols, one at 
time, select Model from the Edit menu, and click on the Chan
Model Reference button. Type RMonte1  in the text box 
provided.

For resistor R3, we would like to assign a 5% DEV tolerance a
no LOT tolerance. For this, we will need a new instance mod
Select Model from the Edit menu, and click on the Edit Instan
Model (Text) button. Enter RTherm as the name of the instance
model. Type R=1 DEV=5% on the line following the .model 
RTherm RES line, and click on OK to accept the changes. Y
schematic should look like Figure 12-7. 

Figure 12-7 Pressure Sensor Circuit with RTherm Model 
Definition Edited
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Figure 12-8 DC Analysis 
Setup Example

Figure 12-9 Monte Carlo 
Analysis Setup Example
Setting up the analyses

First, let’s set up a DC analysis. We would like to sweep the
value of pressure, which we have defined as P. Select Setu
from the Analyses menu and then click on the DC Sweep butt
Select Global Parameter in the Swept Var. Type box, type P in 
the Name text box, type 0 in the Start Value text box, 5.0  in the 
End Value text box, and 0.1  in the Increment text box as shown
in Figure 12-8. Click on OK.

Now, let’s set up the Monte Carlo analysis. Select Setup fro
the Analysis menu and click on Monte Carlo/Worst Case. Ty
10 in the MC Runs text box, select DC and type I(Meter)  in the 
Output Var text box of the Analysis Type box, and select All 
the Output function section of the MC Options box as shown
Figure 12-9. Click on OK.

To enable the analyses, click on the box to the left of the DC
Sweep button and the box next to the Monte Carlo/Worst Ca
button. Click on OK.

Running the analysis and viewing the results

To start the simulation, select Simulate from the Analysis me
If “Automatically Run Probe After Simulation” is enabled with
Probe Setup on the Analysis menu, then a Probe window is
displayed upon completion of the successful simulation. 

Since it was a Monte Carlo analysis that we performed, we 
asked to select the data sections (which runs) to display. Cl
on All and then on OK to view all sections.

To display the desired traces, bring the Schematics window b
into the foreground (either by clicking on a visible portion of i
or by pressing C+E and selecting it from the task list), selec
Mark Current into Pin from the Markers menu, and place a 
current marker on the left-hand pin of the Meter source.

Return to the Probe window to see the family of curves for 
I(Meter) against P. To view the family of curves in Probe 
without making use of markers, select Add from the Trace me
in Probe and double-click on I(Meter) in the output variable li

For more on analyzing Monte Carlo results in Probe, see the
next section on Monte Carlo histograms.
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For information about 
performance analysis, see 
Example: RLC Filter on 
page 11-3.
Monte Carlo Histograms
A typical application of Monte Carlo analysis is predicting 
yields on production runs of a circuit. Probe can be used to 
display data derived from Monte Carlo waveform families as
histograms, part of Probe’s performance analysis feature.

To illustrate this feature, we will simulate a fourth order 
Chebyshev active filter, running a series of 100 AC analyses
while randomly varying resistor and capacitor values for eac
run. Then, having defined performance analysis goal functio
for bandwidth and center frequency, we will observe the 
statistical distribution of these quantities for the 100 runs.

Chebyshev filter example

The Chebyshev filter is designed to have a 10 kHz center 
frequency and a 1.5 kHz bandwidth. The schematic for the fil
is shown in Figure 12-10. The stimulus specifications for V1
V2, and V3 are:

V1: DC=-15
V2: DC=+15
V3: AC=1

The components were rounded to the nearest available 1% 
resistor and 5% capacitor value.   In our analysis, we are 
concerned with how the bandwidth and the center frequency
vary when 1% resistors and 5% capacitors are used in the cir

Creating models for Monte Carlo analysis

Since we are interested in varying the resistors and capacito
the filter circuit, we will need to create models for these 
components on which we can set some device tolerances fo
Monte Carlo analysis. The breakout.slb  Symbol Library file 
contains generic devices for this purpose. The resistors and
capacitors in this schematic are the Rbreak and Cbreak sym
from breakout.slb . Using the model editor, we must modify 
the models for these components as follows:

.model RMOD RES(R=1 DEV=1%)

.model CMOD CAP(C=1 DEV=5%)
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Figure 12-11 Monte Carlo 
Analysis Setup Example

Shortcut: Click on  or press 
!

Setting up the analysis

To analyze our filter, we will set up both an AC analysis and
Monte Carlo analysis. The AC analysis sweeps 50 points pe
decade from 100 Hz to 1 MHz. The Monte Carlo analysis is 
to take 100 runs (see Figure 12-11). The analysis type is AC 
the output variable that we are interested in is V(OUT). We w
select All in the MC Options box. 

Creating histograms

Because the data file can become quite large when running
Monte Carlo analysis and because we are only interested in
output of the filter, we will place a voltage marker at the outp
of the filter. The steps necessary to collect data for the mark
node only are enumerated below.

1 Select Probe Setup from the Analysis menu.

2 Mark the Automatically Run Probe after Simulation chec
box.

3 Select At Markers Only in the Data Collection box.

4 Click on OK.

To run the simulation, select Simulate from the Analysis men
After the simulation is complete, a Probe window is displaye

Figure 12-10 Chebyshev Filter
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For information about 
performance analysis, see 
Example: RLC Filter on 
page 11-3.

You can also display this 
histogram by using the 
performance analysis wizard to 
display Bandwidth
(VDB(OUT) , 1).
Since we performed a Monte Carlo analysis, we are asked t
select the runs for which we wish to display the data. Click o
All and then on OK to view all sections.

The steps to display a histogram are enumerated below.

1 Select X Axis Settings from the Plot menu.

2 Check the Performance Analysis check box in the 
Processing Options box and click on OK.

The display changes to the histogram display where the Y a
is the percent of samples. To display a histogram of the 
distribution of the 1 dB bandwidth for our filter:

1 Select Add from the Trace menu.

2 Click on the Bandwidth(1, db_level) goal function.

3 Click on V(OUT). 

4 In the Trace Command text box, place the cursor after the
in Bandwidth(V(OUT) , ) and type DB. The text box should 
now read as Bandwidth(VDB(OUT) , ). 

5 Place the cursor after the comma and type 1 for the 1 dB 
level. The text box should now read as 
Bandwidth(VDB(OUT) , 1). 

6 Click on OK to view the histogram.

To change the number of histogram divisions, select Option
from the Tools menu and replace 10 with 20 in the Number 
Histogram Divisions text box. Click on Save and then OK. Th
histogram of the 1 dB bandwidth is as shown in Figure 12-1
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The statistics for the histogram are displayed along the botto
of the display by default. They can be turned off by selecting
Options from the Tools menu, clicking on the Display Statisti
check box to remove the X, and clicking on Save and OK.

The statistics show the number of Monte Carlo runs, the num
of divisions or vertical bars that make up the histogram, mea
sigma, minimum, maximum, 10th percentile, median, and 90
percentile. Ten percent of the goa1 function values are less t
or equal to the 10th percentile number, and 90% of the goal
function values are greater than or equal to that number.

If there is more than one goal function value that satisfies th
criteria, then the 10th percentile is the midpoint of the interv
between the goal function values that satisfy the criteria. 
Similarly, the median and 90th percentile numbers represen
goal function values such that 50% and 90% (respectively) o
the goal function values are less than or equal to those numb
Sigma is the standard deviation of the goal function values.

We can also show the distribution of the center frequency of 
filter. The steps to display the center frequency are enumera
below.

1 Select Add from the Trace menu.

2 Select the CenterFreq(1, db_level) goal function by clickin
on it. 

Figure 12-12 1 dB Bandwidth Histogram
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3 Select V(OUT) by clicking on it.

4 In the Trace Command text box, place the cursor after the
in CenterFreq(V(OUT) , ) and type DB. The text box should 
now read as follows:

CenterFreq(VDB(OUT) , )

5 Place the cursor after the comma and type in 1 for the 1 dB 
level. The text box should now read as follows:

CenterFreq(VDB(OUT) , 1)

6 Click on OK to view the histogram.

The new histogram replaces the previous histogram. To disp
both histograms at once, use Add Plot on the Plot menu bef
selecting Add from the Trace menu. The histogram of the cen
frequency is as shown in Figure 12-13.

Figure 12-13 Center Frequency Histogram
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Worst-Case Analysis
This section discusses the analog worst-case analysis featu
PSpice. It is hoped that the information provided here will he
you to apply it properly and with realistic expectations.

Overview of Worst-Case 
Analysis
Worst-case analysis is used to find the worst probable outpu
a circuit or system given the restricted variance of its 
parameters. For instance, if the values of R1, R2, and R3 ca
vary by +10%, then the worst-case analysis attempts to find 
combination of possible resistor values which result in the wo
simulated output. As with any other analysis, there are three
important parts: inputs, procedure, and outputs.

Inputs

Besides the circuit description, two forms of information are 
required from the user: 

• parameter tolerances

• a definition of what worst means

PSpice allows tolerances to be set on any number of the 
parameters that characterize a model. Models can be defined
nearly all primitive analog circuit components, such as resisto
capacitors, inductors, and semiconductor devices. PSpice re
the standard model parameter tolerance syntax specified in
.MODEL statement. For each model parameter, PSpice uses
nominal, minimum, and maximum probable values, and the 
DEV and/or LOT specifiers; the probability distribution type 
(such as UNIFORM or GAUSS) is ignored.

The criterion for determining the worst values for the relevant 
model parameters is defined in the .WC statement as a func
of any standard output variable in a specified range of the swe
In a given range, the measurement must be reduced to a sin
value by one of these five collating functions:
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Analog behavioral models can 
be used to measure waveform 
characteristics other than those 
detected by the available 
collating functions, such as rise 
time or slope. Analog behavioral 
models can also be used to 
incorporate several voltages and 
currents into one output variable 
to which a collating function may 
be applied. See Chapter 
6,Analog Behavioral Modeling, 
for more information.
Worst is user-defined as the highest (HI) or lowest (LO) possib
collating function relative to the nominal run.

Procedure

To establish the initial value of the collating function, worst-
case analysis begins with a nominal run with all model 
parameters at their nominal values. Next, multiple sensitivity
analyses determine the individual effect of each model 
parameter on the collating function. This is accomplished by
varying model parameters, one at a time, in consecutive 
simulations. The direction (better or worse) in which the 
collating function changes with a small increase in each mo
parameter is recorded.

Finally, for the worst-case run, each parameter value is take
far from its nominal as allowed by its tolerance, in the directio
which should cause the collating function to be its worst (giv
by the HI or LO specification).

This procedure saves time by performing the minimum numb
of simulations required to make an educated guess at the 
parameter values which produce the worst results. It also ha
some limitations, which will be discussed in the following 
sections.

Outputs

A summary of the sensitivity analysis is printed in the PSpic
output file (.out ). This summary shows the percent change i
the collating function corresponding to a small change in ea

MAX Maximum output variable value

MIN Minimum output variable value 

YMAX Output variable value at the point where i
differs the most with the nominal run

RISE_EDGE
(value)

Sweep value where the output variable 
value crosses above a given threshold 
value

FALL_EDGE
(value)

Sweep value where the output variable 
value crosses below a given threshold 
value
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model parameter. If a .PROBE statement is included in the 
circuit file, then the results of the nominal and worst-case ru
are saved for viewing with Probe.

An important condition for correct worst-case 
analysis

Worst-case analysis is not an optimization process; it does n
search for the set of parameter values which result in the wo
result. It assumes that the worst case occurs when each 
parameter has been either pushed to one of its limits or left a
nominal value as indicated by the sensitivity analysis. It sho
the true worst-case results when the collating function is 
monotonic within all tolerance combinations. Otherwise, ther
is no guarantee. Usually you cannot be certain if this conditi
is true, but insight into the operation of the circuit may alert y
to possible anomalies.
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Worst-Case Analysis Example
The schematic shown in Figure 12-14 is for an amplifier circu
which is a biased BJT. This circuit is used to demonstrate ho
simple worst-case analysis works. It also shows how non-
monotonic dependence of the output on a single parameter c
adversely affect the worst-case analysis. Since an AC (sma
signal) analysis is being performed, setting the input to unity
means that the output, Vm([OUT]), is the magnitude of the ga
of the amplifier. The only variable declared in this circuit is th
resistance of Rb2. Since the value of Rb2 determines the bias on
the BJT, it also affects the amplifier’s gain.

Figure 12-16 is the circuit file used to run either a parametric 
analysis (.STEP, shown enabled in the circuit file) that sets 
value of resistor Rb2 by stepping model parameter R through
values spanning the specified DEV tolerance range, or a worst-
case analysis (shown disabled in the circuit file) that allows 
PSpice to determine the worst-case value for parameter R ba
upon a sensitivity analysis. PSpice allows only one of these
analyses to be run in any given simulation. Note that the AC a
worst-case analysis specifications (.AC and .WC statements)
written so that the worst-case analysis tries to minimize 
Vm([OUT]) at 100 kHz.

The netlist and circuit file in Figure 12-16 is set up to run eith
a parametric (.STEP) or worst-case (.WC) analysis of the 
specified AC analysis. These simulations demonstrate the 

Figure 12-14 Simple Biased BJT Amplifier
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Figure 12-15 YatX Goal 
Function

The YatX goal function is used 
on the simulation results for the 
parametric sweep (.STEP) 
defined in Figure 12-16. The 
resulting curves are shown in 
Figure 12-17 and Figure 12-18.

YatX(1, X_value)=y1
{

1|sfxv(X_value)!1;
}

conditions under which worst-case analysis works well and 
those that can produce misleading results when output is no
monotonic with a variable parameter (see Figure 12-17 and
Figure 12-18).

For demonstration, the parametric analysis is run first, 
generating the curve shown in Figure 12-17 and Figure 12-1
This curve, derived using the YatX goal function shown in 
Figure 12-15, illustrates the non-monotonic dependence of g
on Rb2. To do this yourself, place the goal function definition i
a probe.gf  file in the circuit directory. Then run Probe, load a
of the AC sweeps, set up the X axis for performance analys
and add the following trace:

YatX(Vm([OUT]),100k)

Next, the parametric analysis is commented out and the wo
case analysis is enabled. Two runs are made using the two 
versions of the Rbmod .MODEL statement shown in the circuit
file. The model parameter, R, is a multiplier which is used to
scale the nominal value of any resistor referencing the Rbmod 
model (Rb2 in this case).

The first .MODEL statement leaves the nominal value of Rb2 at 
720 ohms. The sensitivity analysis increments R by a small 
amount and checks its effect on Vm([OUT]). This slight 
increase in R causes an increase in the base bias voltage o
BJT, and increases the amplifier’s gain, Vm([OUT]). The wor
case analysis correctly sets R to its minimum value for the 
lowest possible Vm([OUT]) (see Figure 12-17).

The second .MODEL statement scales the nominal value of Rb2 
by 1.1 to approximately 800 ohms. The gain still increases w
a small increase in R, but a larger increase in R increases th
base voltage so much that it drives the BJT into saturation a
nearly eliminates the gain. The worst-case analysis is fooled
the sensitivity analysis into assuming that Rb2 must be 
minimized to degrade the gain, but maximizing Rb2 is much 
worse (see Figure 12-18). Note that even an optimizer, whic
checks the local gradients to determine how the parameters
should be varied, is fooled by this circuit.

Consider a slightly different scenario: Rb2 is set to 720 ohms so
that maximizing it is not enough to saturate the BJT, but Rb1 is 
variable also. The true worst case occurs when Rb2 is 
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maximized and Rb1 is minimized. Checking their individual 
effects is not sufficient, even if the circuit were simulated fou
times with each resistor in turn set to its extreme values.

* Worst-case analysis comparing monotonic and non-monotonic
* output with a variable parameter

.lib

***** Input signal and blocking capacitor *****
Vin In 0 ac 1
Cin In B 1u

***** "Amplifier" *****
*   gain increases with small increase in Rb2, but 
*   device saturates if Rb2 is maximized.
Vcc Vcc 0 10
Rc Vcc C 1k
Q1 C   B 0 Q2N2222
Rb1 Vcc B 10k
Rb2 B 0 Rbmod 720
.model Rbmod res(R=1 dev 5%) ; WC analysis results 

; are correct
* .model Rbmod res(R=1.1 dev 5%) ; WC analysis misled 

; by sensitivity

***** Load and blocking capacitor *****
CoutC Out 1u
Rl Out 0 1k

* Run with either the .STEP or the .WC, but not both. 
* This circuit file is currently set up to run the .STEP 
* (.WC is commented out)

**** Parametric Sweep—providing plot of Vm([OUT]) vs. Rb2 ****
.STEP Res Rbmod(R) 0.8 1.2 10m

***** Worst-case analysis *****
* run once for each of the .model definitions stated above)
* WC AC Vm([Out]) min range 99k 101k list output all

.AC Lin 3 90k 110k

.probe

.end

Figure 12-16 Amplifier Netlist and Circuit File
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Output is monotonic within the 
tolerance range. Sensitivity 
analysis correctly points to the 
minimum value.

Output is non-monotonic within 
the tolerance range, thus 
producing incorrect worst-case 
results.
Figure 12-17 Correct Worst-Case Results

Figure 12-18 Incorrect Worst-Case Results
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Figure 12-19 Schematic 
Demonstrating Use of VARY 
Hints and Other Useful 
Information

VARY BOTH, VARY DEV, and VARY LOT

When VARY BOTH is specified in the .WC statement and a
model parameter is specified with both DEV and LOT 
tolerances defined, the worst-case analysis may produce 
unexpected results. The sensitivity of the collating function i
only tested with respect to LOT variations of such a paramet
for example, during the sensitivity analysis, the parameter is
varied once affecting all devices referring to it and its effect 
the collating function is recorded. For the worst-case analys
the parameter is changed for all devices by LOT + DEV in th
determined direction. Consider the example schematic in 
Figure 12-19 and circuit file in Figure 12-20.

Figure 12-20 Circuit File Demonstrating Use of VARY BOTH

In this case, V(3) is maximized if:

• Rwc1 and Rwc2 are both increased by 10% per the LOT 
tolerance specification, and then

• Rwc1 is decreased by 5% and Rwc2 is increased by 5% per
the DEV tolerance specification.

The final values for Rwc1 and Rwc2 should be 105 and 115, 
respectively. However, because Rwc1 and Rwc2 are varied 
together during the sensitivity analysis, it is assumed that bo
must be increased to their maximum for a maximum V(3). 
Therefore, both are increased by 15%.

Here again, the purpose of the technique is to reduce the num
of simulations. For a more accurate worst-case analysis, yo
should first perform a worst-case analysis with VARY LOT, 

WCASE VARY BOTH Test

Vin 1 0 10V
Rs 1 2 1K
Rwc12 3 Rmod 100
Rwc23 0 Rmod 100
.MODEL Rmod RES(R=1 LOT 10% DEV 5%)
.DC Vin LIST 10
.WC DC V(3) MAX VARY BOTH LIST OUTPUT ALL
.ENDS
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manually adjust the nominal model parameter values accord
to the results, then perform another analysis with VARY DE
specified.

Gaussian distributions

Parameters using Gaussian distributions are changed by 3σ 
(three times sigma) for the worst-case analysis.

YMAX collating function

The purpose of the YMAX collating function is often 
misunderstood. This function does not try to maximize the 
deviation of the output variable value from nominal. Dependi
on whether HI or LO is specified, it tries to maximize or 
minimize the output variable value itself at the point where 
maximum deviation occurred during sensitivity analysis. Thi
may result in maximizing or minimizing the output variable 
value over the entire range of the sweep. This collating funct
is usually useful when you know the direction in which the 
maximum deviation occurs.

RELTOL

During the sensitivity analysis, each parameter is varied 
(multiplied) by 1+RELTOL where RELTOL is specified in a 
.OPTIONS statement, or defaults to 0.001.

Sensitivity analysis

The sensitivity analysis results are printed in the output file 
(.out ). For each varied parameter, the percent change in th
collating function and the sweep variable value at which the
collating function was measured are given. The parameters
listed in worst output order; for example, the collating function
was its worst when the first parameter printed in the list was
varied.

When the YMAX collating function is used, the output file als
lists mean deviation and sigma values. These are based on
changes in the output variable from nominal at every sweep
point in every sensitivity run.
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Manual optimization

Worst-case analysis can be used to perform manual optimization 
with PSpice. The monotonicity condition is usually met if the
parameters have a very limited range. Performing worst-cas
analysis with tight tolerances on the parameters yields 
sensitivity and worst-case results (in the output file) which c
be used to decide how the parameters should be varied to 
achieve the desired response. You can then make adjustmen
the nominal values in the circuit file, and perform the worst-ca
analysis again for a new set of gradients. Parametric sweep
(.STEP), like the one performed in the circuit file shown in 
Figure 12-16, can be used to augment this procedure.

Monte Carlo analysis

Monte Carlo (.MC) analysis may be helpful when worst-case
analysis cannot be used. Monte Carlo analysis can often be u
to verify or improve on worst-case analysis results. Monte Ca
analysis randomly selects possible parameter values, which
be thought of as randomly selecting points in the parameter 
space. The worst-case analysis assumes that the worst resu
occur somewhere on the surface of this space, where param
(to which the output is sensitive) are at one of their extreme
values.

If this is not true, the Monte Carlo analysis may find a point 
which the results are worse. To try this, simply replace .WC 
the circuit file with .MC <#runs>, where <#runs> is the number 
of simulations you are willing to perform. More runs provide 
higher confidence results. To save disk space, do not specify
OUTPUT options. The Monte Carlo summary in the output fi
lists the runs in decreasing order of collating function value.

Now add the following option to the .MC statement, and 
simulate again.

OUTPUT LIST RUNS <worst_run#>

This performs only two simulations: the nominal and the wor
Monte Carlo run. The parameter values used during the wor
run are written to the output file, and the results of both 
simulations are saved.
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Using Monte Carlo analysis with YMAX is a good way to obtai
a conservative guess at the maximum possible deviation fro
nominal, since worst-case analysis usually cannot provide th
information.
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Part Four describes how to use Probe to view simulation res

Chapter 13,Waveform Analysis, describes how to use Probe t
perform waveform analysis of simulation results.

Chapter 14,Output Options, describes output options that can
be used to control the simulation output.



Waveform Analysis
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13
Chapter Overview
This chapter describes how to use Probe to perform wavefo
analysis of simulation results. This chapter includes the 
following:

Overview of Probe on page 13-2

What You Need to Know to Run Probe on page 13-5

Probe Example on page 13-12

User-Interface Features on page 13-15

Probe Trace Expressions on page 13-22

Limiting File Size Using Markers on page 13-28
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Overview of Probe
MicroSim Probe is the waveform analyzer for PSpice 
simulations. Probe allows you to visually analyze and 
interactively manipulate the waveform data produced by circ
simulation.

Using high-resolution graphics, Probe allows you to view the
results of a simulation both on the screen and on hard copy
effect, Probe is a software oscilloscope. Running PSpice 
corresponds to building or changing a breadboard, and runn
Probe corresponds to looking at the breadboard with an 
oscilloscope.

Probe displays simple voltages and currents and also displa
complex arithmetic expressions involving voltages and curren
Probe can also display the Fourier transform of these 
expressions.

PSpice generates two forms of output: the simulation output 
and the Probe data file. The calculations and results reporte
the simulation output file act as an audit trail of the simulation
However, the graphical analysis of information stored in the
Probe data file using the Probe program is the most informat
and flexible method for evaluating simulation results.
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Use Options on the Tools menu 
to display/hide the toolbar.
Anatomy of a Plot Window
A plot window is a separately managed waveform display ar
A plot window can include multiple plots. Figure 13-1 shows
the Probe window with two plot windows displayed (toolbars
disabled).

Since a plot window is a window object, it has standard windo
features which allow you to minimize/maximize the window o
move and scale the window within the Probe window area. A
toolbar can be displayed in the Probe window and applies to
currently active plot window.

One or more Probe data files can be opened in a plot windo
After the first file is loaded, other files can be loaded into the
same plot window using Append on the File menu.

Figure 13-1 Probe Window with Two Plot Windows

window A

window B
(active)



13-4 Waveform Analysis

w 

 plot 

or 

 

Printing multiple windows 

You can print all or selected plot 
windows, with up to nine 
windows appearing on a single 
page. When you select Print 
from the File menu, a list of all 
current plot windows is 
displayed. Each window is 
identified by the unique identifier 
in parentheses in the title bar of 
the plot window.

The arrangement of plot 
windows on the page can be 
customized using the Page 
Setup dialog box. You can print 
in either portrait (vertical) or 
landscape (horizontal) 
orientation.
Managing Multiple Plot Windows
Any number of plot windows can be opened. Each plot windo
is an independent window.

The same Probe data file can be displayed in more than one
window. Only one plot window is active at any given time, 
identified by a highlighted title bar. Menu, keyboard, and curs
operations affect only the active plot window. Another plot 
window can be made active by clicking anywhere within the
window.
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You do not need to exit Probe if 
you are finished examining the 
simulation results for one circuit 
and want to begin a new 
simulation. However, when you 
set up Probe to run automatically 
after simulation, Probe unloads 
the data file each time that you 
run a simulation. Once the 
simulation is complete, the new 
or updated Probe data file is 
loaded for viewing.

Once the simulation is complete 
(all data sections), the PSpice 
window reverts to manual mode.

If a new Probe window is opened 
(using New on the Window 
menu) while monitoring the data, 
the new window also starts in 
monitor mode since it is 
associated with the same Probe 
data file.
What You Need to Know 
to Run Probe

Starting Probe
If you are using MicroSim Schematics, you can automaticall
start MicroSim Probe after a simulation is run, or you start Pro
separately from Windows.

When you start Probe, you can use the default .prb  file or you 
can use a custom .prb  file. 

To automatically start Probe after simulation

1 In Schematics, select Probe Setup from the Analysis me

2 In the Auto-Run Option area, click on Automatically Run
Probe after Simulation. 

3 Click on any other options you want to use. 

4 Click on OK.

To start Probe and monitor results during a 
simulation

1 Turn on waveform monitoring:

a Select Probe Setup from the Analysis menu.

b Select Monitor Waveforms (Auto-update). If this entr
is grayed out, then disable the Text Data File Forma
(CSDF) check box.

c Click on OK.

2 Select Simulate from the Analysis menu to start the 
simulation. Probe starts automatically and displays one 
window in monitor mode.

3 In Probe, select the waveforms to be monitored using Ad
on the Trace menu or by placing markers.
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For information about 
customizing Probe colors in 
msim.ini , see Appendix A in the 
Schematics User’s Guide.
4 During a multiple run simulation (such as Monte Carlo, 
parametric or temperature), only the data for the first run
displayed. To view the curves for several runs:

a Select Close from the File menu to close the data file
then select Open from the File menu to reload it.

b Specify the data sections (runs) to load.

c Select the traces to monitor. Waveforms for all loade
sections are displayed.

To start Probe from Schematics

Select Run Probe from the Analysis menu, or press @.

To start Probe in Windows

1 Display Program Manager.

2 Double-click the Probe icon in the MicroSim program 
group.

Setup Requirements
The configuration file msim.ini  contains settings which control
the way Probe is run on your system. Foreground, backgrou
and trace colors for display and hard copy can be configured
Probe by editing the file msim.ini . 

.prb  files, command files, and switches can be specified in t
Run Probe Command text box of the Options/Editor 
Configuration/App Settings dialog box. The command line 
entered here is saved to msim.ini . Probe recognizes these 
options when you start it automatically after simulation or wh
you start it from Schematics by selecting Run Probe from th
Analysis menu or by pressing @.
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Manual Startup
The command for running Probe at the Windows Properties
command line is:

probe <options>* <data file>

where

Other Ways to Run Probe

Mid-analysis “snoop”

The mid-analysis “snoop” feature allows simulations to be 
paused and resumed so that you can use Probe to analyze 
waveforms before the simulation is finished. This feature is 
useful for verifying that a long transient analysis is proceedin
correctly. You can start the analysis, check the waveforms f
the first few transitions, and then either let the analysis contin
or abort it.

To start mid-analysis “snoop”

1 In the Simulation Status window, select Pause Simulatio
from the File menu. A check mark is displayed.

2 Select Run Probe from the File menu.

To resume a simulation

1 Exit Probe.

2 In the Simulation Status window, select Pause Simulatio
from the File menu.

options are the command line options for running Pro
with a command file (C switch), log file (L 
switch), etc., where switches are preceded with
or -.

data file is the name of the Probe data file generated b
the simulator.
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Starting Probe during a simulation

Once a simulation is in progress, it is possible to monitor the
results for the data section currently being written by the 
simulator. This method applies when Monitor Waveforms 
(Auto-update) is not selected in the Probe Setup dialog box 
Schematics.

To start Probe during a simulation

1 Start the simulation as described in Starting Simulation on 
page 7-11.

2 In Schematics, start Probe by selecting Run Probe from 
Analysis menu. The current data file is automatically 
opened. 

3 (In Probe) If multiple data sections are available, load th
data section currently being generated by selecting the l
data section listed in the Available Sections dialog box. Th
deselects all earlier data sections.

4 (In Probe) Select the waveforms to be monitored using A
on the Trace menu.

When started this way, the Probe window monitors the 
waveforms for as long as the data section is being written. O
complete, the window reverts to manual mode.

To monitor subsequently generated data 
sections

1 Select AC, DC, or Transient from the Plot menu.

2 In the Available Sections dialog box, select the latest da
section that is being generated. This deselects all earlier d
sections.

If a new Probe window is opened (using New on the 
Window menu) while monitoring the data, the new windo
starts in manual mode.
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Interacting with Probe while in monitor mode

All of the Probe functionality is available during monitor mode
However, functions that change the X axis domain (set a new
axis variable) pause monitoring and place the window in man
mode until the X axis is reverted back to its original domain.
These functions include:

• fast Fourier transforms, activated by selecting X Axis 
Settings from the Plot menu and clicking on the Fourier 
check box

• Performance Analysis, activated by selecting X Axis 
Settings from the Plot menu and clicking on the 
Performance Analysis check box

• new X axis variable, activated by selecting X Axis Setting
from the Plot menu, clicking on Axis Variable, specifying 
new X axis variable

• goal function evaluation, activated by selecting Eval Goa
Function from the Trace menu

• loading a previously completed data section

Configuring update intervals

The frequency at which Probe updates the waveform display 
be customized by selecting Options from the Tools menu an
specifying the auto-update interval. The default setting (Auto
leaves the interval determination to Probe. You can also def
the interval at fixed time intervals (Everyn sec) or according to 
the percentage of simulation completed (Everyn %), where n is 
user-defined.
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Schematic Markers
Markers can be placed on your schematic to identify the poi
where you want to see the waveform results displayed in Pro
Placement can occur before or after simulation takes place.

When placed before simulation, they can be used to limit res
written to the Probe data file and/or automatically display tho
traces in Probe. Once Probe is running, placement of any 
additional markers on the schematic results in the automatic
display of traces in the currently active plot window.

Table 13-1 summarizes the available marker types and how 
select them for placement. The markers for dB, phase, grou
delay, real, and imaginary waveform characteristics can be u
instead of the built-in Probe functions provided in output 
variable expressions (see Table 13-6 on page 13-25). 

The Markers menu provides additional selections for controlli
display of marked results in Probe, both after simulation and
after initial marker placement:

Table 13-1 Schematic Markers

Waveform
Markers Menu 
Selection

Symbol Selection

voltage Mark Voltage/Level (not required)

voltage
differential

Mark Voltage 
Differential

(not required)

current Mark Current Into Pin (not required)

dB Mark Advanced VDB (voltage)
IDB (current)

phase Mark Advanced VPHASE (voltage)
IPHASE (current)

group delay Mark Advanced VGROUPDELAY (voltage)
IGROUPDELAY (current)

real Mark Advanced VREAL (voltage)
IREAL (current)

imaginary Mark Advanced VIMAGINARY (voltage)
IIMAGINARY (voltage)
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Show All causes all traces corresponding to marke
placed on any page or level of the 
schematic to be displayed in Probe

Show 
Selected

selectively displays existing markers 
(highlight markers of interest and select 
Show Selected)

Clear All removes all markers from the schematic 
and all corresponding traces in the Probe
display
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The example circuit 
example.sch  is provided with 
the MicroSim software 
installation.
Probe Example
In this section, basic techniques for operating Probe are 
demonstrated using the circuit example.sch .

Figure 13-2 Example Schematic example.sch

When shipped, example.sch  is set up with multiple analyses 
enabled. For purposes of this demonstration, we can disable the 
AC sweep, DC sweep, Monte Carlo/worst-case, and small-
signal transfer function analyses by selecting Setup from the
Analysis menu in Schematics and toggling the check box nex
the appropriate analysis. The specification for each of these
disabled analyses remains intact. We can run them in the fu
by simply toggling the check box back to the enabled state.

We will run with the Bias Point Detail, Temperature, and 
Transient analyses enabled. The temperature analysis is set 
degrees. The transient analysis is specified with:

Print Step 20ns
Final Time 1000ns
Enable Fourier checked on
Center Frequency 5Meg
Output Vars V(OUT2)

The simulation is started by selecting Simulate from the 
Analysis menu in Schematics. By default, Probe is set to 
automatically run. In this example, we will not be specifying 
goal functions or macros so that we can keep the default 
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Automatically Run Probe After Simulation option enabled in th
Probe Setup dialog.

PSpice generates a binary Probe data file containing the res
of the simulation. The Probe screen is displayed with the da
file example.dat  already loaded as shown in Figure 13-3. 

The name of the data file example.dat  is indicated in the title 
bar. All Probe commands are activated through the menu ite

Notice that the Transient menu item on the Plot menu is 
checked, indicating that the data currently loaded are the 
transient analysis results. A menu does not always allow 
selection of all of its commands, as indicated by the grayed-
entries. The availability of commands depends on what 
activities are currently legal.

Having selected an analysis, voltages and currents across 
devices or at nets can be displayed in the Probe plot using e
the schematic marker method or by explicitly specifying Pro
output variables (as will be demonstrated in this example).

Probe output variables are specified in Probe by selecting A
from the Trace menu. A list of valid output variables is 

Figure 13-3 Probe Main Window with Loaded example.dat 
and Open Plot Menu
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automatically displayed when Add is selected. A screen sim
to Figure 13-4 is displayed.

Figure 13-4 Output from Transient Analysis: Voltage at 
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Accelerator keys

Many of the menu functions in 
Probe have matching keystrokes 
which can be used instead. For 
instance, having placed a zoom 
box in the plot, we could have 
typed C+A instead of 
selecting Area from the View 
menu.
User-Interface Features
Probe offers a number of direct manipulation techniques to 
facilitate analysis of the waveform data as well as shortcuts.
These techniques are described in this section.

Zoom Regions
Probe provides a direct manipulation method for marking the
zoom region of the plot. After placing the first bar, and with th
mouse button still depressed, the second bar can be dragge
or right to demarcate the region of zoom. By subsequently 
selecting Area from the View menu, Probe changes the plot
display only the region of interest as marked by the zoom ba

It is also possible to directly select a zoom region by draggin
the mouse in the plot to produce a zoom box as shown in 
Figure 13-5. As with the case above, Area on the View men

redisplays the traces, showing only the region within the zoo
box.

zoom box 

Figure 13-5 Zoom Box
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You can also double-click on a 
trace or text label to modify it.
Scrolling Traces 
By default, when a plot is zoomed, standard scroll bars will 
appear to the left and/or bottom of the plot area. These can 
used to pan through the data. Scroll bar behavior can also b
configured by selecting Options from the Tools menu and 
checking the appropriate Scrollbars box as follows:

Modifying Traces and Labels
Traces, text labels, and ellipse labels that are currently displa
within the plot window may be modified, thus eliminating the
need to delete and recreate any of these objects. The releva
object must be selected.

For instance, to modify the expression for any given trace, t
trace name must be selected by clicking on it (indicated by a
color change) and then selecting Modify Object from the Ed
menu. Text and ellipse labels may be similarly selected and
modified. In the case of ellipse labels, the inclination angle m
be modified.

Auto Scroll bars appear when a plot is zoomed 
additional traces are displayed in the plot
but are not visible (default). 

Never Scroll bars are never displayed. This mod
provides maximum plot size and is useful
on VGA and lesser resolution displays.

Always Scroll bars are displayed at all times, but
are disabled if the applicable axis is full 
scale.
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Moving Traces and Labels
Traces and labels can also be selected and moved, either w
the same plot window or to another plot window.

To copy or move traces

1 Select one (single click) or more (V+click) traces by trace 
name. Selected trace names are highlighted.

2 Select Copy or Cut from the Edit menu, depending upon
whether you wish to leave the selected traces intact, or t
remove them. In either case, the traces are saved to the
clipboard.

3 From the plot window where traces are to be added, do o
of the following:

• To add traces to the end of the currently displayed s
select Paste from the Edit menu.

• To add traces before a currently displayed trace, sel
the trace and then select Paste from the Edit menu.

Here are some considerations when moving traces between
windows:

• If the new plot window is reading the same Probe data fi
the copied or moved traces are identical to the original 
selection set.

• If the new plot window is reading a different Probe data file, 
the copied traces are displayed in the context of the 
waveform expression as applied to the new data.

For example, suppose two data files, mysim.dat  and 
yoursim.dat  each contain a V(2) waveform. Suppose als
that two plot windows are currently displayed where 
window A is loaded with mysim.dat , and window B is 
loaded with yoursim.dat .

When V(2) is copied from window A to window B, the trac
looks different since it is derived from yoursim.dat  instead 
of mysim.dat .
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To copy or move labels

1 Select one (single click) or more (V+click) labels by label 
name, or select multiple labels by clicking and dragging 
form a Selection Box around the label objects of interest
Selected label names are highlighted.

2 Select Copy or Cut from the Edit menu, depending upon
whether you wish to leave the selected labels intact, or t
remove them. In either case, the labels are saved to the
clipboard.

3 From the plot window where labels are to be added, sele
Paste from the Edit menu. Labels can be moved by dragg
them to a new location.

Tabulating Trace Data Values 
It can be useful to generate a table of data points reflecting 
or more traces in the plot window, and use this information in
document or spreadsheet. To view the table:

1 Select one (single click) or more (V+click) traces by trace 
name. Selected trace names are highlighted.

2 Save the trace data point values to the Clipboard by 
selecting Copy or Cut from the Edit menu, depending up
whether you wish to leave the selected traces intact.

3 From within Clipboard, select either Text or OEM Text 
from the Display menu.

To store the data points as an ASCII file, paste the data from
Clipboard into a text editor of your choice. This method guar
against spurious clipboard file data appearing at the beginni
of the file when saving the data directly from the Clipboard 
Viewer program.
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Cursors
When one or more traces are displayed, Probe provides cur
which can be used to display the exact coordinates of two po
on the same trace, or points on two different traces. In additi
differences are shown between the corresponding coordina
values for the two cursors.

Cursors are enabled by selecting Cursor from the Tools me
and then selecting Display. Both cursors are initially placed 
the trace listed first in the trace legend. The corresponding tr
symbol is outlined in a dashed line. On the Cursor submenu
under the Tools menu, there are specific cursor placement 
commands: Peak, Trough, Slope, Min, Max, Point, and Sea
Commands.

The mouse and keyboard can also be used to move cursors
chosen position on the trace. Table 13-2 lists the cursor control 
commands for the mouse. Keyboard commands are listed in
Table 13-3. 

Table 13-2 Mouse Commands for Cursor Control

 Category  Command Function

cursor 
assignment

left-click on the trace symbol associates the first 
cursor with the selected 
trace.

right-click on the trace symbol associates the second 
cursor with the selected 
trace.

cursor 
movement

left-click in the display area moves the first cursor to
the closest trace 
segment at the X 
position.

right-click in the display area moves the second curso
to the trace segment at 
the X position.
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Figure 13-6 shows both cursors positioned on the V(1) 
waveform.

Figure 13-6 Probe Screen with Cursors Positioned on the 
Trough and Peak of the V(1) Waveform

Cursor 1 has been positioned on the minimum value of the V
waveform using the Trough option from the Cursor command
the Tools menu. Cursor 2 been positioned on the maximum

Table 13-3 Keyboard Commands for Cursor Control

Keyboard 
Sequence

Function

C+l and C+r Changes the trace associated with the first cursor

V+C+l and 
V+C+r 

Changes the trace associated with the second 
cursor.

l and r Moves the first cursor along the trace.

V+l and V+r Moves the second cursor along the trace.

h Moves the first cursor to the beginning of the 
trace.

V+h Moves the second cursor to the beginning of the 
trace.

e Moves the first cursor to the end of the trace.

V+e Moves the second cursor to the end of the trace.
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value of the same waveform using Peak option. In the Probe
Cursor box, cursor1 and cursor 2 coordinates are displayed 
and A2, respectively) with their difference shown at the botto
(dif).

The mouse buttons are also used to associate each cursor w
different trace by clicking appropriately (see Table 13-2 on 
page 13-19) on the trace symbol in the legend. These are 
outlined in the pattern corresponding to the associated curs
crosshair pattern. Given the example in Figure 13-6, right-
clicking on the V(2) symbol will associate cursor two with the
V(2) waveform. The legend now appears as shown in 
Figure 13-7.

Figure 13-7 Legend

The Probe Cursor box also updates the A2 coordinates to ref
the X and Y values corresponding to the V(2) waveform.

For a family of curves (such as from a nested DC sweep), y
can use the mouse or the arrow keys to move the cursor to 
of the other curves in the family. Click on the desired curve.

cursor 1 cursor 2
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See Chapter 14,Output 
Options, for additional 
information about output options.
Probe Trace 
Expressions
Traces are referred to by Probe output variable name. These
be selected from the list in the Add Traces dialog box, or typ
at the Trace Command prompt. Probe output variables are 
similar to the PSpice output variables specified in the 
Schematics Analysis Setup dialog boxes for AC, DC, Monte
Carlo, worst-case, transfer function, and Fourier analyses. 
However, there are additional alias forms that are valid with
Probe. Both forms are discussed here.

Basic Output Variable Form
This form is representative of those available for specifying 
PSpice analyses.

<output>[AC suffix](<name>[,name])

where:

<output> is the type of output quantity: V for voltage
or I for current.

[AC suffix]* specifies the quantity to be reported for a
AC analysis, such as M (magnitude), P 
(phase), G (group delay).

<name>
[,<name>]

specifies either the out id or (+ out id, - out 
id) pair for which the voltage is to be 
reported, or the out device for which a 
current is reported, where:

• out id specifies either the net id or pin 
id (<fully qualified device name>:<pin 
name>)

• out device specifies the fully qualified 
device name
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Output Variable Form for Device 
Terminals
This form can only be specified in Probe. The primary 
difference between this and the basic form is that the termin
symbol appears before the net id or device name specification 
(whereas the basic form treats this as the pin name within the pin 
id).

<output>[terminal]*[ AC suffix](<name>[,name])

where:

Table 13-4 summarizes the allowed formats and Table 13-5 
provides examples of equivalent output variables. Note that
some of the output variable formats are unique to Probe.

<output> is the type of output quantity: V for voltage
or I for current.

[terminal]* specifies one or more terminals for device
with more than two terminals, such as D 
(drain), G (gate), S (source), B (base).

[AC suffix]* specifies the quantity to be reported for a
AC analysis, such as M (magnitude), P 
(phase), G (group delay).

<name>
[,<name>])

specifies the net id, net id pair, or fully 
qualified device name.

Table 13-4 Probe Output Variable Formats

Format Meaning

V[ac](< + out id >,
< - out id >)

Voltage between + and - 
out ids

V<pin name>[ac](< 2-terminal device 
>)

Voltage at pin name of 
a 2-terminal device

V< x >[ac](< 3 or 4-terminal device >) Voltage at non-
grounded terminal x of a 
3 or 4-terminal device

V< z >[ac](< transmission line device 
>)

Voltage at one end z of 
a transmission line 
device



13-24 Waveform Analysis

3 
I<pin name>[ac](< 2-terminal device 
>)

Current through pin 
name of a 2-terminal 
device

I< x >[ac](< 3 or 4-terminal device >) Current through non-
grounded terminal x of a 
3 or 4-terminal device

I< z >[ac](< transmission line device 
>)

Current through one end 
z of a transmission 
line device

< DC sweep variable > Voltage or current 
source name

FREQUENCY AC analysis sweep 
variable

TIME Transient analysis 
sweep variable

V(ONOISE) Total RMS summed 
noise at output net

V(INOISE) Total RMS summed 
noise at input net

Table 13-5 Examples of Probe Output Variable Formats

A Basic Form
An Alias 
Equivalent

Meaning

V(NET3,NET2) (same) Voltage between nets labeled NET
and NET2

V(C1:1) V1(C1) Voltage at pin1 of capacitor C1 

VP(Q2:B) VBP(Q2) Phase of voltage at base of bipolar 
transistor Q2

V(T32:A) VA(T32) Voltage at port A of transmission 
line T32

I(M1:D) ID(M1) Current through drain of MOSFET 
device M1

VIN (same) Voltage source named VIN

FREQUENCY (same) AC analysis sweep variable

Table 13-4 Probe Output Variable Formats (continued)

Format Meaning
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Trace Expressions
Arithmetic expressions of output variables use the same 
operators as those used in PSpice (via Schematic symbol 
attribute definitions). Expressions may also include intrinsic 
functions. The intrinsic functions available in Probe similar to
those available in PSpice, but with some differences, as sho
in Table 13-6. A complete list of PSpice arithmetic functions 
can be found in Table 3-6 on page 3-11.

Table 13-6 Probe’s Arithmetic Functions

Probe
Function

Description
Available in
PSpice?

ABS(x) |x| YES

SGN(x) +1 (if x>0), 0 (if x=0), -1 (if x<0) YES

SQRT(x) x1/2 YES

EXP(x) ex YES

LOG(x) ln(x) YES

LOG10(x) log(x) YES

M(x) magnitude of x YES

P(x) phase of x {in degrees} YES

R(x) real part of x YES

IMG(x) imaginary part of x YES

G(x) group delay of x {in seconds} NO

PWR(x,y) |x|y YES

SIN(x) sin(x) YES

COS(x) cos(x) YES

TAN(x) tan(x) YES

ATAN(x) tan-1(x) YES

ARCTAN(x)

d(x) derivative of x with respect to the X axis 
variable

NO

s(x) integral of x over the range of the X axis 
variable

NO

AVG(x) running average of x over the range of the 
X axis variable

NO
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Note For AC analysis, Probe uses complex arithmetic to 
evaluate expressions. If the result of the 
expression is complex, then its magnitude is 
displayed.

Explicit numeric values are input in the same form as the 
simulator (via Schematics symbol attributes), except that the
suffixes M and MEG are replaced with m (milli, 1E-3) and M
(mega, 1E+6), respectively. Also, MIL and mil are not 
supported. With the exception of the m and M scale suffixes
Probe is not case sensitive, therefore upper/lower case 
characters are equivalent (V(5) and v(5), for example).

Unit suffixes are only used to label the axis; they never affect
the numerical results. Therefore, it is always safe to leave of
a unit suffix. The quantities 2e-3, 2mV, and 0.002V all have t
same numerical value. For plotting purposes, Probe notes th
the second and third forms are in volts, whereas the first is 
dimensionless.

The units which Probe recognizes are shown in Table 13-7.

AVGX(x,d) running average of x from 
X_axis_value(x)-d to X_axis_value(x)

NO

RMS(x) running RMS average of x over the range 
of the X axis variable

NO

DB(x) magnitude in decibels of x NO

MIN(x) minimum of the real part of x NO

MAX(x) maximum of the real part of x NO

Table 13-7 Output Units Recognized by Probe

Symbol Unit

V Volt

A Amps

W Watt

Table 13-6 Probe’s Arithmetic Functions (continued)

Probe
Function

Description
Available in
PSpice?
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Probe also knows that W=V·A, V=W/A, and A=W/V. So, if you
add a trace which is

V(5)*ID(M13)

the axis values will be labeled with W”

For a demonstration of trace presentation, see Probe Example on 
page 13-12.

d degree (of phase)

s second

H Hertz

Table 13-7 Output Units Recognized by Probe

Symbol Unit
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Saving Results in ASCII 
Format

The default Probe data file 
format is binary. However, the 
Probe data file may be saved in 
the Common Simulation Data 
Format (CSDF) instead, by 
selecting Probe Setup from the 
Analysis menu and clicking in the 
Text Data File Format check box. 
This causes simulation results to 
be written to the Probe data file 
in ASCII format following the 
CSDF convention.
Limiting File Size Using 
Markers
By default, all simulation results are written to the Probe dat
file. However, if you have placed markers on your schematic
prior to simulation, you can instruct the simulator to save on
the results for the marked wires and pins. This is specified in 
Data Collection section of the Analysis/Probe Setup dialog b
by enabling At Markers Only. The default is All data. An All 
Except Internal Subcircuit Data selection is also available wh
excludes data for internal subcircuit nodes and devices.

Probe Data File Output Control
Probe data file format and content can be controlled directly
from the schematic editor using options available in the Prob
Setup dialog box in combination with marker placement.

Avoiding File Size Limits
When PSpice runs, it creates a Probe data file. The size of t
file for transient analyses is roughly equal to (# transistors)·(
simulation steps)·24 bytes. The size for other analyses is ab
2.5 times smaller. For long runs, especially transient runs, th
can generate Probe data files which are over a megabyte. E
if this does not cause a problem with disk space, large Probe 
files take longer to read in and longer to display traces on th
screen.

One reason that Probe data files are large, is that all net voltages 
and device currents are stored for each time (or frequency, etc.)
step. To avoid this, you can place markers on the schematic
specify in Schematics that data should be collected at mark
only. This feature is found by selecting Probe Setup from th
Analysis menu in Schematics.
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The other reason for the large size of the Probe data file is t
long runs, especially transient ones, involve storing many da
points. For transient runs, you can suppress a part of the run
setting the No Print Delay value in the transient analysis 
specification. For example, setting No Print Delay to 0.9 ms 
tells the simulator to start output at 0.9 ms instead of time 0.
Note that this does not affect the transient calculations 
themselves; these always start at time 0. It only suppresses
output.
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Chapter Overview
This chapter describes output options that can be used to con
the simulation output. This chapter includes the following 
sections:

Viewpoints on page 14-2

Printpoints on page 14-3
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Viewpoints
Pseudocomponents that display simulation results on the 
schematic are called viewpoints. These apply to the analog 
portion of your circuit. Bias voltages and currents are suppor

Figure 14-1 Viewpoint Example

IPROBE allows you to display the bias point current. This 
essentially places a zero-valued voltage source on the 
schematic. Place the IPROBE symbol on the net, and the bi
point current is displayed.

VIEWPOINT allows you to display the bias point voltage of a
net within the MicroSim Schematics window. Place the 
VIEWPOINT symbol on the net, and the bias point is display

WATCH1 allows you to specify up to three output variables 
be viewed in the PSpice window as DC, AC, and/or transien
analyses proceed. All output variables are acceptable excep
group delay. Specify the type of analysis by editing the Valu
text box of the ANALYSIS attribute. Set the upper and lower
limit values by editing the LO and HI attributes.
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VPRINT1 supersedes the old 
PRINT1 pseudocomponent.
Printpoints
Pseudocomponents that write results to the simulation outpu
file are called printpoints. Printpoints generate tabulated tab
or line printer plots. Printpoint symbols and types are shown
Figure 14-2. Table 14-1 describes each of the printpoint 
symbols.

Figure 14-2 Printpoint Symbols

Except for the PRINTDGTLCHG symbol, you can specify on
or more analysis types for which the information should be 
reported as follows:

1 Double-click on the symbol.

Table 14-1 Printpoint Symbols

Symbol Description

IPLOT plot showing current through a cut in the 
net; this symbol must be inserted into the 
circuit in series (like a current meter)

IPRINT table showing current through a cut in the 
net; this symbol must be inserted into the 
circuit in series (like a current meter)

VPLOT1 plot showing voltages on the net to which 
the symbol terminal has been connected

VPLOT2 plot showing voltage differentials between 
the two nets to which the symbol terminal 
have been connected

VPRINT1 table showing voltages at the net to which 
the symbol terminal has been connected

VPRINT2 table showing voltage differentials 
between the two nets to which the symbol 
terminals have been connected
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2 Double-click on the analysis type attribute of interest. Set
Value text box to any non-blank value, such as Y, YES, or 1.

Set any additional analysis types. If AC is set, then one 
more output formats may also be set: MAG (magnitude)
PHASE, REAL, IMAG (imaginary), or DB.

If no analysis types are selected, transient results is reported
default. If AC is selected but no output formats are selected
MAG (magnitude) is used. 
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Appendix Overview
This appendix includes the following sections:

Save and Load Bias Point on page A-2

Setpoints on page A-4

Setting Initial Conditions on page A-6
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If the circuit uses high gain 
components, or if the circuit’s 
behavior is nonlinear around the 
bias point, this feature is not 
useful.

See Setting Up Analyses on 
page 7-3 for a description of the 
Analysis Setup dialog box.
Save and Load Bias 
Point
Save Bias Point and Load Bias Point are used to save and re
bias point calculations in successive PSpice simulations. Sav
and restoring bias point calculations can decrease simulatio
times when large circuits are run multiple times and can aid
convergence.

Save/Load Bias Point affect the following types of analyses:

• transient

• DC

• AC

Save Bias Point
Save bias point is a simulation control function that allows yo
to save the bias point data from one simulation for use as ini
conditions in subsequent simulations. Once bias point data 
saved to a file, you can use the load bias point function to use
data for another simulation.

To use save bias point

1 Click on Load Bias Point in the Analysis Setup dialog bo

2 Complete the Save Bias Point dialog box as described in
Schematic Editor Reference chapter of the Schematics 
User’s Guide. Click on OK when finished.

3 The check box next to Save Bias Point should be check
on. If not, click on the check box to enable it.
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See Setting Up Analyses on 
page 7-3 for a description of the 
Analysis Setup dialog box.
Load Bias Point
Load bias point is a simulation control function that allows yo
to set the bias point as an initial condition. A common reason
giving PSpice initial conditions is to select one out of two or 
more stable operating points (set or reset for a flip-flop, for 
example).

To use load bias point

1 Run a simulation using Save Bias Point for the Analysis
Setup dialog box.

2 Prior to running another simulation, click on Load Bias 
Point.

3 Specify a bias point file to load. Include the path if the fil
is not located in your working directory. Click on OK when
finished.

4 The check box next to Load Bias Point should be check
on. If not, click on the check box to enable it.
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Setpoints
Pseudocomponents that specify initial conditions are called 
setpoints. These apply to the analog portion of your circuit.

Figure A-1 Setpoints

The example is Figure A-1 includes the following:

Using IC symbols sets the initial conditions for the bias poin
only. It does not affect the DC sweep. If the circuit contains bo
an IC symbol and a NODESET symbol for the same net, the
NODESET symbol is ignored.

To specify the initial condition, edit the value of the VALUE 
attribute to the desired initial condition. PSpice attaches a 
voltage source with a 0.0002 ohm series resistance to each n
which an IC symbol is connected. The voltages are clamped 
way for the entire bias point calculation.

NODESET1 is a one-pin symbol which helps calculate the b
point by providing a initial guess for some net. NODESET2 is
two-pin symbol which helps calculate the bias point between
two nets. Some or all of the circuit’s nets may be given an init
guess. NODESET symbols are effective for the bias point (b
small-signal and transient bias points) and for the first step of 
DC sweep. It has no effect during the rest of the DC sweep 
during the transient analysis itself.

Unlike the IC pseudocomponents, NODESET provides only 
initial guess for some net voltages. It does not clamp those no
to the specified voltages. However, by providing an initial 
guess, NODESET symbols may be used to break the tie (in
flip-flop, for instance) and make it come up in a desired state.

IC1 a one-pin symbol that allows you to set th
initial condition on a net for both small-
signal and transient bias points

IC2 a two-pin symbol that allows you to set 
initial condition between two nets
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guess at the bias point, enter the initial guess in the Value te
box for the VALUE attribute. PSpice attaches a voltage sour
with a 0.0002 ohm series resistance to each net to which an
symbol is connected.

These pseudocomponents are netlisted as PSpice .IC and 
.NODESET commands. Refer to these commands in the PSpice 
Reference Manual for more information. Setpoints can be 
created for inductor currents and capacitor voltages using the
attribute described in Setting Initial Conditions on page A-6.
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See Setpoints on page A-4 for 
more information about IC1 and 
IC2.

See Setting Up Analyses on 
page 7-3 for a description of the 
Analysis Setup dialog box.
Setting Initial 
Conditions
The IC attribute allows initial conditions to be set on capacito
and inductors. These conditions are applied during all bias po
calculations. However, if you enable the Skip Initial Transien
Solution check box in the Transient Analysis Setup dialog bo
the bias point calculation is skipped and the simulation proce
directly with transient analysis at TIME=0. Devices with the I
attribute defined start with the specified voltage or current 
value; however, all other such devices have an initial voltage
current of 0. 

Note Skipping the bias point calculation can make the 
transient analysis subject to convergence 
problems.

Applying an IC attribute for a capacitor has the same effect 
applying one of the pseudocomponents IC1 or IC2 across it
nodes. PSpice attaches a voltage source with a 0.002 ohm s
resistance in parallel with the capacitor. The IC attribute allo
the user to associate the initial condition with a device, while t
IC1 and IC2 pseudocomponents allow the association to be w
a node or node pair.

In the case of initial currents through inductors, the associat
is only with a device, and so there are no corresponding 
pseudocomponents. The internal implementation is analogo
to the capacitor. PSpice attaches a current source with a 1 G
parallel resistance in series with the inductor. 

If you want IC attributes to be ignored when Skip Initial 
Transient Solution is not enabled in the Transient Analysis 
Setup dialog box:

1 Click on Options for the Setup Analysis dialog box.

2 Set NOICTRANSLATE to Y.
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diodes, 5-8, 5-32, 5-33, 7-8
expression parts (ABM), 6-8, 6-22
frequency table parts (ABM), 6-28, 6-37, 6-45
GaAsFET, 5-32, 7-9
ideal switches, 5-30
IGBT, 5-8, 5-32, 5-33, 7-9
inductor coupling (KBREAK), 5-27
inductors, 3-2, 5-26, 7-8
integrators and differentiators (ABM), 6-7, 6-14
ISTIM (analog stimulus), 10-13
JFET, 5-8, 5-32, 5-33, 7-9
Laplace transform (ABM), 6-8, 6-18, 6-28, 6-

35, 6-42
limiters (ABM), 6-7, 6-10
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math functions (ABM), 6-8, 6-21
mathematical expressions (ABM), 6-28
MOSFET, 5-8, 5-32, 5-33, 7-9
nonlinear magnetic core, 5-8
opamp, 5-8
passive, 3-2
power supplies, 3-13
PSpice A/D-equivalent parts (ABM), 6-28
resistors, 3-2, 5-26, 7-8
semiconductor parts, 5-31
table look-up (ABM), 6-7, 6-14, 6-28, 6-33
transformers, 3-4, 5-29
transmission lines, 3-5, 7-9
voltage comparator, 5-8
voltage reference, 5-8
voltage regulator, 5-8
VSTIM (analog stimulus), 10-13

analog simulation
Probe waveform display, 13-12, 13-25

analyses
AC sweep, 1-6, 2-18, 7-2, 9-1
analysis setup, 7-3
analysis types, 1-6, 7-2
bias point, 2-6
bias point detail, 1-6, 7-2, 8-7
DC sensitivity, 1-6, 7-2, 8-10
DC sweep, 1-6, 2-9, 7-2, 8-2
execution order, 7-4
Fourier, 1-7, 7-2
frequency response, 1-6, 7-2
Monte Carlo, 1-8, 7-2, 12-7
noise, 1-7, 7-2, 9-5
parametric, 1-7, 2-22, 7-2, 11-2
performance analysis, 2-28
sensitivity/worst-case, 1-8, 7-2, 12-21
small-signal DC transfer, 1-6, 7-2, 8-8
temperature, 1-7, 7-2, 11-11
transient, 1-7, 2-14, 7-2

attributes, 4-6

B
basic components (ABM), 6-7, 6-9
basic controlled sources (ABM), 6-47
bias point analysis example, 2-6
bias point detail analysis, 1-6, 7-2, 8-7
bias point, save/restore, A-2
bipolar transistors, 5-8, 5-32, 5-33, 7-9
Bode plot, 1-6, 2-20

breakout parts, 5-26

C
capacitors, 3-2, 5-26, 7-8
Chebyshev filters, 6-7, 6-11, 6-44, 12-16
circuit file (.cir), simulating multiple circuits, 7-12
circuit file set, 1-3
comparator, 5-8
connectors, 4-7
control system parts (ABM), 6-7
controlled sources, 6-28, 6-47
copying symbols, 4-2
creating and analyzing circuits, 1-2
current source, controlled, 6-28, 6-47
cursors, Probe, 13-19

D
DC analyses

displaying results in Probe, 2-10
see also DC sweep analysis, bias point detail ana

ysis, small-signal DC transfer, DC sensi-
tivity

DC sensitivity analysis, 1-6, 7-2, 8-10
DC sweep analysis, 1-6, 7-2, 8-2

curve families, 8-5
example, 2-9
nested, 8-4
overview, 8-3
setting up, 2-9

differentiators (ABM), 6-7, 6-14
digital parts

see also analog parts
diodes, 5-8, 5-32, 5-33, 7-8

E
example circuit design entry, 2-2
examples and tutorials

AC sweep analysis, 2-18
bias point analysis, 2-6
DC sweep analysis, 2-9
example circuit design entry, 2-2
frequency response vs. arbitrary parameter, 11-8
model editor, 5-24
modeling a triode (ABM), 6-25
Monte Carlo analysis, 12-10
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parametric analysis, 2-22
performance analysis, 2-28, 11-3
transient analysis, 2-14
using Probe (analog waveform analysis), 13-12
using the Parts utility, 5-13
worst-case analysis, 12-24

expression parts (ABM), 6-8, 6-22
expressions, 3-10

see also parameters
ABM, 6-28
functions, 3-11
Probe, 13-25
system variables, 3-13

F
Fourier analysis, 1-7, 7-2
FREQUENCY output variable, 13-24
frequency response analysis, see AC sweep analysis
frequency response vs. arbitrary parameter, 11-8
frequency table parts (ABM), 6-28, 6-37, 6-45
functions (Probe), 13-25
functions (PSpice A/D), 3-11

G
GaAsFET, 5-32, 7-9
goal functions, 11-5

in performance analysis, 11-5
single data point, 11-5

H
histograms, 12-16
hysteresis curves, 10-16

I
IC (attribute), A-6
IGBT, 5-8, 5-32, 5-33, 7-9
include files, 1-4

configuring, 5-36
directory paths, 5-39
model definitions, 5-38
search order, 5-38

inductors, 3-2, 5-26, 7-8
initial conditions, A-2, A-6
integrators (ABM), 6-7, 6-14

IPROBE (view bias point current symbol), 14-2

J
JFET, 5-8, 5-32, 5-33, 7-9

K
KBREAK (inductor coupling), 5-27

L
Laplace transform parts (ABM), 6-8, 6-18, 6-28, 6-

35, 6-42, 6-43
limiters (ABM), 6-7, 6-10

M
magnetic core, nonlinear, 5-8
markers, 2-10, 13-28

for limiting Probe data file size, 13-28
for Probe trace display, 13-10
waveform characteristics, 13-10

math function parts (ABM), 6-8, 6-21
mathematical expressions (ABM), 6-28
mid-analysis snoop, 13-7
mixed analog/digital circuits

Probe waveform display, 13-25
MODEL attribute, 4-6, 4-12, 5-2
model editor

dialog box, 5-23
editing global models, 5-23
editing local models, 5-22
example, 5-24
using, 5-21
vs. Parts utility, 5-3

model files, 1-3
configuring, 5-9, 5-36
directory paths, 5-39
global, 5-36
local, 5-36
Parts utility, 5-9
search order, 5-38

models
configuration with Parts utility, 5-10, 5-12
global vs. local, 5-2
model editor, 5-21
overview, 5-2
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subcircuits, 5-20
D (diode), 5-32, 5-33
GASFET (GaAsFET), 5-32
IGBT, 5-32
ISWITCH (current-controlled switch), 5-30
LPNP (bipolar transistor), 5-32, 5-33
NIGBT (N-channel IGBT), 5-33
NJF (JFET), 5-32, 5-33
NMOS (MOSFET), 5-32, 5-33
NPN (bipolar transistor), 5-32, 5-33
PJF (JFET), 5-32, 5-33
PMOS (MOSFET), 5-32, 5-33
PNP (bipolar transistor), 5-32, 5-33
VSWITCH (voltage-controlled switch), 5-30
X (diode), 5-32

Monte Carlo analysis, 1-8, 7-2, 12-7
collating functions, 12-4
histograms, 12-16
model parameter values reports, 12-3
output control, 12-3
tutorial, 12-10
using the model editor, 5-24
waveform reports, 12-4
with temperature analysis, 12-6

MOSFET, 5-8, 5-32, 5-33, 7-9
multiple Y axes, Probe, 11-6

N
NOICTRANSLATE (simulation option), A-6
noise analysis, 1-7, 7-2, 9-5
non-causality, 6-43
nonlinear components (AC sweep), 9-4
nonlinear magnetic core, 5-8

O
opamp, 5-8
operators in expressions, 3-10
options

RELTOL, 6-46
output file (.out), 1-5, 2-7

printpoints, 14-3
output variables

Probe, 13-22
Probe arithmetic expressions, 13-25
Probe functions, 13-25
PSpice A/D, 7-4

P
PARAM, 2-23
parameters, 3-9

see also expressions
parametric analysis, 1-7, 7-2, 11-2

analyzing waveform families in Probe, 2-25
example, 2-22
frequency response vs. arbitrary parameter, 11-8
performance analysis, 11-3
setting up, 2-23
temperature analysis, 1-7, 7-2, 11-11

Parts utility
automatic model configuration, 5-10
creating model and subcircuit definitions by charac

terization, 5-13
manual model configuration, 5-12
model files, 5-9
overview, 5-4
starting, 5-7
supported devices, 5-8
tutorial, 5-13
vs. model editor, 5-3

parts, see analog parts, digital parts
passive parts, 3-2
performance analysis, 11-3

example, 2-28
goal functions, 11-5

PLogic
see also PSpice A/D, simulation
interaction with Schematics files, 5-40
overview, 1-4
simulation status window, 7-14
starting, 7-11

polynomial parts, compared to ABM, 6-47
polynomial transfer function (for ABM controlled sourc-

es), 6-49
power supplies

analog, 3-13
preparing a schematic for simulation, 3-1
printpoints, 14-3
Probe, 13-2

accelerator keys, 13-15
adding traces, 2-10
arithmetic expressions, 13-25
color configuration, 13-6
cursors, 13-19
data file (.dat), 13-28
displaying results, 2-10, 2-20
displaying traces, 2-10
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expressions, 13-25
functions, 13-25
hysteresis curves, 10-16
limiting data file size, 13-28
mid-analysis snoop, 13-7
multiple Y axes, 11-6
output variables, 13-22
performance analysis, 2-28, 11-3
placing a cursor on a trace, 2-11
plot update methods, 13-16
plot windows, 13-3
printing plot windows, 13-4
scrolling, 13-16
startup, 13-5, 13-7
trace data tables, 13-18
traces, 13-28
traces, displaying, 13-15
traces, using output variables, 13-22
using markers, 13-10
waveform families, 2-25, 8-5
zoom regions, 13-15

pseudocomponents
ICn, A-4
IPLOT, 14-3
IPRINT, 14-3
IPROBE, 14-2
NODESETn, A-4
PARAM, 2-23
VIEWPOINT, 2-8, 14-2
VPLOTn, 14-3
VPRINTn, 14-3
WATCH1, 14-2

PSpice A/D
see also simulation
expressions, 3-10
functions, 3-11
interaction with Schematics files, 5-40
output file (.out), 1-5, 2-7
output variables, 7-4
overview, 1-4
Probe data file (.dat), 1-4
PSpice A/D-equivalent parts, 6-28, 6-29
simulation status window, 7-14
starting, 7-11

R
regulator, 5-8
RELTOL (simulation option), 6-46

resistors, 3-2, 5-26, 7-8

S
schematic, preparing for simulation, 3-1
scrolling, Probe, 13-16
semiconductor parts, 5-31
sensitivity analysis, see worst-case analysis
setpoints, A-4
simulation

analysis execution order, 7-4
analysis setup, 7-3
analysis types, 1-6, 7-2
batch jobs, 7-12
bias point, A-2
initial conditions, A-2, A-6
mid-analysis snoop, 13-7
output file (.out), 1-5, 2-7
overview, 1-1
preparing a schematic for, 3-1
printpoints, 14-3
Probe data file, 13-28
results, 1-4
run-time monitoring, 14-2
starting, 7-11
status window, 7-14

SIMULATION ONLY attribute, 4-6
small-signal DC transfer analysis, 1-6, 7-2, 8-8
Stimulus Editor, 1-3, 2-14, 10-5

creating new stimulus symbols, 10-9
defining stimuli, 10-6
editing a stimulus, 10-10
manual stimulus configuration, 10-11
starting, 10-6
stimulus files, 10-5

stimulus files, 1-3
stimulus generation, 10-3

manually configuring, 10-11
stimulus, adding, 2-14
subcircuits, 5-20

editing, 5-21
naming conventions, 4-12
relating to a symbol, 4-12

switches, ideal, 5-30
symbols

attributes, 4-6
copying, 4-2
creating, 4-1
creating new stimulus symbols, 10-9
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graphics, 4-4
relating subcircuits to, 4-12
ABMn and ABMn/I (ABM), 6-8, 6-22
ABS (ABM), 6-8, 6-21
ARCTAN (ABM), 6-8, 6-21
ATAN (ABM) , 6-8, 6-21
BANDPASS (ABM), 6-7, 6-12
BANDREJ (ABM), 6-7, 6-13
BBREAK (GaAsFET), 5-32, 5-34
C (capacitor), 3-2
C_VAR (capacitor), 3-2
CBREAK (capacitor), 5-26
CONST (ABM), 6-7, 6-9
COS (ABM), 6-8, 6-21
DBREAKx (diodes), 5-32, 5-34
DIFF (ABM), 6-7, 6-9
DIFFER (ABM), 6-7, 6-14
E (ABM controlled analog source), 6-48, 6-49
EFREQ (ABM), 6-28, 6-37
ELAPLACE (ABM), 6-28, 6-35
EMULT (ABM) , 6-28, 6-31
EPOLY (ABM controlled analog source), 6-48, 6-

49
ESUM (ABM), 6-28, 6-31
ETABLE (ABM), 6-28, 6-33
EVALUE (ABM) , 6-28, 6-30, 6-31
EXP (ABM), 6-8, 6-21
F (ABM controlled analog source), 6-48, 6-49
FPOLY (ABM controlled analog source), 6-48, 6-

49
FTABLE (ABM), 6-7, 6-15
G (ABM controlled analog source), 6-48, 6-49
GAIN (ABM) , 6-7, 6-9
GFREQ (ABM), 6-28, 6-37
GLAPLACE (ABM), 6-28, 6-35
GLIMIT (ABM) , 6-7, 6-10
GMULT (ABM) , 6-28, 6-31
GPOLY (ABM controlled analog source), 6-48, 6-

49
GSUM (ABM), 6-28, 6-31
GTABLE (ABM), 6-28, 6-33
GVALUE (ABM) , 6-28, 6-30, 6-31
H (ABM controlled analog source), 6-48, 6-49
HIPASS (ABM), 6-7, 6-12
HPOLY (ABM controlled analog source), 6-48, 6-

49
ICn (initial condition), A-4
IDC (power supply), 3-13
INTEG (ABM), 6-7, 6-14
IPLOT (current plot), 14-3

IPRINT (current table), 14-3
ISRC (power supply), 3-13
ISTIM (analog stimulus), 10-13
JBREAKx (JFET), 5-32, 5-34
K_LINEAR (transformer), 3-4
KBREAK (inductor coupling), 5-27
KCOUPLEn (transmission line coupling matrix), 3-

7
L (inductor), 3-2
LAPLACE (ABM), 6-8, 6-18
LBREAK (inductor), 5-26
LIMIT (ABM) , 6-7, 6-10
LOG (ABM), 6-8, 6-21
LOG10 (ABM), 6-8, 6-21
LOPASS (ABM), 6-7, 6-11
MBREAKx (MOSFET), 5-32, 5-34
MULT (ABM) , 6-7, 6-9
NODESETn (initial bias point), A-4
PWR (ABM), 6-8, 6-21
PWRS (ABM), 6-8, 6-21
QBREAKx (bipolar transistor), 5-32, 5-34
R (resistor), 3-2
R_VAR (resistor), 3-2
RBREAK (resistor), 5-26
SBREAK (voltage-controlled switch), 5-30
SIN (ABM), 6-8, 6-21
SOFTLIM (ABM), 6-7, 6-10
SQRT (ABM), 6-8, 6-21
SUM (ABM), 6-7, 6-9
T (transmission line), 3-5
TABLE (ABM) , 6-7, 6-14
TAN (ABM) , 6-8, 6-21
TLOSSY (transmission line), 3-5
TnCOUPLED (transmission line), 3-7
TnCOUPLEDX (transmission line), 3-7
VDC (power supply), 3-13
VIEWPOINT (view bias point voltage), 2-5, 2-8, 

14-2
VPLOTn (voltage plot), 14-3
VPRINTn (voltage table), 14-3
VSRC (power supply), 3-13
VSTIM (analog stimulus), 10-13
WBREAK (current-controlled switch), 5-30
XFRM_LINEAR (transformer), 3-4
XFRM_NONLINEAR (nonlinear transformer), 5-

29
ZBREAKN (IGBT), 5-32, 5-35

system variables in expressions, 3-13



Index-7
T
table look-up parts (ABM), 6-7, 6-14, 6-28, 6-33
temperature analysis, 1-7, 7-2, 11-11

with statistical analyses, 12-6
TEMPLATE attribute, 4-7
TIME (Probe output variable), 13-24
traces

adding, 2-10
direct manipulation, 13-15
displaying, 2-10, 2-17
markers, 13-28
output variables, 13-22
placing a cursor on, 2-11

transformers, 3-4, 5-29
transient analysis, 1-7, 7-2

example, 2-14
Fourier analysis, 1-7, 7-2
hysteresis curves, 10-16
internal time steps, 10-15
overview, 10-2
setting up, 2-16
Stimulus Editor, 10-5
stimulus generation, 10-3
switching circuits, 10-16
transient response, 10-14

transmission lines
coupled, 3-6, 3-8
ideal, 3-5
lossy, 3-5
simulating, 3-8

triode, 6-25
tutorials, see examples and tutorials

V
variables in expressions, 3-13
viewpoints, 14-2
voltage comparator, 5-8
voltage reference, 5-8
voltage regulator, 5-8
voltage source, controlled, 6-28, 6-47
VSTIM symbol, 2-14

W
WATCH1 (view output variable symbol), 14-2
waveform analysis, see Probe
waveform families, displaying in Probe, 2-25

worst-case analysis, 1-8, 7-2, 12-21
collating functions, 12-4
example, 12-24
hints, 12-28
model parameter values reports, 12-3
output control, 12-3
overview, 12-21
waveform reports, 12-4
with temperature analysis, 12-6

Z
zoom regions, Probe, 13-15


	Table of Contents
	List of Figures
	List of Tables
	Before You Begin
	Welcome to MicroSim
	MicroSim PSpice Overview
	How to Use this Guide
	Typographical Conventions
	Mouse Conventions

	Related Documentation
	On-Line Help

	If You Don’t Have the Standard PSpice Package
	If You Have PSpice�Basics
	If You Have the Evaluation CD�ROM


	Simulation Overview
	Chapter Overview
	Creating and Analyzing Circuits
	Creating and Preparing a Circuit for Simulation
	Simulating a Circuit with PSpice����������
	Displaying Simulation Results

	Analysis Types
	Standard analyses
	Simple multi-run analyses
	Statistical analyses


	Simulation Examples
	Chapter Overview
	Example Circuit Design Entry
	Bias Point Analysis
	Running PSpice
	Simulation Output File
	Voltage Viewpoint

	DC Sweep Analysis
	Setting Up and Running a DC Sweep Analysis
	Displaying DC Analysis Results in Probe

	Transient Analysis
	AC Sweep Analysis
	Setting Up and Running an AC Sweep Analysis
	AC Sweep Analysis Results

	Parametric Analysis
	Setting Up and Running the Parametric Analysis
	Analyzing Waveform Families in Probe

	Probe Performance Analysis

	Preparing a Schematic for Simulation
	Chapter Overview
	Passive Parts
	Resistors, Capacitors, and Inductors
	Transformers
	Transmission Lines

	Parameters and Expressions
	Parameters
	Expressions

	Analog Power Supplies

	Creating Symbols
	Chapter Overview
	Creating a New Symbol
	Creating a Symbol
	Understanding Symbol Graphics
	Defining Part Symbol Attributes

	Linking a Symbol to a Model or Subcircuit Definiti...
	Linking a Symbol to a Model
	Relating Subcircuits to Part Symbols

	Adding New Symbols from a Vendor
	Model Library
	Symbol Library
	Copying and Modifying a Symbol for a Single Vendor...
	Copying and Modifying a Symbol for Multiple Vendor...


	Creating Models
	Chapter Overview
	Model Overview
	Global Models vs. Local Models
	Parts Utility vs. Text (Model) Editor

	Using the Parts Utility
	Starting the Parts Utility
	Supported Device Types
	Parts Model Files (.lib or .mod)
	Automatic Model Configuration
	Manual Model Configuration
	Creating Model and Subcircuit Definitions by Chara...
	Parts Utility Tutorial

	Subcircuits
	Using the Model Editor (Text Editor)
	Implementation of Model Editing
	Editing Model Definitions in the Schematic Editor
	Editing Model Definitions in the Symbol Editor
	Model Editor Dialog Box
	Model Editing Example
	Breakout Parts
	Semiconductor Parts

	Configuring the Library

	Analog Behavioral Modeling
	Chapter Overview
	Overview of Analog Behavioral Modeling
	The abm.slb Symbol Library File
	Placing and Specifying ABM Parts
	Net Names and Device Names in ABM Expressions
	Forcing the Use of a Global Definition

	ABM Part Templates
	Control System Parts
	Basic Components
	Limiters
	Chebyshev Filters
	Integrator and Differentiator
	Table Look-Up Parts
	Laplace Transform Part
	Math Functions
	ABM Expression Parts
	An Instantaneous Device Example: Modeling a Triode...

	PSpice-Equivalent Parts
	Implementation of PSpice- Equivalent Parts
	Modeling Mathematical or Instantaneous Relationshi...
	Lookup Tables (ETABLE and GTABLE)
	Frequency-Domain Device Models
	Laplace Transforms (LAPLACE)
	Frequency Response Tables (EFREQ and GFREQ)

	Cautions and Recommendations for Simulation and An...
	Instantaneous Device Modeling
	Frequency-Domain Parts
	Laplace Transforms
	Trading Off Computer Resources For Accuracy

	Basic Controlled Sources
	Basic SPICE Polynomial Expressions (POLY)
	Implementation Examples


	Setting Up Analyses and Starting Simulation
	Chapter Overview
	Analysis Types
	Setting Up Analyses
	Execution Order for Standard Analyses
	Output Variables

	Starting Simulation
	Starting Simulation from Schematics
	Starting Simulation Outside of Schematics
	Setting Up Batch Simulations
	The Simulation Status Window


	DC Analyses
	Chapter Overview
	DC Sweep
	Minimum Requirements to Run a DC Sweep Analysis
	Overview of DC Sweep
	Nested DC Sweeps
	Curve Families for DC Sweeps

	Bias Point Detail
	Minimum Requirements to Run a Bias Point Detail An...
	Overview of Bias Point Detail

	Small-Signal DC Transfer
	Minimum Requirements to Run a Small-Signal DC Tran...
	Overview of Small-Signal DC Transfer

	DC Sensitivity
	Minimum Requirements to Run a DC Sensitivity Analy...
	Overview of DC Sensitivity


	AC Sweep Analysis
	Chapter Overview
	Overview of AC Sweep Analysis
	Minimum Requirements to Run an AC Sweep Analysis
	Overview of AC Sweep

	Nonlinear Components in an AC Sweep Analysis
	Noise Analysis

	Transient Analysis
	Chapter Overview
	Overview of Transient Analysis
	Minimum Requirements to Run a Transient Analysis

	Stimulus Generation
	Overview of Stimulus Generation

	The Stimulus Editor Utility
	Stimulus Files
	Configuring Stimulus Files
	Starting the Stimulus Editor
	Defining Stimuli����������
	Creating New Stimulus Symbols
	Editing a Stimulus
	Deleting and Removing Traces
	Manual Stimulus Configuration
	Using the VSTIM and ISTIM Sources

	Transient (Time) Response
	Internal Time Steps in Transient Analyses
	Switching Circuits in Transient Analyses
	Plotting Hysteresis Curves
	Fourier Components

	Parametric and Temperature Analysis
	Chapter Overview
	Parametric Analysis
	Minimum Requirements to Run a Parametric Analysis
	Overview of Parametric Analysis
	Example: RLC Filter
	Example: Frequency Response vs. Arbitrary Paramete...

	Temperature Analysis
	Minimum Requirements to Run a Temperature Analysis...
	Overview of Temperature Analysis


	Monte Carlo and Sensitivity/ �Worst-Case Analyses
	Chapter Overview
	Statistical Analyses
	Overview of Statistical Analyses
	Output Control for Statistical Analyses
	Model Parameter Values Reports
	Waveform Reports
	Collating Functions
	Temperature Considerations in Statistical Analyses...

	Monte Carlo Analysis
	Tutorial: Monte Carlo Analysis of a Pressure Senso...
	Monte Carlo Histograms

	Worst-Case Analysis
	Overview of Worst-Case Analysis
	Worst-Case Analysis Example
	Hints and Other Useful Information


	Waveform Analysis
	Chapter Overview
	Overview of Probe
	Anatomy of a Plot Window
	Managing Multiple Plot Windows

	What You Need to Know to Run Probe
	Starting Probe
	Setup Requirements
	Manual Startup
	Other Ways to Run Probe
	Schematic Markers

	Probe Example
	User-Interface Features
	Zoom Regions
	Scrolling Traces
	Modifying Traces and Labels
	Moving Traces and Labels
	Tabulating Trace Data Values
	Cursors

	Probe Trace Expressions
	Basic Output Variable Form
	Output Variable Form for Device Terminals
	Trace Expressions

	Limiting File Size Using Markers
	Probe Data File Output Control
	Avoiding File Size Limits


	Output Options
	Chapter Overview
	Viewpoints
	Printpoints

	Setting Initial State
	Appendix Overview
	Save and Load Bias Point
	Save Bias Point
	Load Bias Point

	Setpoints
	Setting Initial Conditions

	Index

